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About This Guide

This guide describes how to use the Designer to create User Application components. It explains
how to work with the Provisioning view, the directory abstraction layer editor, the provisioning
request definition editor, the provisioning team editor, and the role catalog.

+ Chapter 1, “Introduction to the User Application Design Tools,” on page 15

+ Chapter 2, “Working with the Provisioning View,” on page 19

+ Chapter 3, “Configuring the Directory Abstraction Layer,” on page 45

+ Chapter 4, “Configuring Provisioning Request Definitions,” on page 85

+ Chapter 5, “Creating Forms for a Provisioning Request Definition,” on page 109

+ Chapter 6, “Creating the Workflow for a Provisioning Request Definition,” on page 177

+ Chapter 7, “Workflow Activity Reference,” on page 219

+ Chapter 8, “Working with Integration Activities,” on page 269

+ Chapter 9, “Working with ECMA Expressions,” on page 317

+ Chapter 10, “Configuring Provisioning Teams,” on page 367

+ Chapter 11, “Configuring Roles,” on page 375

+ Chapter 12, “Configuring Resources,” on page 405

+ Appendix A, “ECMAScript Core Reference,” on page 419

Audience

This guide is intended for designers responsible for creating and modifying User Application
components.

Feedback

We want to hear your comments and suggestions about this manual and the other documentation
included with this product. Please use the User Comments feature at the bottom of each page of the
online documentation, or go to www.novell.com/documentation/feedback.html and enter your
comments there.

Additional Documentation

For documentation on other Identity Manager features, see the Identity Manager Documentation
Web site (http://www.novell.com/documentation/idm).

About This Guide

13


http://www.novell.com/documentation/idm
http://www.novell.com/documentation/idm

14  User Application: Design Guide



Introduction to the User
Application Design Tools

This section provides an overview of the tools available for designing and configuring the User
Application. Topics include:

+ Section 1.1, “About the Provisioning View,” on page 15

+ Section 1.2, “About the Directory Abstraction Layer Editor,” on page 16

+ Section 1.3, “About the Provisioning Request Definition Editor,” on page 16

+ Section 1.4, “About the ECMA Expression Builder,” on page 16

+ Section 1.5, “About the Provisioning Team Editor,” on page 17

+ Section 1.6, “About the Roles Catalog,” on page 17

+ Section 1.7, “Documenting a Project,” on page 17

IMPORTANT: The User Application is an application and not a framework. The areas within the
User Application that are supported to be modified are outlined within the product documentation.
Modifications to areas not outlined within the product documentation are not supported.

1.1 About the Provisioning View

The Provisioning view provides persistent access to Designer’s provisioning, roles, and compliance
features. Use the Provisioning view to perform the following actions on provisioning and roles
objects:

+ Access the editors that allow you to create and manipulate User Application components, such
as:

*

The directory abstraction layer editor.

*

The provisioning request definitions editor.

*

The provisioning editor.

*

The roles catalog.

Double-clicking an item from the Provisioning view opens the editor for that item.
+ Manipulate object definitions, such as:

*

Importing and exporting object definitions from the Identity Vault or the local file system.

*

Validating local object definitions.
+ Deploying object definitions to the Identity Vault.
+ Comparing the objects on the local file system with those in the Identity Vault.
+ Define the User Application driver’s supported and default locales, including:
+ Importing and exporting display labels and other User Application strings for localization.
+ Defining custom localization resource groups (used only for field localization).

Introduction to the User Application Design Tools
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1.2 About the Directory Abstraction Layer Editor

The directory abstraction layer editor allows you to define directory abstraction layer definitions.
Use the directory abstraction layer editor to modify the User Application’s behavior by:

*

Adding new entities (lIdentity Vault objects).

*

Defining the set of attributes for an entity.

*

Specifying the contents of lists.

*

Modeling relationships among entities.

*

Defining automatic lookups between entities.
+ Defining LDAP searches as Queries that you can run from request and approval forms.

1.3 About the Provisioning Request Definition
Editor

The provisioning request definition editor allows you to create custom provisioning request
definitions by using a rich set of Eclipse-based design tools. Use the provisioning request definition
editor to:

+ Define the basic characteristics of the provisioning request.

+ Design the associated workflow.

+ Define the request and approval forms.

+ Configure the activities and flow paths.

1.4 About the ECMA Expression Builder

Designer incorporates an ECMASCcript interpreter and expression editor, which allows you create
script expressions that refer to and modify workflow data. For example, you can use scripting to:
+ Create new data items needed in a workflow under the flowdata element.
+ Perform basic string, date, math, relational, concatenation, and logical operations on data.
+ Call standard or custom Java classes for more sophisticated data operations.
+ Use expressions for runtime control to:
+ Modify or override form field labels.
+ |Initialize form field data.
+ Customize e-mail addresses and content.
+ Set entitlement grant/revoke rights and parameters.

+ Evaluate any past activity data to conditionally follow a workflow path by using the
Condition Activity.

+ Write different log messages that are conditionally triggered by using a single Log
Activity.

16  User Application: Design Guide



1.5 About the Provisioning Team Editor

The provisioning team editor allows you to define a set of users who can act as a team within the
User Application. The team definition determines who can manage provisioning requests and
approval tasks associated with this team. The team definition consists of a list of team managers,
team members, and team options. In addition, you can define the set of provisioning request objects
that the team can act on.

1.6 About the Roles Catalog

The Roles Catalog includes tools that let you define the contents of the Roles tab of the User
Application. The tools available through the roles catalog include:

+ Resource editor: Defines the set of available resources. Includes information about the
resource’s trustees, owners, approval workflow, and entitlements.

+ Role editor: Defines the set of available roles. Includes information about the role’s trustees,
owners, role containment hierarchy, and entitlements.

+ Separation of Duties editor: Defines the separation of duties constraints and how to handle
requests for exceptions to those constraints.

+ Role Configuration editor: Lets you modify the roles subsystem administrative settings.

The Roles Catalog also includes a menu option that enables you to import roles defined in a comma-
separated values (CSV) file.

1.7 Documenting a Project

Designer provides a document generator that helps you quickly generate customized documentation
for your Designer projects. You can define your own document style, but Designer ships with a
default provisioning style. The default provisioning style includes sections for the User Application.
The sections include:

+ Section 1.7.1, “Provisioning Locales,” on page 17

*

Section 1.7.2, “Directory Abstraction Layer,” on page 17

*

Section 1.7.3, “Provisioning Request Definitons,” on page 18

*

Section 1.7.4, “Provisioning Teams,” on page 18

*

Section 1.7.5, “Role Catalog,” on page 18

1.7.1 Provisioning Locales

Lists the supported locales and default locales along with the provisioning resource groups.

1.7.2 Directory Abstraction Layer

Includes the following sections:

+ Entities: Including access properties, auxiliary classes, and LDAP classes.
+ Global lists: Including key and display label.
+ Queries: Including the query’s keys, parameters, and conditions.

Introduction to the User Application Design Tools
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+ Relationships: Including key, parent key, parent attribute, child key, and child attribute.
+ Configuration: Including default entity key, default locale, and container classes.

1.7.3 Provisioning Request Definitons

Includes:

+ A table containing the definition’s category, status, and e-mail notification.
+ An image of the workflow’s structure.

+ A section for each activity with a table that lists the data mappings for the activity or the
expression (if supported by the activity type).

+ A section for each form.

1.7.4 Provisioning Teams

Includes:

+ Display name

¢ The team members

+ The request type and scope
+ The manager’s permissions

1.7.5 Role Catalog

Includes the following section:

+ Resources:
+ Roles: Including display name, description, role level, and categories.

+ Separation of Duties Constraints: Including display name, description, conflicting roles,
approval type, and approvers.

+ Role Configuration: Including role removal grace period, role level display names and
descriptions, approval types and approval definitions.
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Working with the Provisioning
View

This section provides details on using the Provisioning view. Topics include:

+ Section 2.1, “Setting Up a Provisioning Project,” on page 19

+ Section 2.2, “Accessing the Provisioning View,” on page 24

+ Section 2.3, “Setting Provisioning View Preferences,” on page 25

+ Section 2.4, “Importing Provisioning Objects,” on page 25

+ Section 2.5, “Exporting Provisioning Objects,” on page 26

+ Section 2.6, “Validating Provisioning Objects,” on page 26

+ Section 2.7, “Deploying Provisioning Objects,” on page 29

+ Section 2.8, “Comparing Provisioning Objects,” on page 31

+ Section 2.9, “Specifying Locales and Localization Resource Groups,” on page 32

+ Section 2.10, “Localizing Provisioning Objects,” on page 37
To perform many of the operations available from the Provisioning view (such as compare, import,
and deploy along with the wizards and editors), Designer must be able to establish a connection to
the Identity Vault. Designer generates error messages when it cannot connect to the Identity Vault
while performing these actions. To ensure that Designer is always able to connect to the Identity
Vault, you can choose to save the password when you configure the Identity Vault credentials for

your project. When you choose Save password, Designer saves the password to the local file system;
it is not secure.

2.1 Setting Up a Provisioning Project

The Provisioning view is only available for Designer projects that contain a User Application driver.
After you set up an Identity Manager project and configure an Identity Vault and driver set for the
project, you add and configure a User Application driver.

To use Designer to configure the Roles tab of the User Application, you must additionally add a Role
Service driver to your project. See Section 2.1.2, “Creating a Role Service Driver,” on page 21 after
completing Section 2.1.1, “Creating a User Application Driver,” on page 19.

+ Section 2.1.1, “Creating a User Application Driver,” on page 19

+ Section 2.1.2, “Creating a Role Service Driver,” on page 21

+ Section 2.1.3, “Modifying the Role Service Driver Properties,” on page 22

+ Section 2.1.4, “About E-Mail Notification Templates,” on page 23

2.1.1 Creating a User Application Driver

1 Inan open Designer project, create a new driver by using one of these medoths:
+ Click Provisioning in the Palette, then drag a User Application icon onto the canvas.

Working with the Provisioning View
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2 Select User Application Base from the list of driver base packages in the Driver Configuration
Wizard, then click Next.

3 Use the following information to configure the driver:

Field Description

Driver Name Specify the name of an existing User Application
driver (the driver specified during the User
Application installation), or the name of a new
User Application driver.
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Field

Description

Authentication ID

Application password/Reenter password

Host

Port

Application context

Allow Override Initiator

Specify the DN of the User Application
Administrator.

Specify the password for the User Application
Administrator (above).

Specify the hostname or IP address of the
application server where the Identity Manager
User Application is deployed. This information is
used:

* To trigger workflows on the application
server to connect to access workflows
(terminate, retract, and so on).

+ To update cached data definitions.
Specify the port for the Host (above).

Specify context of the User Application context.
For example, IDMProv.

This property applies to workflows that are
started automatically. Workflows started
automatically are typically started under the
Admin identity. Selecting Yes for this property
allows those workflows to be started under
another user identity. For more information, see
the Identity Manager User Application:
Administration Guide.

4 Click Next.
5 Click Finish.

NOTE: When you create a User Application driver, e-mail templates for the User Application
are added to the Default Notification Collection. You must explicitly deploy them. They are not
deployed by default when you deploy the User Application driver.

2.1.2 Creating a Role Service Driver

1 Inthe same project where you created a User Application driver, click Provisioning in the
Palette, then drag and drop Role Service icon onto the Modeler.
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2 Select Role and Resource Service Base from the list of driver base packages in the Driver
Configuration Wizard, then click Next.

3 Click Finish.

2.1.3 Modifying the Role Service Driver Properties

After creating the Role Service driver, you can optionally modify some of the driver configuration
settings and modify the additional settings described in Table 2-1. To customize the additional

settings:
1 From the Outline view, select the Role Service driver, then right-click and select Properties.
2 Select Driver Configuration (in the left pane).
3 Click the Driver Parameters tab.

4 Click the Driver Options tab. You can modify the driver’s properties that you specified when
you created the driver as well as the properties described in Table 2-1.

5 Click OK to save the changes.

Table 2-1 Additional Settings for Customizing the Role Service Driver

Field Description
Number of days before processing removed The number of days the driver should wait before
request objects cleaning up request objects that have finished

processing. This value determines how long you
are able to track the status of requests that have
been fulfilled.
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Field

Description

Frequency of reevaluation of dynamic and nested
groups (in minutes)

Generate audit events

The number of minutes the driver should wait
before reevaluating dynamic and nested groups.
This value determines the timeliness of updates to
dynamic and nested groups used by the User
Application. In addition, this value can have an
impact on performance. Therefore, before
specifying a value for this option, you need to weigh
the performance cost against the benefit of having
up-to-date information in the User Application.

Determines whether audit events are generated by
the driver.

2.1.4 About E-Mail Notification Templates

Identity Manager includes a standard set of e-mail notification templates, (see “Working with E-
Mail Templates” in the User Application: Administration Guide). When you create a User
Application driver, any e-mail notification templates that are missing from the standard set are

replaced. However, existing e-mail notification templates, which might come from an earlier version

of ldentity Manager, are not updated. To replace existing templates with new templates:

1 Expand the Outline view.
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2 In the Default Notification Collection, delete the e-mail notification templates that you want to

replace.

3 Right-click Default Notification Collection and select Add Default Templates or Add All

Templates.

You can also use this command at any time to update e-mail notification templates without

creating a new User Application driver.

4 To deploy the e-mail notification templates to the Identity Vault, right-click Default
Notification Collection and select Live > Deploy.
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2.2 Accessing the Provisioning View

You can access the Provisioning view in the following ways:

+ Select Window > Show View > Provisioning.

+ In the Modeler window, right-click the User Application, then select Show View > Provisioning
View.

+ In the Outline view, right-click the User Application, then select Show Provisioning View.

When it is open, the Provisioning view displays all of the provisioning projects located in the same
workspace. The contents of the view depend on what version of the User Application driver you
selected when you created the project.

Figure 2-1 Sample Provisioning View
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The Provisioning view displays icons to indicate the object’s status. The icons are described in Table
2-2.

Table 2-2 Provisioning View Status Icons

Icon Description

e Indicates that the local object has changed.

i Indicates that the local object contains a validation warning.

E:] Indicates that the local object contains a validation error.

The User Application driver icon includes a tooltip that provides the project's Identity Vault name,
the DriverSet, the driver name, and the version. Figure 2-2 shows an example of the tooltip for a
Version 3.5 User Application driver.
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Figure 2-2 User Application Driver Tooltip
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TIP: If you do not see the User Applications that you expect, it might be because the project is
corrupt. If your project is corrupt, you must re-create it.

2.3 Setting Provisioning View Preferences

You can customize some Provisioning view behaviors by setting preferences. You access the
preferences page through Windows > Preferences > Novell > Provisioning. For more information,
see “Provisioning” in the “Setting Preferences” chapter of the Designer 4.0.1 for Identity Manager
4.0.1 Administration Guide.

2.4 Importing Provisioning Objects

The Provisioning view’s import feature lets you import provisioning objects in different ways.

¢ Section 2.4.1, “Importing from a Driver Configuration File,” on page 25
¢ Section 2.4.2, “Importing from an ldentity Vault,” on page 26
This feature is useful when you begin a new project based on one or more definitions from an

existing project, or when you want to share definitions with other developers working on the same
project.

NOTE: When you change the Identity Vault or driver set’s deploy context, you must save the
project before performing an import. If you do not save the change, Designer continues to use the
old deploy context for import operations.

2.4.1 Importing from a Driver Configuration File

To import objects from a driver configuration file:

1 Open the Provisioning view.
2 Select the root node representing the type of object you want to import.

3 Right-click the container and select Import from File. Confirm the import operation (which
might overwrite existing definitions of the same name) by clicking OK.

4 Specify the name of the driver configuration file you want to import, then click OK.

Trustee information is stored in the driver configuration file. When you import a driver
configuration file using Designer, the trustee information is processed as expected. If you import the
driver configuration file using iManager, the trustee information is ignored.

Working with the Provisioning View
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2.4.2 Importing from an Identity Vault

1 Open the Provisioning view and select the container into which you want to import the
definitions.

To import a specific provisioning object, select that node in the Provisioning view. To import
all objects of a specific type, select the root node representing that type.

2 Right-click the container and select one of the following:
+ Live > Import to import the contents of the currently selected container.
+ Live > Import Object to browse the Identity Vault and select the object to import.

+ Live > Import From to browse the Identity Vault and select a container whose contents
you want to import objects from.

If prompted, provide the Identity Vault credentials and click OK.

NOTE: For provisioning teams, Import Object imports only the team object. Import Team
Requests imports any associated team request objects.

3 Navigate to the Identity Vault container or object that you want to import and click OK.

4 Review the Import Summary page to determine how you want to proceed. To complete the
import, click Import, or click Cancel. If you click Import, Designer performs the operation and
displays a summary of the completed operation.

2.5 Exporting Provisioning Objects

The Provisioning view’s export feature allows you to move project components from one project to
another without re-creating the contents. It also allows you to clone a project. You can use it to
export provisioning objects (and their children) to an XML-based driver configuration file. You use
the resulting file as the input to the Import from File feature, enabling you to easily share the
contents of your provisioning project with other developers.

To export to a driver configuration file:

1 Open the Provisioning view and select the object containing the definitions to export.

To export a specific provisioning object, select that node in the Provisioning view. To export all
of the objects of a specific type, select the root node representing that type.

2 Right-click the container or object and select Export to File.
3 Provide the name and location of the file to generate, then click OK.

The default name for the file reflects the contents of the file. For example, if you export lists,
the default name for the file is lists.xml. You can change the name as needed.

2.6 Validating Provisioning Objects

The Validation feature allows you to validate provisioning objects on the local file system before
you deploy. The validation runs Designer’s project checker and displays the results in the Project
Checker view.

You can validate provisioning objects individually, by node (such as the directory abstraction layer,
a provisioning team, or a separation of duty constraint), or at the User Application driver level. Each
node (individual, container-level, or driver-level) has a right-click menu item called Validate. In
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addition, when you open an object in the editor, you can access the Validate option, for that item,
from Designer’s main menu and toolbar. For example, if you have a provisioning request definition
open in the editor, the main menu and toolbar provides a PRD > Validate menu option.

NOTE: Validation does not check the Identity Vault for the existence of any object.

Each object type has unique validation rules. They are described in each of the following sections:

+ Section 2.6.1, “Directory Abstraction Layer Objects,” on page 27
* Section 2.6.2, “Provisioning Request Definitions,” on page 27

+ Section 2.6.3, “Provisioning Teams,” on page 28

+ Section 2.6.4, “Role Configuration Objects,” on page 28

+ Section 2.6.5, “Roles,” on page 28

+ Section 2.6.6, “Resources,” on page 28

+ Section 2.6.7, “User Application Driver Locales,” on page 29

2.6.1 Directory Abstraction Layer Objects
Designer does the following:
+ \erifies that the XML is well-formed and complies with the schema that defines the elements
needed for entities, attributes, lists, relationships, and so on.
+ Checks every entity to ensure that references to other entities and global lists are valid.

For example, when validating an entity and its attributes, the validator checks that all
references to other entities via the Edit Entity, DNLookup, and Detail Entity references exist.

+ Ensures that every entity has at least one attribute defined.
+ Ensures that every local and global list contains at least one item.

2.6.2 Provisioning Request Definitions
Designer does the following:
+ Validates that every Provisioning Request Definition has at least one request form and one

approval form.

+ Ensures that the Condition Activity has both an outbound true flow path and an outbound false
flow path.

+ Ensures that the Entitlement Activity Data Item Mapping for DirXML-Entitlement-DN is
valid.

+ Ensures that the Final Timeout Action property (for User Activities) has a matching flow path
link leading from the activity. For example, if Final Timeout Action=denied, there must be a
denied link.

+ For Branch and Merge activities, ensures that a workflow has an equal number of Branch and
Merge activities. It also ensures that all paths descending from a Branch activity merge into one
Merge activity, that all merge activities have a branch activity, and that all Merge activities
have a branch-activity-id attribute.

+ Ensures that static list keys contain the correct data for the decimal data type.

Working with the Provisioning View
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2.6.3 Provisioning Teams

Designer does the following:

+ \alidates that managers and members have been defined for the team.
+ Validates that team requests are specified for the team.

+ If the request scope is Categories, it validates that the team request actually references a
category.

2.6.4 Role Configuration Objects

Designer does the following:
+ Ensures that the Quorum value should be a number between 0 and 100. Validation rules take
into consideration that a percentage can be entered.
+ Ensures that the Removal Grace Period is a positive number.
+ Ensures that Display Names and Descriptions use supported locales.

+ Ensures that the Provisioning Request Definitions defined for the Role Approval and SoD
Conflict Approvals are valid, are not templates, and whose process types match properly.

+ Separation of Duties (SoD) approvers must exist and be valid.

2.6.5 Roles

Before deployment, Designer validates that:

*

The category exists.

*

The description is provided for all supported languages.

*

The Quorum is a valid expression.
+ Approvers are present when the approval type is set to standard serial or parallel.

On deploy, Designer validates that the following objects exist in the Identity Vault:

+ The entitlement

+ The owner

+ The Role Trustees

+ The lower-level roles

+ Groups

+ Containers

+ Approvers

+ Provisioning request definition

2.6.6 Resources

Before deployment, Designer validates that:

+ The category exists.
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+ The description is provided for all supported languages.
+ The Quorum is a valid expression.
+ Approvers are present when the approval type is set to standard serial or parallel.

On deploy, Designer validates that the following objects exist in the Identity Vault:

+ The owner

+ The Resource Trustees

+ Approvers

+ Provisioning request definition

2.6.7 User Application Driver Locales

For the User Application driver locales, Designer ensures that the locales contain descriptions and
display names. You can turn off the validation of display names for each locale by setting a
preference. For more information, see Section 2.3, “Setting Provisioning View Preferences,” on
page 25.

2.7 Deploying Provisioning Objects

The Provisioning view’s Deploy feature deploys your provisioning objects to the specified User
Application driver. You must deploy any changes you’ve made to the provisioning objects in the
design environment before you see them reflected in the Identity Manager User Application. The
Provisioning view allows you to deploy a container and all its children (for example, all entities or
all lists), or to deploy just a single provisioning object (such as a single list element). When you
select an item to deploy, Designer compares it to the same item in the Identity Vault. If the items are
equal, Designer prevents you from deploying. When there are differences, Designer displays them
and allows you to proceed or to cancel the deployment.

NOTE: When you change the Identity Vault or driver set’s deploy context, you must save the
project before performing a deploy. If you do not save the change, Designer continues to use the old
deploy context for deploy operations.

Deployment and Versions

If you deploy a Version 4.0 User Application driver and the Identity Vault does not contain the
necessary 4.0 schema changes, the provisioning objects are not deployed and Designer displays an
error message in the Deploy Results dialog box. This is to prevent you from deploying a 4.0 driver
to a 3.0 Identity Vault.

2.7.1 Deploying Provisioning Objects

1 Save any changes.

If the objects contain unsaved changes, Designer displays the unsaved definitions and prompts
you to save them. If you do not, Designer still deploys the objects but does not deploy the
unsaved changes. Choosing not to save the changes does not cancel the deployment.

2 Open the Provisioning view, right-click the object to deploy, then select Live > Deploy or Live
> Deploy All.
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To deploy a specific provisioning object, select that node in the Provisioning view. To deploy
all of the objects of a specific type, select the root node representing that type.

Designer prompts you for Identity Vault credentials (if necessary), validates the objects, and
writes any messages to the project checker view.

When you deploy a driver that contains provisioning objects that fail validation, Designer
deploys the driver but not the invalid objects (regardless of the deployment preferences).
Designer displays the errors in the deployment result dialog box.

When you deploy a provisioning object that contains validation errors, Designer performs the
deployment based on the defined preferences and writes the errors to the Project Checker view.

+ “Tips for Deploying Provisioning Request Definitions” on page 30
+ “Deploying Roles” on page 30

Tips for Deploying Provisioning Request Definitions

+ If errors associated with activities are detected during deployment of a provisioning request
definition, Designer identifies the activity in which the error occurred by activity Id. However,
in the user interface, Designer by default displays activities by activity name. To make it easier
to identify the activity in an error message, turn on the display of activity Ids before you deploy
the provisioning request definition. To turn on the display of activity Ids, right-click the
Workflow canvas and select Show Activity Ids.

+ A common error occurs when you fail to replace a placeholder expression in an entitlement
provisioning activity. If this is the case, correct the error, then deploy the provisioning request
definition again.

+ Designer cannot evaluate expressions at design time, so it might display a warning when you
use an expression for an entitlement that must be resolved at runtime. This is not a fatal error
and the deployment will succeed.

+ Make sure that the Status is Active (in the Overview tab).

+ If a provisioning request definition with the same CN already exists in the Identity Vault, the
Deployment Summary displays the differences. You can review the differences before you
decide to proceed.

Deploying Roles

Because roles can be related through a role hierarchy, Designer notifies you, on deploy, if the role
you are deploying contains any dependent roles. To ensure that roles in the Identity Vault are in a
valid state, Designer requires that you deploy the role and any dependent roles at the same time by
displaying them in the dialog box shown in Figure 2-3 on page 31.
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Figure 2-3 Deploying Dependent Roles

] Deployment Dependencies Q@El

Deployment Dependencies

To deploy the selected objects, wou have to deploy the Following dependent objects as well,

(7 [ K ] [ Cancel

2.7.2 Testing the Deployed Changes

You can access the User Application from within Designer to view or test what you deploy:

1 Select Tools > Access User Application.

2 Choose the project and User Application driver container associated with the User Application
you want to view, then click OK.

Designer uses the driver configuration information that you defined for the project to make the
connection. Designer uses the browser settings specified in Windows > Preferences > General
> \Web Browser

2.8 Comparing Provisioning Objects

The Provisioning view’s Compare feature allows you to see the differences between the
provisioning objects in the local file system and those that are running in the deployed User
Application driver. When Designer encounters a difference, it allows you to specify what action you
want to take on that difference. You can ignore or reconcile it.

NOTE: When you change the Identity Vault or driver set’s deploy context, you must save the
project before performing a compare. If you do not save the change, Designer continues to use the
old deploy context for compare operations.

To compare provisioning objects:

1 Right-click a container or object in the Provisioning view, then select Live > Compare.
2 If prompted, provide Identity Vault credentials, then click OK.

Designer displays the results of the comparison. By default, only the differences are displayed,
but you can show the full comparison by deselecting Only show differences.

NOTE: For provisioning teams, you must select the container to compare the provisioning
request and provisioning team objects. If you select an individual team, it compares only the
provisioning team objects.
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3 If there are differences, select one of the following actions:

Reconcile Status Description

Do not reconcile Do not change any definitions.

Update Designer Import the definitions from the Identity Vault.

Update eDirectory Deploy the definition from Designer to the Identity Vault.

Reconciled by parent For informational purposes. Specifies whether one of the parent objects is
already being reconciled. It is always disabled and is only set if the parent
object is already being reconciled to Designer or the Identity Vault.

If a provisioning request definition or role object contains trustees, the trustees for the local object
are compared with the trustees defined for the object in the Identity Vault. Trustees are not compared
for directory abstraction layer objects.

2.9 Specifying Locales and Localization
Resource Groups

+ Section 2.9.1, “Specifying the Default Locale,” on page 32
+ Section 2.9.2, “Defining the User Application’s Supported Locales,” on page 32
+ Section 2.9.3, “Creating a Custom Localization Resource Group,” on page 35

2.9.1 Specifying the Default Locale

To specify the User Application driver’s default locale:

1 Right-click the User Application driver in the Provisioning view, then select Configure >
Default Locale.

2 Select the locale from the drop-down list box, then click OK. If you do not see the locale in the
list, you must add it through the Locales dialog box.

2.9.2 Defining the User Application’s Supported Locales

1 Right-click the User Application driver in the Provisioning view, then select Configure >
Locales. Designer displays the Supported Locales dialog box.
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Lets you localize all supported locales in one dialog box. When you click the
button, it launches this dialog box:

® Localize FEX
Select the target language and fill n the valuzs
a
souco i %] Tooe boowore: [ EEE I
Origin ~ Source Target
de Deutsch [ Germen J
en Englsch [Engish ]
es Spanisch [Spanish ]
fr Franzsisch [French | &
it Itallenisch [Ttatian ]
ja Japanisch [ 3apanese |
nl Niederlandisch [ Dutch ]
pt Partugiesisch [ Partuguese |
™
@

You can select the source language from which you want to translate the
names of the supported locales. Select the target language into which you
want to translate the names of the supported locales. Type the translation in
the Target field.

Lets you localize the display labels for the selected locale. This is the same
procedure described in Section 2.10, “Localizing Provisioning Objects,” on
page 37.
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2 Click : 57 then select the Language and optionally the Country from the drop-down list, or
type the value. The language is required, but the country is not. The language is displayed as
the Locale in the Supported Locales dialog box.

3 Click OK.

4 Click Resource groups, then click the localization resource group that you want to support the
new locale.

Locales and Resource Groups

@ Specify the locales and resource groups that should be used For WalDocDriver07 1707,

Locales | Resource Groups
&
+ Default Locales
b Accessory Portlets

» Base

-

Administrative

-

Requests and Approvals

-

Identity

-

Password Managment

@ [ Ok H Cancel ]

5 Click +* in the Locales area, then select the locale from the Available Locales list and move it
to the Selected Locales list, then click OK.

® X

Add Locales

Add one or more locales to the Identity resource group

Available Locales: Selected Locales:
Albanian {albania)
Armenian {Armenia) .y
r e
o
@ Ok ] [ Cancel
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2.9.3 Creating a Custom Localization Resource Group

1 Right-click the User Application driver in the Provisioning view, then select Configure >
Locales. Go to the Localization Resource Groups tab.

2 CBX

Locales and Localization Resource Groups

@ Specify the locales and resource groups that should be used for Rales_Userapplication.

Lacales |Localization Resource Groups

+ &

Default Locales

-

-

Common

-

Accessory Portlets

-

Base

-

Administrative

-

Requests and Approvals

-

Identity

-

Password Management

} Roles
2 Click i ¥,
* X
New Localization Resource Group
Create new resource group by specifying identifier and display name
Identifier: | |
Display Mame: | |
3 Complete the fields as follows:
Field Description
Identifier A unique name used to identify the localization resource group.
Display Name The name displayed in Designer to correspond with this group.

4 Click OK. The Localization Resource Groups property dialog box displays:

Working with the Provisioning View 35



Locales and Localization Resource Groups

(Z) Specify the locales and resource groups that should be used For Roles_UserApplication,

Lacales |Localization Resource Groups

+ &

+ Default Locales

-

Common

-

Accessory Portlets

-

Base

-

Administrative

-

Requests and Approvals

-

Identity

-

Password Management

-

Roles

~ Test b4
Identifier: Test_Resource_Graup

Display Marne: Test =

Descripkion: | &
Required Group: w
Locales:
4
#
®

5 Complete the fields as follows:

Button Description
4}_' Lets you add a new localization resource group.
4 Deletes the current localization resource group.
Lets you localize the localization resource groups in one dialog box.
Description Lets you add descriptive text for this entry.

Required Group

Lets you specify dependencies on other localization resource groups.

Localization resource groups are used for creating resource bundles for non-
standard language. The required groups are defined in the User Application:
Localization Toolkit Guide. Contact your Novell Sales Representative for more
information about the toolkit.
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Button Description

Locales Lets you add or remove the locales into which this localization resource group
must be localized. If the locale is not on the list, see “To specify the User
Application driver’s default locale:” on page 32.

2.10 Localizing Provisioning Objects

+ Section 2.10.1, “Using Designer to Localize,” on page 38

+ Section 2.10.2, “Supported Languages,” on page 39

+ Section 2.10.3, “Exporting and Importing Data to Localize,” on page 39

Designer allows you to translate the names and descriptions of provisioning objects into multiple
languages. Table 2-3 describes the types of provisioning objects that you can translate.

Table 2-3 Localizable Objects

Designer Tool

Description

Directory Abstraction Layer Editor

Provisioning Request Definition Editor

Provisioning Team Editor

Roles Catalog

Entity and attribute display labels
Relationship names
Global and local list items

Query display labels and parameter display labels

Activity properties that are displayed to the user

Form properties that are displayed to the user
Provisioning team display name and descriptions

Resource display label and description
Role display label and description
Separation of Duties display label and description

Role level display label and description

To localize the provisioning objects listed in Table 2-3:

1 Verify that the locale (or language) is supported by the User Application driver. See
Section 2.10.2, “Supported Languages,” on page 39 for the list of languages supported by

default.

2 If necessary, add the new locale (or language) to the User Application driver and to the resource
groups. For more information, see Section 2.9.2, “Defining the User Application’s Supported

Locales,” on page 32.

3 Translate the names and descriptions in one of the following ways:

3a Directly within Designer.

NOTE: You cannot edit the provisioning request definitions in the Attestation category.
For this reason, you cannot use this method for localizing them. You must use the method

described in Step 3b.
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For more information, see Section 2.10.1, “Using Designer to Localize,” on page 38.

3b By exporting the set of localizable objects into an external properties or XML file,
translating the contents of the file, then importing the data back into the project.

For more information, see Section 2.10.3, “Exporting and Importing Data to Localize,”
on page 39).

2.10.1 Using Designer to Localize
1 Click the localize button.

==l

When you click this button, Designer displays a dialog box that lets you add the localized text.
This is an example of the Localization dialog box.

@ Localization E]

Localization

(i) Spedify the localized string values For "Group”,
Chinese (China): | | |
Chinese {Taiwan): | f$:A i
Diukch: | Grogp |
English: | Group |
French: | Groupe |
Ferman: | Gruppe |
Italian: | Gruppo |
Japanese: B |
Partuguese: | Grupo !
Russian: [Fp';-'nna |
Spanish: | Grupo |
Swedish; | Grupp |

@ [ O ] [ Caricel ]

The languages displayed in this dialog box are the languages currently supported by the User
Application driver. If your language is not shown in this dialog, you must add it. For more
information, see Section 2.9.2, “Defining the User Application’s Supported Locales,” on page 32.

The directory abstraction layer editor provides multiple ways to localize data. You can access the
localization dialog boxes in these ways:

38 User Application: Design Guide



Table 2-4 Accessing the Localization Dialog Boxes

To define the localization text for... Perform this action...

Every localizable item in the directory Select DAL > Set Global Localization.

abstraction layer
or

Click Set Global Localization (from the editor’s toolbar), then
select the Target Language before entering the localized
text in the Target field.

A specific entity, relationship, or list From the tree view, right-click the object to localize, select
Localize, then select the Target Language before entering
the localized text in the Target field.

A single display label Select a specific entity or attribute, then click Localize
Display Label (beside the Display Label field in the Property
pane).

2.10.2 Supported Languages

You can localize the display labels, display names, and descriptions into the languages listed in the
localization dialog box. This list represents the languages (locales) supported by the User
Application driver. For information about adding new languages to this list, see Section 2.9,
“Specifying Locales and Localization Resource Groups,” on page 32.

The locale configuration is stored in the driver’s <default-locale> element in the
AppConfig.AppDefs.locale-configuration XMLData attribute.

You must provide a display label for the User Application driver’s default language, or the User
Application generates the following runtime error: The resource resolver
com.novell_soa.common.i18n.LocalizedMapResolver did not return a resource for
the default locale of <locale>. It is required that a resource exist for the
default local.

2.10.3 Exporting and Importing Data to Localize

You can export the localizable data (such as display names and descriptions) in your project to an
XML or properties file. After the data in that file is translated, you can import it back to the Designer
project. You can export an entire driver, one object, or a subset of objects.

+ “Exporting Data to Localize” on page 39
+ “Importing Localized Files” on page 41
Exporting Data to Localize

1 Right-click a container node or an object in the Provisioning view.
2 Select Localize > Export Localization Data.
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Export Localization Data

Select the Folder to store the exported localization data.

File Locations

Store in Folder: | Ci\Documents and Settings'testpworkspacelwalDocDriver 1026 \ProvisioningappConfig|Request Defs | [Browse... ]

Prefix For generated Files: | WalDocDriver 1026_Provisioning Request Definitions |

File bype: [@F: ¢ (%) Properties

Languages

Select the languages to expork:

Locale Language
O nl Dutch
O &n English
O fr French
O de GErmEn
O it Italian
O ja Japanese
O uls Portuguese
O zh-CN Simplified Chinese
| a5 Spanish
O zh-Tw Traditional Chinese

[JPrompt before overwriting existing files

ey .
2) Firish Cancel

3 Fill in the fields as follows:
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Field Description

Store in folder Specify the name of a local folder where the
exported files should be written.

Prefix for generated files Specify a prefix for the generated files.
Determine a naming strategy so you are able to
identity the files for projects.

File Type Select XML or Properties depending on the
encoding or format you prefer. XML files are
UTF-8 encoded. Properties use Unicode*.

Select the languages to export Select the languages you want localizations for.
A file containing the display label key is
generated for that language. The localizations
need to be added to this file in the proper format
S0 you can import them to the proper User
Application driver objects.

Prompt before overwriting existing files If this option is selected, Designer prompts you
before it overwrites any existing files of the same
name in the target directory.

4 Click Finish. Designer displays a message describing the result of the export operation and the
location of the exported data.

Importing Localized Files

1 Right-click a container node or an object in the Provisioning view, then select Localize >
Import Localization Data.
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Import Localization Data

Select the Folder containing the localization Files to import,

Search in Folder: | C:\Documents and SettingsitestiworkspacelwalDocDriver 1 026\ ProvisioningbAppConfigiRequestDefs | [Browse... ]

File bvpe Preferences

@ wML I:‘ Suppress warnings about unused strings

() Properties [] Create backup of existing display label strings
Files

Select the files bo import:

File: Language

@

2 Fill in the fields as follows:
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Field

Description

Search in folder

File Type

Preferences

Files

Specify the folder location where the files to
import are located.

Select XML if the file you want to import is in
XML format.

Select Properties if the file you want to import is
in the properties format.

Select Suppress warnings about unused strings
if you want the wizard to suppress warning
messages.

Select Create backup of existing display label
strings if you want the wizard to create a backup
of the existing strings before the import. Useful in
case you need to revert.

Select the files to import. This table is populated
with the files from the folder location and file type
specified above. If it is blank, no files of the
specified type are located in the target folder.
The wizard attempts to determine the language
by looking at the filename. If the name cannot be
determined, it defaults to English.

You can change the Language column if the
wizard assumes the wrong language. The wizard
changes the filename to reflect the language you
specify and import the display labels to the
corresponding language.

3 Click Finish to complete the import. Designer displays a status dialog box that describes the

results including any errors reading the files and any warnings about display label keys that are

unused.
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Configuring the Directory
Abstraction Layer

This section provides details on configuring the directory abstraction layer. Topics include:

+ Section 3.1, “About the Directory Abstraction Layer,” on page 45
+ Section 3.2, “Working with Entities and Attributes,” on page 49

*

Section 3.3, “Working with Lists,” on page 57

*

Section 3.4, “Working with Queries,” on page 61

*

Section 3.5, “Working with Relationships,” on page 64

*

Section 3.6, “Working with Configuration Settings,” on page 67

*

Section 3.7, “Directory Abstraction Layer Property Reference,” on page 68

3.1 About the Directory Abstraction Layer

The directory abstraction layer is a set of XML-based files that define a logical view of an Identity
Vault for the User Application. The User Application uses the directory abstraction layer definitions
to determine:

+ The Identity Vault objects and attributes that the User Application can display or modify.

+ How the User Application displays Identity Vault data.

+ The relationships the User Application can display.

+ The provisioning request categories, e-mail notification types, and delegate relationships the

User Application can display.

The User Application ships with a default set of entities, relationships, and lists that it needs to
function, but you can add new or modify existing directory abstraction layer objects to customize
the User Application for your own business needs. You use the directory abstraction layer editor to
define the contents of the directory abstraction layer.

+ Section 3.1.1, “Analyzing the User Application’s Data Needs,” on page 46

+ Section 3.1.2, “About the Directory Abstraction Layer Editor,” on page 46

+ Section 3.1.3, “About Directory Abstraction Layer Editor Files,” on page 48

Configuring the Directory Abstraction Layer
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3.1.1 Analyzing the User Application’s Data Needs

Before you make changes to the directory abstraction layer objects, analyze how you want to display
your ldentity Vault data in the User Application. Consider:

+ What parts of the Identity Vault you want to make available to the User Application.

For example, what objects do you want your users to be allowed to search and display? Check
this list against the base set of abstraction layer definitions to determine if you need to add any
new objects.

+ What is the structure of your Identity Vault schema? Have you added custom extensions and
auxiliary classes?

+ What is the structure of your data?

*

What is required and what is optional?

*

What validation rules are in place?

*

What are the relationships between objects (DN references)?

*

How are the attributes defined? (For example, an attribute that represents a phone number
might be multi-valued for home, office, and cell phone numbers)

+ Who sees the data? Is the User Application available as a public or private site?

Use the information about your data needs to map your Identity Vault objects to abstraction layer
entities.

3.1.2 About the Directory Abstraction Layer Editor

The directory abstraction layer editor is a graphical tool for defining the directory abstraction layer
files. When you add a User Application driver to an Identity Manager project and run the
configuration wizard, Designer creates an initial set of directory abstraction layer files. If you do not
run the configuration wizard, the initial files are not created. These base files are displayed when
you start the directory abstraction layer editor.

To start the directory abstraction layer editor:

1 Open the Provisioning view and double-click the Directory Abstraction Layer node.

Designer displays the directory abstraction layer tree containing nodes for Entities, Lists,
Queries, Relationships, and Configuration.
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@ Si'alDor

iver - Directary Abskraction Laver X

B A $
144 Entities
[ Lists
Queries

@ Relationships
L Configuration

Node

Description

Entities

Lists

Queries

Entities represent the Identity Vault objects
available to the User Application. There are two
types of entities:

¢ Entities mapped from the schema: Entities
that represent Identity Vault objects directly
exposed to users via the User Application.
Users can typically create, search, and
modify the attributes of these entities.

¢ Entities representing LDAP relationships:
Called DN lookups, these entities represent
indexed searches and are used to support
particular types of attributes in the User
Application. DN lookup entities provide
information about relationships between
LDAP objects. DN lookup entities are:

+ Used by the Org Chart portlet to
determine relationships.

¢ Used in the Search List, Create, and
Detail portlets to provide selection lists
and DN contexts.

+ Available to the workflow request and
approval flow forms you define using
the provisioning request definition
editor.

Defines the contents of global lists. Global lists
are:

+ Associated with an attribute. The User
Application displays the attribute values as
a drop-down list in the User Application.

+ Used to display Resource Request
categories.

Lets you define LDAP search criteria that can be
run from a workflow form.
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Node Description

Relationships Lets you map hierarchical relationships among
schema-based entities. Used by the
Organization Chart action of the Identity Self-
Service tab of the User Application and in
iManager when defining provisioning s.

Configuration General configuration parameters.

2 Use the left pane to navigate the directory abstraction layer nodes. When you select an item in
the left pane, the right pane displays the properties for the selection.

3 Use the right pane to define the properties for the selection. For more information about the
properties, see Section 3.7, “Directory Abstraction Layer Property Reference,” on page 68.

The following table describes the directory abstraction layer toolbar:

Table 3-1 Directory Abstraction Layer Toolbar

Toolbar Button Description
J.]; Launches the Add Entity Wizard.
@ Launches the Add Attribute Wizard.
& Launches the New List Wizard.
Q Launches the New Query Wizard
Launches the New Relationship Wizard.
-
g
& Launches the Set Global Access Modifiers dialog box.
O Launches the Set Global Localization dialog box.
P Expands and collapses the directory abstraction layer tree.
HiE

3.1.3 About Directory Abstraction Layer Editor Files

The directory abstraction layer files you work with are stored in the Designer project’s
Provisioning\AppConfig\DirectoryModel directory. The filenames are derived from the object
key.
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Table 3-2 Local Directory Abstraction Layer Directories

Directory name Description

ChoiceDefs Contains the files that define global lists. Files have the choice extension.

EntityDefs Contains the files that define the entities and attributes. Files have the entity
extension.

QueryDefs Contains the files that define queries. Files have the query extension.

RelationshipDefs  Contains the files that define the relationships available to the Org Chart portlet
and iManager provisioning configuration. These files have the relation
extension.

Designer creates the base set of directory abstraction layer files for each provisioning project. An
identical set is added to the User Application driver when the User Application is installed.

To customize the Identity Manager User Application, you change the directory abstraction layer
objects and the changes to the User Application driver. Some entities, attributes, lists, and
relationships are required for the User Application to function properly. The editor displays a lock
next to the definitions that you should not delete. From the list below, you can see that you should
not delete the Group, User or User Lookup entities.

Figure 3-1 DAL User Application Default Entities, Lists, and Relationships

+
=
3[4 User Lookup
= [ Lists
|—,_‘, Delegate Relationship
|—,_‘, Email natification bypes
|—,_‘, Provisioning Cateqgary
|—,_', Roles Category

@ Queries
= @ Relationships
#% Group's membership
#1 Manager-Emploves
#9 User groups
4 Corfiguration

If you define multiple User Application drivers in a single project, Designer creates multiple
AppConfig folders and names them AppConfig, AppConfigl, AppConfig2, and so on.

3.2 Working with Entities and Attributes

You can customize your User Application by adding objects and their attributes based on the content
of your own Identity Vault. You do this by adding new entities and attributes to the directory
abstraction layer and deploying them to the User Application driver.

To modify the entity files installed by default, see Section 3.2.2, “Adding Entities,” on page 51 and
Section 3.2.3, “Adding Attributes,” on page 55. To modify the entity files of an already ed project or
a set of files defined by another developer, you must first import the files to your design
environment. For information on importing files, see Section 2.4, “Importing Provisioning Objects,”
on page 25.
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3.2.1 About Entities and Attributes

Any Identity Vault object that you want users to search, display, or edit in the Identity Manager User
Application must be defined as an entity in the directory abstraction layer. For example, to use the
inetOrgPerson ldentity Vault object in the User Application, you must create an entity definition for
it. There are two logical kinds of entities (but you create them the same way):

+ Entities that are mapped from schema: These entities represent objects that exist in the
Identity Vault that are directly exposed to users in the User Application. When defining this
type of entity, expose all of the attributes that you want your users to work with. Examples of
this entity type include User and Group. You can create more than one entity definition for the
same object to expose different sets of attributes to different kinds of users. For more
information, see “Creating Multiple Entity Definitions for a Single Object” on page 50.

+ Entities that represent LDAP relationships: This type of entity is known as a DNLookup and
it is used by the User Application to:

+ Populate a list with the results of a DN search among related entities
+ Maintain referential integrity across DN referenced attributes during updates and deletes

Entities that support DNLookups are used by the Org Chart portlet to determine relationships
and are also used by the Search, Create, and Detail portlets to provide pop-up selection lists and
DN contexts. The User Lookup entity is an example of this type of entity. For more
information, see “Attributes and DNLookup Properties” on page 77.

Creating Multiple Entity Definitions for a Single Object

You can create more than one entity definition that represents the same Identity Vault object but
provides a different view of the data. Within the entity definitions, you can define different attributes
for each entity definition, or you can define the same attributes but specify different access
properties that control how the attributes are searched, viewed, edited, or hidden.

NOTE: You can optionally define a filter to hide certain entities from the result set.

You can then use these different entity definitions in different parts of the user interface. For
example, suppose that you want to create a directory of employees; one for a public site and one for
an internal site. On the public site you want to supply first and last names and a phone number, but
on the internal site, you want to list additional information like title, managers, and so on. Here’s
how you can accomplish this:

1 Create two entity definitions (with different keys).

Both entity definitions expose the same Identity Vault object, but one entity definition key is
public-staff-information, and the other is internal-staff-information.

2 Within each entity definition, define a different set of attributes: one for public-staff-
information, the other for internal-staff-information.

3 Use the Portal Administration tab of the Identity Manager User Application to create a portlet
instance for the public page, and another one for the internal page.

For more information about creating portlet instances, see the Portlet Reference section in the
Identity Manager 3.5 User Application: Administration Guide.

50 User Application: Design Guide



3.2.2 Adding Entities

You add entities through the Add Entity Wizard (described in the next procedure) or by clicking Add
Entity (from the toolbar).

NOTE: When using the Add Entity button, you are prompted to select the object class of the entity
to create, and the editor automatically adds the required attributes to the entity. Use the Add
Attribute dialog box to complete the entity definition.

To add an entity using the Add Entity Wizard:

1 Launch the Add Entity Wizard in one of these ways:
From Designer’s menus:

+ Select File > New > Provisioning. Choose Directory Abstraction Layer Entity, then click
Next.

From the Provisioning view:
+ Right-click the Entities node, then choose New.
From the directory abstraction layer editor:
+ Select DAL > New > Entity
or
+ Right-click the Entities node, then choose New Entity-Attributes Wizard.
The New Entity dialog box displays.

NOTE: If launched from the File menu, the dialog box contains the additional fields shown
below.
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Mew Entity

Specify project and application For the new entity as well as the display name and
kery For the new entity,

Identity Manager Project: |Pr0ject0ne j
Provisioning Application: |User Application j
Enkity Key: |
Display Label; |

Cancel

2 Fill in the fields as follows:

Field

Description

Identity Manager Project and
Provisioning Application

Entity Key

Display Label

The Identity Manager project and the provisioning
application where you want to add the entity and
attributes.

NOTE: These fields display when you launch the wizard
from the File menu.

A unique identifier for the entity.

The string displayed when the entity is displayed by the
User Application. You can localize this label. For more
information, see Section 2.10, “Localizing Provisioning
Objects,” on page 37.

3 Click Next. The New Entity dialog box displays:

User Application: Design Guide



MNew Entity

Select the Object Class that will define your new Entity,
Then select and add any Attribubes you want created in the Entity.

Select Object Class:

AFP Server A o i i
alias == Configure Filker. ..

applicationEntity
applicationProcess
audit:File Object
Bindery Object
Bindery Queue
CommExec
Campukter

Counkry
cRLDiskributionPoink
Device

Directory Map
Diir=ML-Drrivver
Dir£ML-Driver et e

By ailable Attributes For Enkity: Selected Attributes in Entity:

4 Choose the entity’s object class and add the attributes you want by double-clicking them in the
Available Attributes for Entity list. Mandatory attributes are added when you select an Object
Class, and you cannot remove them from the Selected Attributes in Entity list.

TIP: If the entity’s object class is not shown in the Select Object Class list, you should update
Designer’s local schema file by following the steps described in Section 3.2.4, “Updating the
Schema Elements List,” on page 57.

5 Click Finish.

The property page displays for editing. For more information, see “Entity Properties” on
page 68. You must deploy the entity before it is available to the User Application.
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Filter the Object Class List

You can limit the object classes shown in the New Entity dialog box by adding a filter. To add a

filter:

1 Click Configure Filter to launch the Class List Filters dialog box.

E“-:,]. Class Filters

Manage the filkers applied ko the Class list,

conkains w

starts-with 'DirsML’
starts-with ‘spvpry’

[SE|E.'I:|Z all ] ’Deselect all ]

Ik, ] ’ Cancel

By default, Designer does not apply any class filters. The Class Filter dialog box contains two
predefined filters (starts-with "DirXML" and starts-with "srvprv"). To activate them, click

Select All, then click OK. The filters are immediately applied to the object class list. Filters are
applied until you deselect them.

2 Use the buttons as follows:

Button

Description

conkains w | |

Choose one of the string comparison operators, such
as contains, starts-with, ends-with, then type the
string to compare against.
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Button Description

Adds a filter. Enabled when you define the filter
r comparison value.

Removes the selected filter.

Click this option when you want to use all of the

filters. It selects all of the defined filters.

Click this option when you want to deselect all of the
ki defined filters. If you apply this change, no filters are

used.

Adding Entity Filters

You define an entity filter to limit the entries returned for the specified entity. You define the filter
based on attributes and their comparison to another value that you specify. For example, you can
create a filter so that the User entity includes only those entries whose Region attribute contains
Northeast.

1 Click Add Condition Grouping.

- Filter
Specify attribute filter conditions Far the entity:

(%P Add Condition Grouping

(% Remaove Condition Grouping b

Region “ | | contains w b4

Use the drop-down list on the left to select an attribute.
Use the drop-down list in the middle to select a comparison operation.
Use the entry on the right to specify a value for comparison.

ga b~ 0N

To specify multiple condition groupings, repeat this procedure. Within a condition grouping,
you specify each criterion that you want and connect them by using the logical operations: and,
or.

The conditions are evaluated in the order in which you define them.

3.2.3 Adding Attributes

1 Select an entity.
2 Do any of the following to add an attribute:
+ Right-click an entity, then select Add Attribute.
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or

+ Click the Add Attribute button.
or

+ Click DAL > New > Attribute.

You are prompted to choose the entity class that contains the attributes that you want to add to
the entity. You can also add (and remove) auxiliary classes if you need to add a class that
contains the attribute you are looking for.

Add Attribute

@ Select an Entity to display its list of available directory attributes,
Then select and add any attribubes vou want created in wour Entity,

Selected Entity:

N |

Entity Classes:

’Addp’Remnve aux classes, .,

Available Attributes For Entity Class: Entity Attributes:

DAL Calculated Attribute S = (4 Group
ACL . -~
fudit:Fils Link L’;—!‘ Description
Authority Revocation @ Members
auxClassCompatibilicy
Back Link,

Bindery Property
businessiCateqary

CA Private Key

A Public Key

Certificabe Revocation
Certificate Yalidity Interval
M

creatorshame

Cross Certificate Pair
Description

Dir 2ML-Associakions

EMail Address

Equivalent To Me

Full Mame

[11n]

GUID

L
Lask Referenced Time L

)] [ oK H Carcel l

3 Add attributes by double-clicking them in the Available Attributes for Entity Class list.

LDAP operational attributes are supported by the directory abstraction layer editor and User
Application; however, when you add an operational attribute, the Edit, Required, and Hidden
properties are set to false and are disabled so you cannot change these property values.

TIP: If the attribute you want to add is not displayed in the Available Attributes from Entity
Class list, you should update Designer’s local schema file by following the procedure in
Section 3.2.4, “Updating the Schema Elements List,” on page 57.
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4 Click OK. The property page displays for editing.

For more information, see “Attribute Properties” on page 72. To make an attribute available to
the User Application, you must deploy it.

Adding DAL Calculated Attributes

You can create an attribute that is derived from an expression. For example, you can concatenate two
or more attributes to produce a single calculated value. The expressions are ECMAScript compatible
and conform to the ECMA 262 Language specification.

Restrictions: Because this attribute type does not map to a specific attribute in the Identity Vault,
these attributes cannot be updated, removed, multivalued, required, or searched.

To create a calculated attribute:

1 Add an attribute as instructed in Section 3.2.3, “Adding Attributes,” on page 55 and make sure
to select DAL Calculated Attribute from the Available Attributes for Entity Class list.

Designer adds the Attribute with the following restrictions:

Table 3-3 Calculated Attribute Properties

Property Name Description

Expression Click Build ECMAScript Expression to launch the
ECMA Expression Builder. To learn more about
how to use the ECMA Expression Builder, see
Chapter 9, “Working with ECMA Expressions,” on
page 317.

3.2.4 Updating the Schema Elements List
1 With the Identity Manager project open, right-click your Identity Vault, then select Live >
Import Schema.
2 Choose Import from eDirectory and provide the specifications for the eDirectory host.
3 Click Next.
4 Select the classes and attributes to import, then click Finish.

3.3 Working with Lists

The lists node lets you define the contents of global lists. You can then define an attribute control
type as a global list. When the User Application displays the attribute for editing, the contents of the
global list are displayed in a drop-down list for the user to make a selection. By default, the directory
abstraction layer includes the global lists described in Table 3-4.
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Table 3-4 Directory Abstraction Layer Default Global Lists

List Name Description

Delegate Relationship Defines the relationships that can be selected when making a Delegate
Assignment by relationship. The contents of this list display in a drop-
down list box. The values can only be DN attributes from the User entity.

Email Notification Types Represents the type of e-mail notification that a user wants to receive
when involved in proxy/delegate processing of resource requests. Types
are locked.

WARNING: Do not edit these values.

This is used by the Preferred Notification attribute of the user entity.

Provisioning Category Defines the set of categories that organize provisioned resources
(entitlements) and provisioning requests. The categories in this list
display in:

+ Designer: Provisioning request definition editor plug-in
+ iManager: Provisioning Request Configuration plug-in
+ User Application: Requests and Approvals tab

Resources Category Defines the set of categories that organize resources. The categories
are displayed in:

+ Designer: Role Plug-in

+ User Application: Roles and Resources tab

Roles Category Defines the set of categories that organize roles. The categories are
displayed in:

+ Designer: Role plug-in

+ User Application: Roles tab

NOTE: You cannot delete these lists or change the key values for the lists. Except for the Email
Notification types, you can add and remove items and change existing values and labels.

To create a new global list:

1 Launch the New List Wizard in one of these ways:
From Designer’s menus:

+ Select File > New > Provisioning, select Directory Abstraction Layer List, then click
Next.

When launched from the File menu, the dialog box contains fields not displayed when
launched in other ways.

+ Select DAL > New > List.
From the Provisioning view:
+ Right-click the Lists node, then select New.
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From the directory abstraction layer editor:

+ Click New List.

+ Right-click the Lists node, then select Add List.
The New List dialog box displays.

Mew List

Specify project and application For the new list as well as the key for the
new lisk,

Identity Manager Project: |TestF‘rDject

EREN

Prowisioning Application: |User Application

Lisk Key: |

Display Label; |

| | Cancel

2 Fill in the fields as follows:

Field Description

Identity Manager Project and Provisioning Select the Identity Manager project and

Application provisioning application where you want to add
the list.

NOTE: These fields display when you launch the
wizard from the File menu.

List Key The unique identifier for the list.

Display Label The string used when the list is displayed in the
User Application. You can localize this label. For
more information, see Section 2.10, “Localizing
Provisioning Objects,” on page 37.

3 Click Finish.The Global Lists property page displays for editing.
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[F] Test List

Global List
Provide a user-friendly label For the list, Click '+ o add valuejlabel itemns to the lisk:
Eey: TestLisk

Display Label; | Test Lisk

s 2 =
= ¢ & B
Values Labels
valuel label1 -4

4 Fill in the fields as follows:

Field Description

Display Label The name of the list. This is the name displayed in Designer.

Labels The text for the list item to display in the User Application.

Values The list item value stored in the Identity Vault. Valid characters include

letters, numbers, and the underscore (_) character.

The following table describes the wizard’s buttons:

Button Description

= Adds a new value

..UJ

Y Moves the row up or down in the list. This order specifies how the labels are
displayed in the User Application.

¥

B Displays the localization dialog box. For more information on using the dialog

= box, see Section 2.10, “Localizing Provisioning Objects,” on page 37.

Deletes the row.

*

5 Save the project.
6 to make it available to the User Application.
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3.4 Working with Queries

The Queries node allows you to define commonly used LDAP searches that you can execute from a
request or approval form by using the DNQuery control or by calling the globalQuery() method. To
define the query, you specify the directory abstraction layer entity, the search root, the number of
rows to retrieve, and the conditions for retrieving the source entity. You can hard-code the conditions
(for example, Where LastName contains s) or specify one or more parameters that are supplied by
the user on the request or approval form.

To create a query:

1 Launch the New Query Wizard in any of these ways:
From Designer’s menus:

+ Select File > New > Provisioning. Choose Directory Abstraction Layer Query, then click
Next.

+ Select DAL > New > Query.
From the Provisioning view:

+ Right-click Query, then select Add.
From the directory abstraction layer editor:

+ Click the Add Query button.

+ Right-click Query, then select Add Query.
The New Query dialog box displays.

NOTE: When launched from the File menu, the dialog box contains fields not displayed when
launched in other ways.

B New Query E|

Newr (Query

Specify project and application For the new query as well as the display
name and key for the new query,

Identity Manager Project: | walDocDriver W
Prowisioning Application: | User Application w
Query Key:

Display Label:

Cancel

2 Fill in the fields as follows:
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Field What to do

Identity Manager Project and Select the correct Identity Manager project and Provisioning
Provisioning Application Application.

NOTE: This field displays when you create queries from the
File menu.

Query Key Type a unique value for the query key. This value is used in
the Expression Builder to identify the query.

Display Label Type a string to display in the directory abstraction layer
editor and Provisioning view. This value is not visible in the
Expression Builder.

3 Click Finish.
The editor creates the query and opens the property page for editing.

@ Sample Query @

General
Provide a user-friendly label For the query:
Key: SampleCiuery

Display Label: | Sample Query %?

Query Entity: | <Select an item = L3

~ Parameters
Define parameter references:

= & & B

+ Query Conditions
Provide conditions For the query entity selected above:

{4 add Condition Grouping

- Search

Provide search constraints For the query:

Search Rook: 2] @-

Search Scope: <Default> v

Max Search Entries; |0 “ | (D=use runtime setting)

4 Select a Query Entity. If the entity you want to use is not displayed, make sure it is defined in
the Entities node.

5 In the Parameters section, define one or more parameters for the query. To add parameters:
5a Click Add Row.
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~ Parameters
Define parameter references:

S
Parameter Keys Parameter Display Labels
labell b4

5b Specify a unique key and a display label for the parameter. You pass this key when calling
the globalQuery() method on a form. For more information on globalQuery(), see
“globalQuery(fieldname, key, param)” on page 337.

5c¢ Add additional parameters by repeating these steps.
6 To further refine the query, add Query Conditions.

6a Click Add Condition Grouping (a Query Entity must be selected to enable Add Condition
Grouping).

+ Query Conditions
Provide conditions For the query entity selected above:

' 4F &dd Condition Grouping

% Remove Condition Grouping =

<Select anitem W | | <3elect an ikem v O, 4

6b Use the drop-down list on the left to select an attribute. The attributes in this drop-down
are the attributes on the selected Query Entity.

6¢ Use the drop-down in the middle to select a comparison operation to perform against your
chosen attribute.

6d Use the entry on the right to specify a value to compare against your chosen attribute. You
can select a variable name by clicking Predefined Parameters to launch the Predefined
Parameters dialog box.
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B (%]

Parameters

Select one of the predefined parameters For your Figld,

“egroupnanmes

I2) [ K, H Cancel ]

If the query needs to filter on more than one attribute or condition and you want to control
the order in which the conditions are evaluated, you can define multiple conditions or
condition groups. Within a condition grouping, you specify each criterion that you want
and connect them by using the logical operations: and, or.

7 To specify multiple condition groupings, click Add Condition Groupings and make your
selections from the drop-down list boxes.

8 Define the query’s LDAP Search properties if you want to narrow the search further than
already defined for the selected entity. The query’s search root, unlike the entity search root,
does not support the use of predefined parameters. For more information, see Section 3.7.3,
“Queries Properties,” on page 81.

9 Click Save.
10 the query to make it available to the User Application.

3.5 Working with Relationships

The Relationships node allows you to define relationships between entities defined in the directory
abstraction layer. The relationships you define are used in the User Application by the Organization
Chart and in iManager for defining the members within a group.

The relationship you define can be between like entities (such as user/user) or unlike entities (such
as user/device). You can define conditions for the relationship to further refine it. For example, you
might want to create a condition that shows all Manager-Employee relationships and then refine it to
show only employees in one particular region, or show all the subordinates of a vice president
located in the eastern region.

The following relationships are defined, by default, for the User Application:

+ Group’s membership (Org Chart only)
+ Manager-Employee (Org Chart and Management)
+ User groups (Org Chart only)

A relationship can only be used by Management when the Source and Target entities are both related
to the InetOrgPerson object.
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To successfully deploy a relationship, all of the components (entities and attributes) of the
relationship must already be deployed.
1 Create a new relationship in any of these ways:
From Designer’s menus:

+ Select File > New > Provisioning. Choose Directory Abstraction Layer Relationship, then
click Next.

+ Select DAL > New > Relationship.
From the Provisioning view:

+ Right-click Relationships, then select Add.
From the directory abstraction layer editor:

+ Click the Add Relationship button.

+ Right-click Relationships, then select Add Relationship.
The New Relationship dialog box displays.

NOTE: When launched from the File menu, the dialog box contains fields not displayed when
launched in other ways.

News Relationship

Specify project and application For the new relationship as well as the
display name and key for the new relationship,

Identity Manager Project: |Project0ne

Led Lo

Prowisioning Application: |User Application

Relationship Kew: | |

Display Label; |

< Back | | Cancel

2 Fill in the fields as follows:

Field What to do
Identity Manager Project and Select the correct Identity Manager project and Provisioning
Provisioning Application Application.

NOTE: This field displays when you create relationships from
the File menu.

Relationship Key Type a unique value for the relationship key.
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Field What to do

Display Label Type the string to display when the relationship displays in
the User Application.

3 Click Finish.
The editor creates the relationship and opens the property page for editing.

- 1 H
§ | m =z |# Group's membership
=144 Entities a
ccess
C’}‘J Description Specify the bype of application which can use this relationship:
C,‘J Members [#]used by Organizational Chark
+ '\j Manager Laookup
e 'ﬂj User
+ el User Lookup
=[] Lists

Relationship

El Delegates Relationship Provide a user-friendly label For the relationship:

m Ernail notification types

El Preferred Locale key: R
El Provisioning Categary Display Label: | Group's membership %?
] request Scope
@ Queries

= @ Relationships Source Dbject Target Object
] Groun's menbership Source Entity: Group “ | Target Entity: User -
#4 Manager-Employes
#1 User groups Source Attribube: | This entity's key ~ | Target Attribute: | Group v

5 configuration

~ Conditions

Specify any additional conditions For your target attribute: e

For property definitions, see Section 3.7.4, “Relationship Properties,” on page 82.
To delete a relationship:
1 Right-click the relationship you want to delete, then click Delete.
To add a relationship condition:

1 Click Add Row.

2 Use the drop-down list box (on the left) to select an attribute. The attributes in this drop-down
are attributes on the Target Object entity.

3 Select an operator from the middle drop-down list box.
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4 Use the text field on the right to specify the comparison value to complete the condition. For
example:

¥ Manager-Employee(region)
Access
Specify the type of application which can use this relationship:

Used by Organizational Chart [CJEnable Cascading Relationship

Used by Team-Management 0 o | Maximum levels to cascads

Relationship
Provide a user-frisndly label For the relationship:
Key! UsErZIserss

Display Label: | Manager-Employesiregion) &=

Source Object Target Object
Source Enkiby: User | Targek Entiby: User L

Source Attribute: | This entity's key “ | Target Attribute: |Manager -

= Conditions

Specify any additional conditions For your target attribute: S

Reqion * | | equals + | | Latin ®

You can create a condition that filters on more than one attribute or condition and connect the
attributes by using the logical operations: and, or. The conditions are evaluated in the order in which
you define them.

3.6 Working with Configuration Settings

The Configuration node allows you to set general configuration properties for the User Application.

Table 3-5 Configuration Settings

Field Description

Default ‘My Profile’ Entity Defines the entity to display when the user clicks My Profile in the
user interface.

This field is restricted to show only entities whose object class is
user (or LDAP inetOrgPerson).

Default LDAP Naming Attributes Defines the default LDAP naming attribute if the entity’s Create
Naming Attribute is not defined.
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Field

Description

Default Management Attributes

Container Classes

The attributes used to look up members. In the My 's Work and My
's Settings pages of the User Application, the user is able to search
for members by clicking the search icon. For example:

Team Metmhber: E

The search displays the attributes specified here, for example:

Ohject Lookup S ]

Search ohject list, (example; &%, Lar®, 1D, *1)

LastMame

| ™% Search

These settings only affect the lookups performed by Managers.
The User Application administrator sees only First Name and Last
Name.

This provides the Create User or Group action with the contents of
a selection list of container classes. The user selects a container
from the selection list as the location for the newly created object.

3.7 Directory Abstraction Layer Property

Reference

The section provides definitions for the properties for the following abstraction layer nodes:

*

*

*

*

Section 3.7.1, “Entity Properties,” on page 68
Section 3.7.2, “Attribute Properties,” on page 72
Section 3.7.3, “Queries Properties,” on page 81
Section 3.7.4, “Relationship Properties,” on page 82

3.7.1 Entity Properties

You can set the following kinds of properties on entities:

+ “Entity Access Properties” on page 69

+ “Entity General Properties” on page 69

+ “Entity Auxiliary Properties” on page 69

+ “Entity Search Properties” on page 70
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+ “Entity Create Properties” on page 71
+ “Entity Password Management Properties” on page 71
+ “Using Predefined Parameters” on page 71

Entity Access Properties

Access properties control how the User Application interacts with the entity.

NOTE: You can also access the access properties by selecting DAL > Set Global Access.

Table 3-6 Entity Access Properties

Property Name Description
Create When selected, this object can be created by the User Application.
Edit When deselected, this object cannot be changed by the User Application

regardless of the underlying ACLs.

When selected, this object is editable, but the Identity Vault ACLs are used
to determine this.

View When selected, this object can be displayed by the User Application.

Remove When selected, this object can be deleted by the User Application.

Entity General Properties

Table 3-7 Entity General Properties

Property Name Description

Key The unique identifier for this entity. It defines the way the User Application
references this object. It is defined when the entity is created and cannot be
modified after the entity is created.

Display Label Defines how the object is shown in the user interface.

Class Name The eDirectory object class name.

LDAP Name The LDAP object class name.

Include in Search When selected, this entity is searchable in the User Application. Entities used in

queries by identity portlets (such as Entity Search List or Entity Org Chart) must
be selected (True).

Entity Auxiliary Properties
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Table 3-8 Entity Auxiliary Properties

Property Name Description

Auxiliary Classes A list of zero or more auxiliary classes for this entity. If you are adding
auxiliary classes, you are prompted to define:

+ The auxiliary class by selecting from the list of those available

* Whether it is searchable. Setting searchable to True applies a filter to
LDAP searches that involve directory abstraction layer relationships.
For example, if you added an aux class to the user entity and
specified that the aux class was searchable, the Org Chart (using the
manager-employee relationship) would display only the employees
that have the aux class.

* Whether to Add Always. When True (selected), the object class is
automatically added when the entity is modified in the User
Application. Maodification includes create or update operations. When
False, the object class is only added if an attribute associated with the
auxiliary class is modified.

Entity Search Properties

Table 3-9 Entity Search Properties

Property Name Description

Search Container The distinguished name of the LDAP node or container where
searching starts (the search root). For example:

ou=sample,o=ourOrg

You can browse the Identity Vault to select the container, or you
can use one of the predefined parameters described in “Using
Predefined Parameters” on page 71.

Search Scope Specifies where the search occurs in relation to the search root.
Values are:

<Default>: This search scope is the same as selecting Containers
and subcontainers.

Container: The search occurs in the search root DN and all
entries at the search root level.

Container and subcontainers: The search occurs in the search root
DN and all subcontainers. This is the same as selecting
<Default>.

Object: Limits the search to the object specified. This search is
used to verify the existence of the specified object.

Search Time Limit [ms] Specify a value in milliseconds or specify 0 for no time limit.

Max Search Entries Specify the maximum number of search result entries you want
returned for a search. Specify 0 if you want to use the runtime
setting. Recommendations: Set it between 100 and 200 for
greatest efficiency. Do not set it over 1000.
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Property Name

Description

Perform Automatic Query

When selected, performs an automatic query of the entity and
presents the results in a selectable list. Do not choose this option
if the data returned will be a large number because it forces the
user to scroll through a large result set.

When not selected, allows the user to specify the search criteria
for the entity query, then presents the results in a selectable list.

Entity Create Properties

Table 3-10 Entity Create Properties

Property Name

Definition

Create Container

Create Naming Attribute

LDAP attribute

Create Naming Label

The name of the container where a new entity of this type is created.

You can browse the Identity Vault to select the container, or you can use
one of the predefined parameters described in “Using Predefined
Parameters” on page 71.

If you do not specify this value, then the Create portlet prompts the user to
specify a container for the new object. The portlet uses the search root
specified in the entity definition as the base and allows the user to drill
down from there. If there is no search root specified in the entity definition
then it uses the root DN specified during the User Application installation.

The naming attribute of the entity. It is the relative distinguished name
(RDN). This value is only necessary for entities where the access
parameter Create is selected.

The LDAP attribute for the Create Naming Attribute.

Display label displayed in the User Application for the Create Naming
Attribute.

Entity Password Management Properties

Table 3-11 Entity Password Management Properties

Property Name

Definition

Password required when entity is created If the password attribute is required, set this value

to True (selected) to ensure that one is required by
the Create portlet. If a password is required, then
you cannot create this entity in a workflow.

Using Predefined Parameters

The directory abstraction layer editor allows you to use predefined parameters for certain values.
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Table 3-12 Predefined Parameters

Predefined Parameter Description

%driver-root%

%user-root%

%group-root%

Represents the Provisioning Driver DN. This value is specified during
the User Application configuration during installation or a later
configuration. It is stored in the User Application’s realm configuration.

Represents the User Container DN. This value is specified during the
User Application configuration during installation or a later
configuration. It is stored in the User Application’s realm configuration.

Represents the Group Container DN.This value is specified during the
User Application configuration during installation or a later
configuration. It is stored in the User Application’s realm configuration.

3.7.2 Attribute Properties

You can set the following kinds of properties on attributes:

+ “Attribute Access Properties” on page 72

+ “Attribute General Properties” on page 73

+ “Attribute Default Value Properties” on page 74

+ “Attribute Ul Control Properties” on page 74

+ “Attributes and DNLookup Properties” on page 77

Attribute Access Properties

NOTE: You can set attribute access for all of an entity’s attributes by selecting DAL > Set Attribute
Access, right-clicking an entity, and selecting Set Attribute Access.

Table 3-13 Attribute Access Properties

Name Description

Edit When selected, this attribute can be edited/modified by the User Application. Even if
it is selected (True), the attribute might still not be editable if the underlying Identity
Vault ACLs/effective rights prevent it.

Enable When deselected, this attribute cannot be used by the User Application. It is the

same as removing the entry from the file.
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Name Description

Hide Controls whether the Hide check box in the User Application is enabled or disabled.
The Hide check box allows users to control whether an attribute (such as a photo) is
displayed by the application.

When deselected, the Hide check box is disabled for this attribute, so the user
cannot choose to hide this attribute.

When selected, the Hide check box can be enabled in the User Application.
However, the following must also be true of the logged-in user.

+ He or she is either the owner of the attribute or a User Application
Administrator.

+ He or she has Trustee rights to update the srvprvHideAttributes attribute on the
Identity Vault.

If these requirements are not met, then the Hide check box is disabled in the
user interface even if this setting is selected (True).

TIP: When a user hides an attribute that contains an image, users who have viewed
the image might continue to see it until their browser cache is refreshed.

The Search and Hide properties are mutually exclusive. If Hide is selected (True),
Search cannot also be selected (True). If Search is selected (True), Hide cannot be
selected (True).

Multivalue Specifies whether this attribute can be multivalued, for example, a phone number.
When selected, the attribute can be multivalued.

Read When this option is selected, the User Application can query this attribute. For most
attributes this should be selected (True), but for some attributes, like password, it
should be deselected.

Require When this option is selected, the attribute must be supplied.

Search When this option is selected, the User Application can search on this attribute.
Attributes that are used in queries by identity portlets (such as Entity Search List or
Entity Org Chart) or request and approval forms must be selected.

TIP: If an attribute used in a search is also indexed in eDirectory, the search is faster.

The Search and Hide properties are mutually exclusive. If Hide is selected (True),
Search cannot also be selected (True). If Search is selected (True), Hide cannot be
selected (True).

View When this option is selected, the User Application can display this attribute. In most
cases this is selected, but for attributes like password, it should be deselected. If you
specify it in a request or approval form, view must be selected.

Attribute General Properties

Table 3-14 Attribute General Properties

Property Name Description

Key The unique identifier for the attribute.
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Property Name Description

Display Label The label that is displayed in the User Application.
Attribute Name The eDirectory name for this attribute.
LDAP Name The LDAP name for this attribute.

Attribute Default Value Properties

This value is used when an object is created via the Create identity portlet or through a workflow.
You can express the default value as a literal or an ECMAScript expression. You cannot use a
default value as part of a calculated attribute. If defined as an ECMAScript expression, it is resolved
at runtime. If you define both the literal and an expression, the expression takes precedence.

TIP: If you want the default value to be displayed by the Create portlet, you must define the access
property viewable as True (selected). If you want the user to be able to change the value, you must
set the editable property to True.

Attribute Ul Control Properties

Table 3-15 Attribute Ul Control Properties

Property Name Description

Data Type Choose a data type from the following list:

+ Binary

+ Boolean
* DN

* Integer

+ LocalizedString

NOTE: Selecting the LocalizedString Data Type causes the search to be
case-sensitive in the Ul.

+ String

¢ Time
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Property Name Description

Format Type Used by the User Application to format data. Format types include:

* None

¢ AOL IM

+ Emalil

+ Groupwise IM
+ Image

+ Phone Number
¢ Yahoo IM

* Image URL

¢ Date

+ DateTime

The Format Types are dependent on the data type. For example, a Time data
type can only be associated with Date and DateTime formats.
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Property Name Description

Control Type Types include:

DNLookup: Defines that this attribute contains a DN reference. Use when you
want to:

+ Populate a list with the results of a DN search among related entities.

+ Maintain referential integrity across DN referenced attributes during
updates and deletes.

+ Use the attribute in an object selector dialog box. Object selectors are used
by certain identity portlets, such as Detail, and are also available to the
form controls you can define for provisioning request and approval forms.

The User Application uses this information to generate special user interface
elements (such as an object selector), and to perform optimized searches based
on the DNLookup definition.

For more information on defining this property, see the “Attributes and
DNLookup Properties” on page 77. For more information on the object selector
dialog box for request and approval forms, see Section 5.6.2, “Working with
Object Selectors,” on page 168.

Global List: Display this attribute as a drop-down list whose contents are defined
in a file outside of this attribute definition. Click Go to list to access the Global
List editor for the selected list.

For more information, see Section 3.3, “Working with Lists,” on page 57.

Local List: Display this attribute as a drop-down list whose contents are defined
with this attribute. To define a local list:

1. With the attribute selected, set the control type to Local List.

 UI Control
Specify any Formatting or special controls used in displaving the attribute;

Daka Type: String -
Formak Type: | <None > b
Control Type: | Local List w

= Local List

+ ¢ & B
Yalues Labels
waluel labell ¥

2. Use the buttons to add or remove list items. Use the up-arrow and down-
arrow buttons to change the position of the item in the list.

In the Value column, type the value to write to the Identity Vault. It can
include letters, numbers, and the underscore (_) character.

3. Inthe Labels column, type the text you want displayed in the user
interface.

Range: Use the Range control type with Integer data types to restrict user input
to a sequential range of values. Define the range’s start and end values.
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Attributes and DNLookup Properties

When you define an attribute as a DNLookup control type, it means that:

+ This attribute can be used in an object selector dialog box that allows users to select from a list

of possible values when searching on this attribute.

+ When this attribute is created, populated, or deleted through the User Application, an attribute
on a related entity is updated appropriately depending on the user action (create, delete, update)
to maintain referential integrity.

+ “DNLookups for Object Selectors” on page 77
+ “DNLookups for Referential Integrity” on page 80

+ “DNLookup Property Reference” on page 80

DNLookups for Object Selectors

The DNLookup Display properties for a particular attribute define the contents of the object
selectors in the User Application. Object selectors are displayed by the Identity Self-Service portlets
and in workflow request and approval forms. They provide a convenient way for users for users to
search and select objects that represent DNs (such as users or groups). The object selector displays a
drop-down list of attributes; the user can select one of the attributes and then enter search criteria for
that attribute. In this example, the user searches for groups by group description.

Figure 3-2 Sample Object Selector

[ Object Lookup - Mozilla

Object Lookup

Description

Search object list: [example: a%, Lar®, 1D, *r]

782 _0

- search

The result of the user’s selection looks like this:
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Figure 3-3 Sample Object Selector Results

[ Object Lookup - Mozilla (=13

Object Lookup ? & _ 0O

Search object list: [example: a%, Lar™, 1D, 1)

Description » |H “‘% Search

Select an object from the list:

Description
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Information Technology

1-2of2

The DNLookup display properties control the contents of the object selector and the result set. The
object selector, shown above, displays this way because it was based on the group attribute of the
user entity. The group attribute is defined as a DNLookup control type as shown here:

Figure 3-4 Group DNLookup Definition

~ UI Control

Specify any Formatting ar special contrals used in displaying the attribute:

Data Type: |DN 4 |
Format Type: |<N0ne> v|
Contral Type: |DNLoolmp ~ |

* DNLookup Display
Select the Entity and Attributes ta display for the Lookup operation:

Loakup Entity: Group w |

Lookup Attributes

P | Description v | 4

|:| Perfarm Automatic Query

This definition also controls the way identity portlets provide a selection list of groups for a user. For
example, a user might choose to do a Directory Search to find a user in a group, but the group name
is unknown. The user would select User as the object to search for and select group as the search
criteria, as follows:
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Figure 3-5 Search Criteria

Search List &8 _0
Basic Search

Search far: | User VI

With this criteria:

CECH | [ae: S S = <

@ My Sawed Searches _@- Advanced Search

Because the members attribute is a DNLookup for the user entity, the Lookup icon displays. If the
user selects it, then a list of possible groups displays.

Figure 3-6 Object Lookup

2 Object Lookup - Microsoft Internet Explorer
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Object Lookup & _ 8
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When the user picks a group, then he or she can select a group from the list and all of the members
of that group are displayed.

NOTE: When the Perform Automatic Query property is not selected (False), the object selector is
not populated when first displayed to the user and the user must enter selection criteria. The example
above illustrates the object selector that displays when the Perform Automatic Query property is
selected (True).

DNLookups for Referential Integrity

DNLookups for updates and synchronization are important because LDAP allows group
relationships to map in both directions. For example, your data might be set up so that:

+ The User object contains a group attribute. The group attribute is multi-valued and lists all of
the groups to which a user belongs.

+ The Group object contains a user attribute. The user attribute is multi-valued and lists all of the
users that belong to the group.

This means that you can have an attribute on the user object that shows all the groups a user belongs
to, and on the Group object you have a DN attribute that includes all the members of that group.

When the user requests an update, the User Application must honor the relationships and ensure that
the target and source attributes are synchronized. In the DNLookup, you specify both attributes that
must be synchronized. You can use this technique to provide synchronization between any objects
that are related not just group structural objects. Create this kind of DNLookup control type by
specifying the advanced DNLookup properties described in the DNLookup Relational Integrity
properties reference.

DNLookup Property Reference

Table 3-16 DNLookup Display Properties

Property Name Description

Lookup Entity The name of the entity to search. For example, suppose that
the User entity contains an attribute for Manager. To populate
that field, you'd need to know which users are Managers.

Lookup Attributes Choose one or more attributes to display when a search is
performed.
Perform Automatic Query Defines how the Lookup Attributes are displayed.

¢ When this option is selected, the form or portlet
performs an automatic query of the entity and presents
the results in a selectable list. This option is not
recommended if a large amount of data can be returned
because it forces the user to scroll through a large result
set.

+ When this option is deselected, allows the user to
specify the search criteria for the entity query, then
presents the results in a selectable list.
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Table 3-17 DNLookup Detail Properties

Property Name Description

Detail entity The key of the entity whose details you want displayed if the
user requests more information by clicking a hypertext link in
the User Application. When you define a DNLookup, the
identity portlets are able to provide a hypertext link that allows
users to display the details of the linked object.

The DNLookup Relational Integrity properties are used for synchronizing data between two objects
such as groups and group members.

Table 3-18 DNLookup Relational Integrity Properties

Property Name Description

Source Attributes to Update Name of the attribute to update. The attribute must contain a DN
reference to the Target Attributes to Update. This is required to
synchronize attributes on two different objects.

Target Attributes to Update Name of the attribute that must be updated along with the Source
Attributes to Update. This is an LDAP attribute name. This is
required to synchronize attributes on two different objects. The
attribute must contain a DN reference.

Target Auxiliary Classes Needed, if Name of the auxiliary class that contains the Target Attributes to
any Update.

3.7.3 Queries Properties

You can set the following kinds of Queries properties:

+ “Queries General Properties” on page 81
+ “Query Parameters Properties” on page 82
+ “Query Search Properties” on page 82

Queries General Properties

Table 3-19 Queries General Properties

Property Name Description

Key A unique value for the query key. This value is used in the Expression Builder
to identify the query. The key is specified at the query creation time. It cannot
be modified after the query is created.

Query Entity Select an entity from the drop-down list box. The resulting LDAP search is on
this entity.
Display Label Type a string to display in the directory abstraction layer editor and

Provisioning view. This value is not visible in the Expression Builder.
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Query Parameters Properties

Table 3-20 Queries Parameters Properties

Property Name Description

Parameter Keys A unique identifier for the key. You pass this key when calling the
globalQuery() method on a form.

Parameter Display Labels A label to identify the key.

Query Search Properties

If left blank, the query search properties default to the search properties specified for the selected
entity. Specify the query search properties to further refine the search scope already defined for the
entity. You cannot specify predefined parameters (for example,%user-root%) in the query’s search
properties.

Table 3-21 Query Search Properties

Property Name Description

Search Root Specifies the location in the LDAP tree where the LDAP search defined by
the query begins.

Search Scope Specifies where the search occurs in relation to the search root. Values
are:

<Default>: This search scope is the same as selecting Containers and
subcontainers.

Container: The search occurs in the search root DN and all entries at the
search root level.

Container and subcontainers: The search occurs in the search root DN and
all subcontainers. This is the same as selecting <Default>.

Object: Limits the search to the object specified. This search is used to
verify the existence of the specified object.

Max Search Entries Specify the maximum number of search result entries you want returned for
a search. Specify 0 if you want to use the runtime setting.
Recommendations: Set it between 100 and 200 for greatest efficiency. Do
not set it over 1000

3.7.4 Relationship Properties

Relationship properties include:

+ “Relationship Access Properties” on page 83
+ “Relationship Properties” on page 83
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Relationship Access Properties

Table 3-22 Relationship Access Properties

Property Name

Description

Used by Organizational Chart

Used by Management

When selected, this relationship can be used by the Org Chart
portlet.

When selected, this relationship can be used to define the
provisioning members in iManager.

For example, if Used by Management is selected for the manager-
employee relationship, then the provisioning application administrator
can use this relationship to define the members as all users that
report to the manager.

If Enable Cascading Relationship is selected, then the can include
several levels within the organization. You define the number of
levels via Maximum Levels to Cascade.

Relationship Properties

Table 3-23 Relationship Properties

Property Name

Description

Key

Display Label

Source Entity

Source Attribute

The read-only unique identifier for the relationship.

TIP: You specify this value in the Org Chart Portlet preference sheet.

Specify a name to display when this relationship is displayed in the User
Application. For example, this value is displayed when users click
Choose Org Chart from the Detail portlet.

Click Localize to provide the translation for the display label text.
Choose an entity from the drop-down list.

The entity that you choose becomes the parent or source object in the
organization chart hierarchy. In a Manager-Employee relationship, the
Source Entity is User. For a Group-Member relationship, the source entity
is Group.

Directory abstraction layer requirements: The entities in this list are a
subset of the entities defined in the directory abstraction layer. Source
entities must have the view access property selected (True).

Choose an attribute from the drop-down list.

This attribute is used to find matching target entities. When the value of
this attribute matches a corresponding value on an attribute of the target
entity (see Target Attribute below), then a relationship can be established.

Directory abstraction layer requirements: This list of attributes is
populated using the selected Source Entity’s attributes. It includes any
attributes that are searchable and readable.
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Property Name Description

Target Entity Choose an entity for the child object in the hierarchy. In a Manager-
Employee relationship, it is user.

This entity must contain the attribute that is related to the Source
attribute.

Target Attribute Choose the attribute that matches the Source Attribute.

This is the target entity’s attribute used to find matching source entities.
When the value of this attribute matches a corresponding value on the
source entity (see Source Attribute above), then a relationship can be
established.

NOTE: The Org Chart portlet does not fully support dynamic groups; you cannot define a dynamic
group as the Source entity, but you can define a dynamic group as the target entity.
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Configuring Provisioning Request
Definitions

A provisioning request is a user or system action that initiates one or more provisioning workflows.
These workflows can be used to grant or revoke resources or roles, or perform attestation processes.
You use the provisioning request definition editor to create and deploy provisioning requests to the
User Application driver. This section includes information about the provisioning request definitions
shipped with the system and how to create new provisioning request definitions. It include the
following sections:

+ Section 4.1, “About Provisioning Request Definitions,” on page 85

+ Section 4.2, “Using the Provisioning Request Definition Editor,” on page 86
+ Section 4.3, “Provisioning and Workflow Example,” on page 103

4.1 About Provisioning Request Definitions

Provisioning request definitions are directory objects that encapsulate the business rules for granting
or revoking a corporate resource or role, and binding the corporate resource or role to a workflow.
Provisioning request definitions can also be used to launch attestation workflows. They are used in
the User Application to support:

+ Resource requests on the Requests & Approvals tab

Resource requests allow users to request access to resources such as accounts, applications,
servers, and so forth. Novell provides a read-only resource-oriented provisioning request
definition named Resource Approval.

For information about customizing the existing definition or writing your own resource based
provisioning request definitions, see Section 6.7, “Guidelines for Creating Resource Based
Workflows,” on page 207.

+ Role assignment requests on the Roles tab.

Role assignment requests allow users to request roles that grant them permissions to resources
and not to the resources themselves. Novell provides these two read-only role-oriented
provisioning request definitions:

+ Role Approval: Manages role requests.

+ SoD Conflict Approval: Manages role requests that result in Separation of Duties (SoD)
conflict overrides.

For information about customizing the existing definitions or writing your own roles based
provisioning request definitions, see Section 6.6, “Guidelines for Creating Roles Based
Workflows,” on page 197.

+ Attestation process requests on the Compliance tab.

Attestation process requests are used by Compliance Administrators and Attestation Officers to
submit requests for attestation workflows. These workflows allow users to verify their own
user profile information, to allow authorized users to verify the violations and exceptions to
SoD constraints, or to verify role and user assignments.
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Designer provides these two attestation type provisioning request definitions:

+ Attestation Report: Manages the attestation process that allows users to verify the
violations and exceptions for a set of SoD constraints.

+ Attestation User Profile: Manages the attestation process that allows users to confirm that
their user profiles contain accurate information.

Attestation type provisioning request definitions are not editable within Designer. You cannot
define or use custom provisioning request definitions for attestation, and they are not visible on
the Requests & Approval tab.

You use Designer to define the trustees for the attestation process requests, to deploy the
provisioning request definitions, and to localize the text users see during the approval process.
For information on localizing attestation provisioning request definition text, see Section 2.10,
“Localizing Provisioning Objects,” on page 37.

4.2 Using the Provisioning Request Definition
Editor

The provisioning request definition editor allows you to create provisioning request definitions that
bind corporate resources or roles to a workflow. The provisioning request definition editor includes
the following tools:

*

*

*

Overview tab: Used to define the basic characteristics of the provisioning request.

Workflow tab: Used to define the associated workflow by configuring activities and flow
paths.

Form tab: Used to define the request and approval forms that the user interacts with in the
Requests & Approvals tab.

Signature Declarations tab: Used to define the Digital Signature declarations.

For provisioning request definitions that are not based on roles, you can use a provisioning request
template to create your definitions. The templates model some common workflow design patterns.
However, if you want complete control over the behavior of your workflows, you can create your
own custom provisioning request definitions.

*

*

Section 4.2.1, “Creating a Provisioning Request Definition,” on page 86

Section 4.2.2, “Starting the Provisioning Request Definition Editor,” on page 87

Section 4.2.3, “Creating a Provisioning Request Definition By Using a Template,” on page 89
Section 4.2.4, “Creating a Custom Provisioning Request Definition,” on page 96

Section 4.2.5, “Creating a Roles Based Provisioning Request Definition,” on page 96

Section 4.2.6, “Modifying Settings of a Provisioning Request Definition,” on page 98

4.2.1 Creating a Provisioning Request Definition

This section describes how to create both provisioning requests that are based on roles and
provisioning requests that are not based on roles by using the following methods:

*

*

From a template (not supported for roles based provisioning request definitions).
From a copy of an existing provisioning request definition.

+ As a custom provisioning request definition.
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When possible, you should use a template or a copy of an existing definition because it saves you
time, and allows you to make targeted changes to an existing provisioning request definition.
However, if no existing provisioning request definition resembles new work that you want to do,
you can create a custom provisioning request.

The following table describes the steps for defining a provisioning request.

Table 4-1 Basic Steps for Defining a Provisioning Request

Task Action For More Information
1 Create a provisioning request definition. Depending on what you want to
create, see:

¢ Section 4.2.3, “Creating a
Provisioning Request Definition
By Using a Template,” on
page 89

+ Section 4.2.4, “Creating a
Custom Provisioning Request
Definition,” on page 96.

+ Section 4.2.5, “Creating a Roles
Based Provisioning Request
Definition,” on page 96

+ Section 4.2.6, “Modifying
Settings of a Provisioning
Request Definition,” on page 98

2 Create the request and approval forms. See Chapter 5, “Creating Forms for a
Provisioning Request Definition,” on

TIP: Creating the forms before the workflow simplifies Page 109

the process of mapping the form fields to the
application data.

3 Create the workflow diagram by adding activities to the See Chapter 6, “Creating the
workflow diagram and connecting them with flow Workflow for a Provisioning Request
paths. Definition,” on page 177

4 Configure the activities and flow paths by specifying See Chapter 7, “Workflow Activity
the properties, data item mappings, and e-mail Reference,” on page 219

notification settings for the actvities. Then define the
semantics for the flow paths.

4.2.2 Starting the Provisioning Request Definition Editor

1 Open the Provisioning view and double-click the Provisioning Request Definitions node.

Designer displays the provisioning request definitions tree containing nodes for the default
provisioning definition request definition categories of Accounts, Attestations, Entitlements,
Groups, Roles, and Uncategorized.
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= E) Provisioning Request Definitions
E,:. Accounts
E,:, Attestations
E,:. Entitlements
E,:, Sroups
+ E,:. Rales
E,:. Uncateqorized

+

&

These default categories are defined by the directory abstraction layer Provisioning Category
list. For information on managing categories, see Section 3.3, “Working with Lists,” on
page 57.

The installed templates are available in the Entitlements node, and the default role provisioning
request definitions are available in the Roles node.

2 Use the Provisioning view pane to navigate the provisioning request definition categories. The
right-click menu is available from the top-level node or when you select an existing
provisioning request definition. You cannot create a provisioning request definition by
selecting a category node.

3 Double-click a provisioning request definition to open it in the editor in the right pane.
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For details on using...

See

Overview tab

Workflow tab

Forms tab

Signature Declarations

Section 4.2.6, “Modifying Settings of a Provisioning Request
Definition,” on page 98.

Chapter 6, “Creating the Workflow for a Provisioning Request
Definition,” on page 177.

Chapter 5, “Creating Forms for a Provisioning Request Definition,”
on page 109.

Section 6.11, “Configuring Digital Signature Support,” on page 216.

Provisioning request definitions are stored locally in the Provisioning\AppConfig\
RequestDefs directory within your workspace.

4.2.3 Creating a Provisioning Request Definition By Using a

Template

1 Launch the Create A New PRD wizard in one of these ways:

+ From the Provisioning view, right-click the Provisioning Request Definitions node and

choose New.

+ From the Provisioning view, click a User Application or provisioning request container,

then select Insert > Provisioning Request Definition.

+ Select File > New > Provisioning > Provisioning Request Definition. Choose
Provisioning Request Definition, then click Next.

The first page of the Create a New PRD Wizard is displayed.

x

Specify the basic information of the Provisioning Request Definition.

Give the PRD a CM name, a display name, and a description,

Identifier (CN): |

Display Mame: |

Description: |

= Back [ext = | Eimish I Cancel

2 Fill in the fields as follows:
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Field Description

Identifier (CN) The CN (common name) identifier for the provisioning request
definition. The name cannot be longer than 64 characters.

Display Name The display name for the provisioning request definition. This is the
name that is displayed in the Provisioning view.

Description A description of the provisioning request definition.

3 Click Next. The next page of the wizard is displayed.

& Create a new PRD =

Choose the workflow template for this Provisioning Request Definition.

[™ Create a provisioning requesk definition using one of the kemplates

Available Templates: Description:

TemplatezParallelapproval _TA -
TemplatezParallelapproval _TD
TemplatezSerialapproval _TaA
Templatezserialapproval _TD
Template3Parallelapproval _TA
Template3Paralelapproval _TD
Template3Serialapproval _TaA
Template3Serialapproval _TD
Template4Parallelapproval _TA
Template4Parallelapproval _TD
TemplatedSerialapproval _Ta
Template4Serialapproval _TD
TemplateSParallelapproval _TA LI

(7) {2 Back |

Mext = | Einish I Cancel |

4 Select Create a provisioning request definition using one of the templates, then select the

desired template (for example, TemplateSingleApproval_TA) from the Available Templates
list, then click Next.

You use the next panel of the wizard to specify the provisioning request definition’s category
and trustees (the users, groups, or containers) who can access the provisioning request
definition after it is deployed.
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@ Create a new PRD

Specify the details of the Provisioning Request Definition.

Categaory:
Motify participants by E-Mail
+ #&

Trustee DM
admin, novell

Trustee rights:

Finish

] [ Cancel

5 Select a category from the list.

6 Select Notify participants by e-mail if you want approvers to be notified by e-mail about
pending approval tasks, and also want initiators to be notified by e-mail of workflow
completion. If Notify participants by e-mail is not selected, users must look at the Requests and
Approvals tab in the User Application for notifications about tasks.

10

Click the plus (+) icon to add a trustee.

Designer displays a panel that allows you to browse the Identity Vault to select a trustee. You
can select a user, group, or container. If you cannot connect to the Identity Vault, you can type

trustee DNs directly in the Trustee DN field.
Select the trustee, then click OK.

Designer returns you to the previous panel. If desired, add additional trustees by repeating the

previous step.
When you have finished adding trustees, click Finish.

Designer displays the Provisioning Request Definition Details panel on the Overview tab (see
Section 4.2.6, “Modifying Settings of a Provisioning Request Definition,” on page 98).

Click the Workflow tab. The Workflow view is displayed.
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The provisioning request definition template includes some default values that you must
customize for your environment. For example, the Entitlement Provisioning Activity contains
placeholder values for several data item mapping properties. You need to replace the
placeholder values with the actual values for your provisioning request.

11 Click the Entitlement Provisioning activity, then click the Data Item Mapping tab.

| T
¥4 Finish

Overview |workflow Forms|

Email Matification | Palicy Set | Data Flow W\Pmperties | =0
Source Expression | Targek | [Drat:
recipient dn skrir
'cn=IDYAULT, cn=VYalueAdder, cn=spitset, o=acme' DirsML-Entitlement-Dr skrir
' Dir#ML-Entitlemnent-Action skrir
“fenter Entitlernent param here}' Dir#ML-Entitlement-Parameter skrir
‘brue’ Dir#ML-Entitlement-Multidaluesliowed | bool

12 Double-click in the Source Expression field to display the DirXML-Entitlement-DN target field,
then click the button that appears in the field to display the ECMA Expression Builder.

See Chapter 9, “Working with ECMA Expressions,” on page 317 for information about the
ECMA Expression Builder.
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13 Use the ECMA Expression Builder to replace the placeholder expression with an expression
that specifies the entitlement that you want to provision with this provisioning request.

14 Replace the placeholder expression in the Source Expression field for the DirXML-Entitlement-
Parameter.

15 Click the Forms tab and customize the forms for the provisioning request to meet your needs.

See Chapter 5, “Creating Forms for a Provisioning Request Definition,” on page 109.The
template includes predefined request and approval forms. You might want to add additional
forms, or add or remove form controls.

16 Click the Workflow tab and customize the properties of the workflow to your needs.

See Chapter 6, “Creating the Workflow for a Provisioning Request Definition,” on page 177
and Chapter 7, “Workflow Activity Reference,” on page 219.

For more information about the preconfigured templates, see the following:

+ “About the Installed Templates” on page 93
+ “About the Installed Templates and Flow Strategy” on page 95

About the Installed Templates

Identity Manager ships with a set of preconfigured provisioning request definitions and workflows.
You can use these as templates for building your own provisioning system. To set up your system,
you define new objects based on the installed templates and customize these objects to suit the needs
of your organization.

The installed templates let you determine the number of approval steps required for the request to be
fulfilled. You can configure a provisioning request to require from zero to five approval steps.

You can also specify whether you want to support sequential or parallel processing, and whether you
want to approve or deny the request if the workflow times out during the course of processing.

The following table lists the templates included with Identity Manager.

Table 4-2 Preconfigured Provisioning Request Definitions and Workflows

Template Description

Self Provision Approval Allows a provisioning request to be fulfilled without any
approvals.

One Step Approval (Timeout Approves) Requires a single approval for the provisioning request

to be fulfilled. If an activity times out, the activity
approves the request and the work item is forwarded
to the next activity.

Two Step Sequential Approval (Timeout Requires two approvals for the provisioning request to

Approves) be fulfilled. If an activity times out, the activity
approves the request and the work item is forwarded
to the next activity.

This template supports sequential processing.
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Template

Description

Three Step Sequential Approval (Timeout
Approves)

Four Step Sequential Approval (Timeout
Approves)

Five Step Sequential Approval (Timeout
Approves)

One Step Approval (Timeout Denies)

Two Step Sequential Approval (Timeout Denies)

Three Step Sequential Approval (Timeout

Denies)

Four Step Sequential Approval (Timeout Denies)

Five Step Sequential Approval (Timeout Denies)

Two Step Parallel Approval (Timeout Approves)

Requires three approvals for the provisioning request
to be fulfilled. If an activity times out, the activity
approves the request and the work item is forwarded
to the next activity.

This template supports sequential processing.

Requires four approvals for the provisioning request to
be fulfilled. If an activity times out, the activity
approves the request and the work item is forwarded
to the next activity.

This template supports sequential processing.

Requires five approvals for the provisioning request to
be fulfilled. If an activity times out, the activity
approves the request and the work item is forwarded
to the next activity.

This template supports sequential processing.

Requires a single approval for the provisioning request
to be fulfilled. If an activity times out, the workflow
denies the request.

Requires two approvals for the provisioning request to
be fulfilled. If an activity times out, the workflow denies
the request.

This template supports sequential processing.

Requires three approvals for the provisioning request
to be fulfilled. If an activity times out, the workflow
denies the request.

This template supports sequential processing.

Requires four approvals for the provisioning request to
be fulfilled. If an activity times out, the workflow denies
the request.

This template supports sequential processing.

Requires five approvals for the provisioning request to
be fulfilled. If an activity times out, the workflow denies
the request.

This template supports sequential processing.

Requires two approvals for the provisioning request to
be fulfilled. If an activity times out, the activity
approves the request and the work item is forwarded
to the next activity.

This template supports parallel processing.
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Template

Description

Three Step Parallel Approval (Timeout
Approves)

Four Step Parallel Approval (Timeout Approves)

Five Step Parallel Approval (Timeout Approves)

Two Step Parallel Approval (Timeout Denies)

Three Step Parallel Approval (Timeout Denies)

Four Step Parallel Approval (Timeout Denies)

Five Step Parallel Approval (Timeout Denies)

Requires three approvals for the provisioning request
to be fulfilled. If an activity times out, the activity
approves the request and the work item is forwarded
to the next activity.

This template supports parallel processing.

Requires four approvals for the provisioning request to
be fulfilled. If an activity times out, the activity
approves the request and the work item is forwarded
to the next activity.

This template supports parallel processing.

Requires five approvals for the provisioning request to
be fulfilled. If an activity times out, the activity
approves the request and the work item is forwarded
to the next activity.

This template supports parallel processing.

Requires two approvals for the provisioning request to
be fulfilled. If an activity times out, the workflow denies
the request.

This template supports parallel processing.

Requires three approvals for the provisioning request
to be fulfilled. If an activity times out, the workflow
denies the request.

This template supports parallel processing.

Requires four approvals for the provisioning request to
be fulfilled. If an activity times out, the workflow denies
the request.

This template supports parallel processing.

Requires five approvals for the provisioning request to
be fulfilled. If an activity times out, the workflow denies
the request.

This template supports parallel processing.

About the Installed Templates and Flow Strategy

By default, provisioning request definition templates use the Single Flow flow strategy. The
templates assume that the recipient is a user DN. If you change the flow strategy, you must modify
the template. If you change the flow strategy to:

+ Flow per member: Remove the recipient reference from the request form.

+ Single flow provision members: Remove the recipient from the request form and add logic to
determine the addressee for the approval activity. The templates assume the recipient is a user
DN, so you must determine if the recipient is a user or group DN. You can use the IDVault
isGroup(String dn) method to determine if the DN is a group. If the recipient is a group DN,
you must provide logic for assigning the approval activity addressee.
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4.2.4 Creating a Custom Provisioning Request Definition

If no existing provisioning request definition resembles the new work that you want to do, then you
need to build a custom provisioning request definition.You can still save time and effort by re-using
forms from other workflows.

NOTE: The procedure in this section does not use roles. To create a custom roles based
provisioning request definition, see Section 4.2.5, “Creating a Roles Based Provisioning Request
Definition,” on page 96

1 Create the basic information for a new provisioning request definition (see Section 4.2.3,
“Creating a Provisioning Request Definition By Using a Template,” on page 89). In step Step 4
on page 90, do not select Create a provisioning request definition using one of the templates,
and do not select a template. When you are finished, the Overview tab for the new provisioning
request is displayed.

2 Create the forms for the provisioning request definition. Defining forms before you create the
workflow topology ensures that data bindings can be set up automatically for each activity
when you create activities.

To create the forms, see Section 5.3, “Creating Forms,” on page 116.
3 Click the Workflow tab and create the workflow topology.

You create the topology of a workflow by creating and linking activities into the desired
workflow pattern, and by assigning rules to the flowpaths between activities. For information
about creating a workflow topology, see Chapter 6, “Creating the Workflow for a Provisioning
Request Definition,” on page 177.

4 Specify the details (properties, data item mappings, e-mail notification) for each workflow
activity.

To specify workflow activity details, see Chapter 7, “Workflow Activity Reference,” on
page 219.

5 Configure the flowpaths between workflow activities.
To configure flowpaths, see Section 6.4, “Configuring Flow Paths,” on page 187.

4.2.5 Creating a Roles Based Provisioning Request Definition

Designer supplies two Roles Based provisioning request definitions that you should use as a basis
for your custom roles based provisioning request definitions. They are:

+ Role Approval

+ SoD Conflict Approval

To create a copy and customize its contents:

1 From the Provisioning view, open Roles in the Provisioning Request Definitions node.

2 Select one of the roles-based provisioning request definition (depending on which type of
approval you want to create), right-click, then select Create From.

+ Role Approval: Choose this for role requests.
+ SoD Conflict Approval: Choose this for SoD conflict approval requests.
Designer displays the Create a New PRD Wizard.
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l;_'};;,l:real:e anew PRD

Specify the basic information of the Provisioning Request Definition.

Give the PRD a CM name, a display name, and a description,

Identifier (CN): |

Display Mame: |

Description: |

= Back [ext = | Eimish I Cancel

3 Fill in the fields as follows:

Field

Description

Identifier (CN)

Display Name

Description

The CN (common name) identifier for the provisioning request
definition. The name cannot be longer than 64 characters.

The display name for the provisioning request definition. This is the
name that is displayed in the Provisioning view.

A description of the provisioning request definition.

4 Click Next. Designer displays the following dialog box.

@ Create a new PRD

Categaory:

Specify the details of the Provisioning Request Definition.

[ motify participants by E-Mail

Trustee rights: R

Trustee DM

Finish ] [ Cancel

5 Specify Roles for the category.
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6 Select Notify participants by e-mail if you want approvers to be notified by e-mail about
pending approval tasks, and also want initiators to be notified by e-mail of workflow
completion. If Notify participants by e-mail is not selected, users must look at the Roles tab in
the User Application for notifications about tasks.

7 (Optional) Click the plus (+) icon to add a trustee.

Designer displays a panel that allows you to browse the Identity Vault to select a trustee. You
can select an individual trustee or a group.If you cannot connect to the Identity Vault, you can
type trustee DNs directly in the Trustee DN field.

8 (Optional) Select the trustee, then click OK.
Designer returns you to the previous panel. Add additional trustees by repeating the previous
step.

9 Click Finish.

Designer displays the Provisioning Request Definition Details panel on the Overview tab (see
Section 4.2.6, “Modifying Settings of a Provisioning Request Definition,” on page 98).

For more details on defining the associated workflow, see Section 6.6, “Guidelines for Creating
Roles Based Workflows,” on page 197.

4.2.6 Modifying Settings of a Provisioning Request Definition

You use the Overview tab to define the basic information about the provisioning request definition
(for example, the name of the provisioning request definition, the category to which it belongs, and
who can access it).

+ “Modifying Basic Settings” on page 98

+ “Modifying Properties of Attestation or Roles Based Provisioning Request Definitions” on
page 102

Modifying Basic Settings
Figure 4-1 Overview Tab

3] testResource - Developer [ ] *TemplatezParalelApprowal_TD 53
Display Mame: TemplatezParallelapproval _TD

Description: Two Step Parallel Approwal (Timeout Denies)

Cakegary: Entitlements
Status: Template
Flow Strategy: | Single Flow
Process Type: | Rarmal

Motify participants by E-Mail

[[]5et Default Completion Status to Approved

Trusteerights: g ge

Trustee DN

Global scripts:

bivity [

B

Tvoe [ [ workflows [ Star
external LIBLDAP-15

117500 At generstes functior (1527 I N R R R
>

Cverview  WorkFlow | Forms | Signature Declarations

ala
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The following table describes each property that you can configure on the Overview tab.

Table 4-3 Overview Properties

Field

Description

Identifier (CN)

Display Name

Description

Category

Status

Flow Strategy

Displays the CN (common name) of the provisioning request definition. The CN
cannot be changed.

Specifies the display name of the provisioning request definition. This is the name
that is displayed to the user in Designer and Identity Manager.

Specifies the description of the provisioning request definition.

Specifies the category to which the provisioning request definition belongs from
the list of Provisioning Categories defined in the directory abstraction layer. The
Provisioning view displays the provisioning request definitions by categories.

Specifies the status of the provisioning request definition:

Active: Select this option to make the provisioning request definition available for
use in the User Application.

Inactive: Select this option to make the provisioning request definition
temporarily unavailable for use in the User Application. You can use this option
when you want keep the roles of the person who develops the provisioning
request definition separate from the person who activates the provisioning
request definition. For example, a developer could be responsible for marking the
provisioning request definition as Inactive, and an administrator could be
responsible for changing the status to Active.

Template: Select this option if you want to use this provisioning request definition
as the basis for other provisioning request definitions. Templates are not available
for use in the User Application.

Retired: Select this option to mark the provisioning request definition as
permanently unavailable for use in the User Application (you can still change the
status of the provisioning request definition at any time). This status provides a
way of keeping a historical record of a provisioning request definition that is no
longer in use.

Specifies the flow strategy for the provisioning request definition:
Single Flow: This strategy allows one workflow with one recipient.

Flow per member: This strategy allows the recipient to be a group DN. If you
select this strategy, the User Application starts a workflow instance for each
member of the group, and each workflow can be approved or denied separately.
For example, assume there is a provisioning request definition for the recipient
Human Resources. The Human Resource group has the members ablake and
kchester. The User Application passes the Human Resources DN to the
provisioning start. The provisioning interface starts two workflow instances, one
for ablake and one for kchester.

Single Flow Provision Members: This strategy allows the recipient to be a
group DN. If you select this strategy, the User Application starts a single workflow
for the group. The workflow spawns multiple provisioning steps (one for each
member) within the single workflow. The workflow is approved or denied to the
group as a whole, not for each individual member.
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Field Description

Process Type Specifies the type of provisioning request definition. Values are:
Normal: Used for typical workflow definitions that are not related to roles.

Role Approval: Specify this type if the workflow is used for roles approvals.
When this is set, the workflow is available to the Roles Configuration editor and
the SoD Editor. It ensures that the NrfRequest object data item is available in the
data item mapping.

Resource Approval: Specify this type if the workflow is used for resource
approvals. When this is set, the workflow is available to the Resource Editor. It
ensures that the NrfResourceRequest object data item is available in the data
item mapping.

Attestation: Used by Compliance Administrators and Attestation Officers to
submit requests for attestation workflows.

WARNING: ¢ If you change the process type from Role Approval or Resource
Approval to Normal, you must also remove any ECMA expressions related
to the NrfRequest object. ECMA expressions related to the NrfRequest
object are only valid in role based workflows and resource based workflows.
Including these expressions in non-roles-related workflows or non-resource-
related workflows cause runtime errors in the User Application.

* The driver must be Roles Based Provisioning 3.7 or higher.

Notify participants by Specifies whether approvers are notified by e-mail about pending approval tasks,

E-Mail and whether initiators are notified by e-mail of workflow completion. If Notify
participants by email is not selected, then users must look at the Requests and
Approvals tab in the User Application for natifications about tasks.

For information about selecting an e-mail template and customizing e-mail
template parameters, see Section 7.15, “Finish Activity,” on page 257.

Restrict View Specifies that the list of tasks that can be viewed by the user in My Requests in
the User Application is restricted to tasks initiated by the user. The default
behavior (that is, Restrict View is not selected) is that the user can see any
requests that the user initiated or for which the user is the recipient.

Generate Comments Specifies that the workflow engine should generate comments as the workflow
progresses. These comments can be displayed by clicking the following:

+ View Comment and Flow History in a Request Detail form in the User
Application

+ View Comment History in a Task Detail form in the User Application

Set Default Specifies that the default completion status of the provisioning request is
Completion Status to approved if selected, or denied if not selected. This feature can be useful for
Approved provisioning requests that do not contain a provisioning activity (an Entitlement or

Entity). The value of this parameter can be overridden by explicitly setting the
completion status by using a Provisioning activity or Workflow Status activity.

Trustee Rights Specifies the users and groups that can use the provisioning request definition.
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Field Description

Global Scripts Specifies the global ECMA scripts that provisioning request definition imports
while working with workflows and forms. Inline or extenal scripts can be added by
specifying the type of the script. You can also specify when these scripts should
be available to you. These scripts can be availble on workflows, start activity, or
forms.

Designer allows you to modify the properties of more than one provisioning request definition at a
time. The provisioning request definitions must be of the same category. You will see a different set
of properties for provisioning request definitions whose categories are Attestations or Roles. See
“Modifying Properties of Attestation or Roles Based Provisioning Request Definitions” on

page 102.

1 With the Provisioning view open, select one or more provisioning request definitions, right-
click, then select Properties. A dialog box like the following displays (the properties you can
modify depend on the type of provisioning request definitions you have selected):

B Provisioning Request Definition Property Modification

Blank properties have different values for the selected Definitions, Leaving a property blank kesps the original values in each Definition.
Provisioning Request Definition Details
Zategory:
Status: Template
Process Type: Morrnal
Mokify by E-Mail: true
Restrict Yiew: False
@enerate Comments: |true
Default Status: denied
Trustee rights:
9 + % B
Trustee DN
Glabal Scripts:
4
Tvoe | Scripk ‘ ‘wiorkFlows ‘ Stark Ackivity
external LIBLDAP-15
inline {/ TODO Auta g.. .entation. OOFO 0

2 Modify the selected provisioning request definitions as desired by changing the value for that
property.

If you have selected multiple provisioning request definitions and one of the properties does
not contain a value, the corresponding field is blank. If you modify that field, then the value
you specify is applied to all of the selected provisioning request definitions.

3 For Trustees, delete, add, or merge the values for the selected provisioning request definitions.

A merge adds all of the trustees in the selected provisioning request definitions to all of the
selected provisioning request definitions.

Configuring Provisioning Request Definitions 101



4 For Global Scripts, delete, add, or modify the values for the selected provisioning request
definitions.

+ External: The script is incorporated into the provisioning request definition by reference
using the supplied ECMA Script DN.

+ Inline: The script is inserted directly into the provisioning request definition in a
<script> block. You add your JavaScript using this ECMAScript Editor. To learn more
about using the editor, click the editor’s help button. For inline scripts, the following is
inserted in the page:
<script>whatever you type</script>

5 Click OK to save your changes.

Modifying Properties of Attestation or Roles Based Provisioning Request Definitions

The provisioning request definitions that support Attestations and Roles cannot be opened in the
Provisioning Request Definition editor so you cannot set their properties by using the Overview tab.
You can set several important properties, such as Trustee Rights, before deploying them.

1 With the Provisioning view open, select one (or more) of the Roles or Attestation provisioning
request definitions, right-click, then select Properties.

@ Provisioning Request Definition Property Modification

Syskem Role property modifications are limited to the setting of trustees only,

Provisioning Request Definition Details

Notify by Email v
Restrict: View: false v

Trustee rights: R {ED‘

Trustee DN

[:‘:7:] OF ] [ Cancel

2 Fill in the fields as follows:

Field Name Description

Notify by E-Mail ~ Specifies whether approvers are notified by e-mail about pending approval
tasks, and whether initiators are notified by e-mail of workflow completion. If
Notify participants by email is not selected, then users must look at the
Requests and Approvals tab in the User Application for notifications about tasks.

For information about selecting an e-mail template and customizing e-mail
template parameters, see Section 7.15, “Finish Activity,” on page 257.
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Field Name Description

Restrict View Specifies that the list of tasks that can be viewed by the user in My Requests in
the User Application is restricted to tasks initiated by the user. The default
behavior (that is, Restrict View is not selected) is that the user can see any
requests that the user initiated or for which the user is the recipient.

Trustee Rights Specifies the users and groups that can use the provisioning request definition.

3 For Trustees, delete, add, or merge the values for the selected provisioning request definitions.

A merge adds all of the trustees in the selected provisioning request definitions to all of the
selected provisioning request definitions.

4 For Global Scripts, delete, add, or modify the values for the selected provisioning request
definitions.

5 Click OK to save your changes.

4.3 Provisioning and Workflow Example

This section describes a common provisioning and workflow scenario. It is designed to help you
understand how the different objects that you create with the provisioning request editor are used by
the User Application.

Suppose a user needs an account on an IT system. To set up the account, the user initiates a request
through the Identity Manager User Application. This request starts a workflow, which coordinates

an approval process. When the necessary approvals have been granted, the request is fulfilled. The
process includes four basic steps:

*

Section 4.3.1, “Step 1: Initiating the Request,” on page 103

*

Section 4.3.2, “Step 2: Approving the Request,” on page 104

*

Section 4.3.3, “Step 3: Fulfilling the Request,” on page 107

*

Section 4.3.4, “Step 4: Completing the Workflow,” on page 107

4.3.1 Step 1: Initiating the Request

In the Identity Manager User Application, the user browses a list of resources by category and
selects one to provision. In the Identity Vault, the selected provisioned resource is associated with a
provisioning request definition. The provisioning request definition is the most prominent object in a
provisioning system. It binds a provisioned resource to a workflow and acts as the means by which
the workflow process is exposed to the end user. The provisioning request definition provides all the
information required to display the initial request form to the user and to start the flow that follows
the initial request.

In this example, the user selects the New Account resource. When the user initiates the request, the
Web application retrieves the initial request form and the description of the associated initial request
data from the Provisioning System, which gets these objects from the provisioning request
definition.

When a provisioning request is initiated, the Provisioning System tracks the initiator and the
recipient. The initiator is the person who made the request. The recipient is the person for whom the
request was made. In some situations, the initiator and the recipient can be the same individual.
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Each provisioning request has an operation associated with it. The operation specifies whether the
user wants to grant or revoke the resource.

4.3.2 Step 2: Approving the Request

After the user has initiated the request, the Provisioning System starts the workflow process, which
coordinates the approvals. In this example, two levels of approvals are required, one from the user’s
manager and a second from the manager’s supervisor. If approval is denied by any user in a
workflow, the flow terminates and the request is denied.

Workflows can process approvals sequentially or in parallel. In a sequential workflow, as shown in
the following figure, each approval task must be processed before the next approval task begins.

Figure 4-2 Sequential Workflow with Two Approvals

o start

forward

:3 First approwal

]

approved denied
«-ﬂ Log For approval_1 activity

fonmard

G Second approval

afproved denied
4
5| Log For approval_2 activity 75| Lo For all denied activities
| %
farward farward

:] Entitlement Provisioning sckivity
forward

¥ Finish

In a parallel workflow, as shown in the following figure, users can work on the approval tasks
simultaneously.
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Figure 4-3 Parallel Workflow with Two Approvals
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NOTE: The display labels (First approval, Second approval, and so on) can easily be changed to
suit your application requirements. For parallel flows, you might want to specify labels that do not
imply sequential processing. For example, you might want to assign labels such as One of Three
Parallel Approvals, Two of Three Parallel Approvals, and so on.

The workflow definition is made up of the components shown in the following table:

Table 4-4 Workflow Definition Components

Process Component Description

Activities An activity is an object that represents a task. An activity can present
information to the user and respond to user interactions. It can also perform
background functions that are not visible to the user.

In a workflow diagram, the activities are represented by boxes.

In the Identity Manager User Application, the activities that handle the
approval process are referred to as tasks. An end user can see the list of
tasks in his or her queue by clicking My Tasks in the My Work group of
actions. To see which workflow activities have been processed for a
particular task, the user can select the task and click the View Comment
History button on the Task Detail form.

To see which workflow activities have been processed for a particular
provisioning request, the user can click My Requests, select the request,
and click the View Comment and Flow History button on the Request Detail
form.

For more information on the My Tasks and My Requests actions, see the
Identity Manager 3.6.1 User Application: User Guide.
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Process Component Description

Flow paths Flow paths tie the activities in a workflow together. A flow path represents a
path to be followed between two activities.

An activity can have multiple incoming flow paths and multiple outgoing
flow paths. When an activity has more than one outgoing flow path, the flow
path selected often depends on the outcome of the activity. The outcome is
the end result of processing performed by the activity. For example, an
approval activity can have an outcome of approved or denied, depending
on the action taken by the user.

In a workflow diagram, the flow paths are represented by arrows.

Start activity: The workflow process begins with the execution of the Start activity. This activity
displays the initial request form to the user. After the user has provided the initial request data, it
initializes a work document using this data. The Start activity also binds several system values, such
as the initiator and recipient, so that these can be used in script expressions.

Approval activities: After the Start activity finishes, the Workflow System forwards processing to
the first Approval activity in the flow. The Approval activity sends an e-mail to the approver,
notifying this user that his or her attention is needed. When the user claims the task, the Approval
activity displays an approval form, which gives the user the ability to act on the request. In the
workflow examples shown in Section 4.3.2, “Step 2: Approving the Request,” on page 104, “First
approval” and “Second approval” are examples of Approval activities. The display labels for
Approval activities can be localized to satisfy international requirements.

An Approval activity has five possible outcomes, each represented by a different flow path exiting
the activity:

+ Approved

+ Denied

+ Refused

+ Error

+ Timeout

NOTE: The Error and Timeout outcomes can occur without any action being taken by the user.

If the user approves the request, the workflow follows the approved flow path to the next activity in
the flow. If no further approvals are needed, the resource can be provisioned. If the user denies the
request, the workflow follows the denied flow path to the next activity in the flow. Alternatively, the
user can reassign the task (if he or she is an Organizational Manager or User Application
Administrator), which puts the task in another user’s queue.

The user to whom an Approval activity has been assigned is referred to as the addressee. The
addressee for an activity can be notified of the assigned task via e-mail. To perform the work
associated with the activity, the addressee can click the URL in the e-mail, find the task in the work
list (queue), and claim the task.

The addressee must respond to an Approval activity within a specified amount of time; otherwise,
the activity times out. Typically the timeout interval is expressed in hours or days to allow the user
sufficient time to respond.
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When an activity times out, the workflow process might try to complete the activity again,
depending on the escalation count specified for the activity. In some situations, the workflow
process might be configured to escalate an activity that has timed out. In this case, the activity is
reassigned to a new addressee (the user’s manager, for example) to give this user an opportunity to
finish the work of the activity. If the last retry times out, the activity might be marked as approved or
denied, depending on how the workflow was configured.

Log activity: The Log activity is a system activity that writes messages to a log. To log information
about the state of a workflow process, the Workflow System interacts with Novell Audit. During the
course of its processing, a workflow might log information about various events that have occurred.
Users can use the Novell Audit reporting tools to look at logging data.

Branch and Merge activities: In a workflow that supports parallel processing, the Branch activity
allows two users to act on different areas of the work item in parallel. After the users have completed
their work, the Merge activity synchronizes the incoming branches in the flow.

Condition activity: During the course of execution, a workflow process might perform a test and
check the outcome to see what to do next. The Condition activity provides this capability. Condition
activities use a scripting expression to define the condition to evaluate. In the workflow examples
shown in Section 4.3.2, “Step 2: Approving the Request,” on page 104, “Approval Condition” is an
example of a Condition activity.

The Condition activity supports three possible outcomes or exit paths:

+ True
+ False
+ Error

4.3.3 Step 3: Fulfilling the Request

When a provisioning request has been approved, the Workflow System can begin the provisioning
step. At this point, control passes back to the Provisioning System.

To fulfill the provisioning request, the Provisioning System can execute an Identity Manager
entitlement or directly manipulate an Identity Vault object and its attributes. These actions are
performed by either the Entitlement activity or the Entity activity:

+ Entitlement activity: Fulfills the provisioning request by granting or revoking an entitlement.
This activity is not usually executed unless all of the necessary approvals are given.

+ Entity activity: Fulfills the provisioning request by directly manipulating an eDirectory object
and its attributes. This activity is not normally executed unless all of the necessary approvals
are given.

4.3.4 Step 4. Completing the Workflow

When all other activities have terminated, the workflow executes the Finish activity, which is the
final activity in a workflow. When all the activities in a flow have been completed and the final
result of the flow is available, the Finish activity executes. The Finish activity sends a final e-mail
notification to inform participants of the completion of the workflow.
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Creating Forms for a Provisioning
Request Definition

This section provides details on creating and customizing the User Application’s request and
approval forms. Topics include:

+ Section 5.1, “About Forms,” on page 109

+ Section 5.2, “About the Forms Tab,” on page 112

+ Section 5.3, “Creating Forms,” on page 116

+ Section 5.4, “Action Reference,” on page 125

¢ Section 5.5, “Form Control Reference,” on page 128

+ Section 5.6, “Working with Distinguished Names,” on page 168

+ Section 5.7, “Using DAL Queries in Forms,” on page 170

+ Section 5.8, “Printing Forms,” on page 175

+ Section 5.9, “Providing Direct Access to a Form,” on page 175

5.1 About Forms

Forms allow the user to request a resource, approve a resource request, and work on a task. They are
available when the user chooses any of the actions in the My Work category of the User
Application’s Requests and Approvals tab. Forms are also available directly from a URL. For details
on this technique, see Section 5.9, “Providing Direct Access to a Form,” on page 175.

Figure 5-1 is an example of a resource request form. At the top of the form is a read-only area that
displays the details of the request (or approval for approval forms). In the Form Detail section at the
bottom, the user provides input to the resource request (or approval) and takes some action on it.
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Figure 5-1 Sample Form

Novelle Identity Manager fay, | N
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My Settings - Resource: Title Change Request
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Nt Availability Resource Category:  Accounts

Ay Proxy Assignments
Description: Allow a user to reguest a title change, Requires manager approval,

Moy Delegate Assignments
Farm Detail

One Step Approval (Timeout Approves)
Press 'Submit' to request the entitlement.

Recipient: Allison Blake

Current Title: il
Requested Mew Title: ‘ |

Reason for request: *‘ |

You use the Forms tab of the provisioning request definition editor to define the appearance and
behavior of the Form Detail section of the User Application’s requests and approvals forms.
About Request Forms

You can create one request form for a provisioning request definition. The request form is associated
with the workflow’s Start Activity.

Figure 5-2 Sample Resource Request Form

Novelle Identity Manager day, June 30, 2006 N
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Reason for request: *‘ |
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About Approval Forms

You can define multiple approval forms for a provisioning request definition, but only one form per
Approval Activity. You can specify the approval form to associate with an approval activity in the
properties for the activity. You can create an approval form via the Forms tab or from the approval
activities property sheet.

Figure 5-3 Sample Resource Approval Form

Ay Requests *-indicates required.

Moy Settings F

Etrar By el Resource: Title Change Request  Recipient:  Allison Blake

Edit fvailability Requested By:  Allison Blake Task: Single Approval

Ay Prosey hssignments InQueue since:  06/30/2006 12:32:18 PAL Timeout on:  03/17/2026 12:32:18 P

My Delegate Assignments . .
hssigned To: ﬁ Marzo Macksnde Claimed By:

Ay Team's Work

»

Team Tasks

Form Detail
Request Team Resources
Team Requests Single Approval

Please select the appropriate button to approve or reject the request.
Ay Team's Settings 3 tllison
N oy — Requested by Allizon Blake Recipient: Blake
Team Delegate Assignments Request Date: O& /3072006

Team Availability Reason:

Current Employee Title:
Requested Title Change:

Comment:

Wigw Comment History

5.1.1 About Form Control Data Binding

All of the fields you define for a form are automatically available for data binding in the Data Item
Mapping property sheet. Two bindings, or mappings, are possible for each form field: a pre-activity
mapping to initialize or pre-load a form field with data, and a post-activity mapping to move
modified form data into the workflow document called flowdata. These data-item bindings, and any
script expressions they use, execute on the application server as preparation of the form before it is
sent to the client browser for display to the user. Common uses for pre-activity data-item mappings
and their expressions that operate against the flow-data document are for moving previous approval
data into the current approval or for setting default values for fields. For more information on data
item mappings, see Section 6.2.2, “Defining the Data Item Mappings,” on page 185.

Some form controls allow you to initialize their values from data sources other than workflow data.
For example, some list controls allow you to specify the initial value as a property of the control. For
more information about defining initial values, see Section 5.5, “Form Control Reference,” on

page 128.

5.1.2 About Forms and Events

Designer allows you to define action scripts that execute on the form control’s onLoad, onChange,
or custom events. Each form control supports an Events property where you supply the script for the
event. The scripts you define have an event-level scope and execute in the browser of the user’s
client machine.
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The Events property provides access to Designer’s Event Action Expression Builder, which allows
you to create script expressions that refer to and modify form and data. Because form control event
scripts execute in the client browser, they do not have access to the flow-data document. They do
have access to directory abstraction layer queries.

Figure 5-4 Event Action Expression Builder

B4 Event Action Expression Builder,

ECMASCript Yariables Functions/Methods ECMASCript Operators
@ Form Methods | "t ECMAScript © math
o Figld Methods @ Relational
o Event Methods @ Logical
o Form Fields @ Skring
o Lists
o ueries
o Script Functions
o Container Methods
I [a]'s ] [ Cancel ] [Check Syntax] [Identitv Vault...]

The Event Action Expression Builder also provides access to the Form Action methods (shown in
the left column). This column provides access to the form action script API along with directory
abstraction layer query objects. The form action script API is written in JavaScript so that you can
add conditions, loops, and user-defined functions. For more information about the Form Action API,
see Section 9.3.1, “Form Action Script Methods,” on page 328. To import or include a JavaScript
library, you use the Scripts tab of the Form Controls area. For more information, see Section 5.3.4,
“Using the Scripts Tab,” on page 123.

5.2 About the Forms Tab

You use the Forms tab of the provisioning request definition editor to define the appearance and
behavior of your request and approval forms.
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Figure 5-5 Forms Tab

® Designar - CallingCard - Dasigner

B ER Yew Project Tock Live PRD Wirdow Help
{3 3 £ Biwes BT g Dvsgner
Form Selection Form Controls

P = X &+ @

Form 10 Furm Feld Naime Data Type Control Type Liebreaks

CardRequest btie rng Tile 1
CficeRresode #ng Tt 1
Htie? g Thie 1
Comellaters ™ Pkl 1
a3 strig Tiie 1

< ¥

Regqunt . Approvd Frekde . Auliors | Everis | Sumpts

Cverview | Workflow [Foms . Sagnature Dedarsticns

The Forms tab contains a Form Selection section and a Form Controls section.

+ Section 5.2.1, “About Form Selection,” on page 113
+ Section 5.2.2, “About Form Controls,” on page 114

5.2.1 About Form Selection

Use the Form Selection section to create, delete, or preview a form, or to create a form template.
Click the Request or the Approval tab depending on the type of form you want to manipulate.

Figure 5-6 Form Selection
Form Selection

+ X & @&

Farm ID
request_form

Request < &pproval

Creating Forms for a Provisioning Request Definition 113



The Form Selection toolbar contains these options:

Table 5-1 Form Selection Toolbar Options

Button Description

Click to launch the New Form Wizard.

LL,J
% Click to delete an existing form.
Click to save the form as a template. You can then base other forms on this template.
L= Forms are saved as XML documents in the project directory.
Templates are available only within the project in which you create them.
Y Click to preview the form.

If you create a provisioning request definition from an existing template, and the template has forms
associated with it, the Form Controls section displays them. You can modify the form instance by
using the Form Controls section.

5.2.2 About Form Controls

Use the Form Controls section to define or modify the form’s appearance and behavior.

+ Fields tab: Lets you add, delete, and change the data type, control type, and layout order of the
controls on the form.

Form Controls

+ X ¢ 3

Form Field Name Data Type Control Type Lincbreaks
title: string Title
OfficeareaCade string Text
string Title
Candidates dn PickList
title3 string Title

Fields " actions | Events | Scripts

For information about adding controls, see Section 5.3, “Creating Forms,” on page 116. For
more information about individual form controls, see Section 5.5, “Form Control Reference,”
on page 128.

+ Actions tab: Lets you define the actions the user can perform on the form. Use the Actions
toolbar to add, delete, and change the actions and layout order of the actions on the form.
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Form Controls

& K ’> {L Actions location: | Batkom w

Action Command Linebreaks
iSubmitAckion in
Cancelaction 0

Fields | Artinns - Srrinks

For more information about the supported actions, see Section 5.4, “Action Reference,” on
page 125.

Scripts tab: Use the Scripts tab to define calls to external JavaScript files or to write JavaScript
scripts that are stored as part of the form definition. When you have created a script by using
this tab, it becomes available in the Action Script Expression Builder and you can call it from
any form control event. These scripts have a page-scope rather than an event-scope. For more
information about using the script tab, see Section 5.3.4, “Using the Scripts Tab,” on page 123.

Form Controls
F #H

Id Type URL{Inline Scripk
Scripk inline

< ¥

Fields | Actions | Events | Scripts
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+ Events tab

Form Controls

Ewent Name Action Expression
onload

< >

Fields | Ackions |Events - Scripts

5.3 Creating Forms

This section describes how to create new forms and add controls to them. It includes these topics:

+ Section 5.3.1, “Creating New Forms,” on page 116

+ Section 5.3.2, “Adding Form Controls and Actions,” on page 117
+ Section 5.3.3, “Defining Events,” on page 119

+ Section 5.3.4, “Using the Scripts Tab,” on page 123

5.3.1 Creating New Forms

1 With the provisioning request definition editor open, click the Forms tab.
2 Inthe Form Selection section of the page, click Add to access the New Form Wizard.
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E"}: Mew Form

Form

Form name musk be specified

Form name
|

[ ]create a form using one of the templates

Form kemplates

approval_Form
MoTemplateFarm

Pt
7 Cancel

3 Fill in the fields as follows:

Field Description

Form Name Type the name of the form as you want it to
appear in Designer.

Create a form using one of the templates If you want to base the new form on an existing
template, select this option and select one of the
forms from the Form templates list.

4 Click OK to save the form or click Cancel to exit without saving.

5.3.2 Adding Form Controls and Actions

Use the Form Controls section to define the content and layout of the form.

NOTE: The Designer places form controls on the form from top to bottom and left to right. Use
Linebreaks to force spacing between controls
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To add a control to a form:

1 Click Add. Designer adds a control named Field to the bottom line of the form.

If you add more than one control of the same name to the form, Designer adds a unique number
to the end of the control name.

2 Define the following properties for the control:

Field Description

Form Field Name A unique name for the field. The name is used in several different locations:
+ The Workflow tab’s Data Item Mapping dialog box.
+ The ECMA expression builder dialog box.

+ An internal XML reference in the provisioning request definition file.

Consider the naming conventions you want to use for form fields, in order to
avoid confusion in the Data Item Mapping and ECMA Expression Builder
dialog boxes. For example, the request and approval forms might both
contain a field called Reason. To make it clear which field you are working
with while performing data mappings, you can preface the field name with the
name of the form where it is used. You might name one reason field
Reqg_Reason and the other App_Reason.

Data Type The field’s data type. The data type determines the valid control types and the
type of validation performed.

Control Type The type of visual control used to display or edit the data. The selection list is
filtered based on the selected data type.

Linebreaks Defines the number of lines you want inserted after the control.

Form field controls do not have Data Item Mappings or E-mail notifications property sheets.

3 For each control, specify its properties in the Properties tab (available via Window > Show
View > Properties). For more information, see Section 5.5, “Form Control Reference,” on
page 128.

4 Click the Actions tab to define what the user can do with the form. For example, you can add
actions that allow the user to submit a form or cancel it.

A request form must have, at a minimum, a SubmitAction. Without a SubmitAction, the
request does not process. Every form should have a CancelAction. Each approval form must
have at least one action defined.

5 In the Actions page, click Add to add a new Action. Fill in the fields as follows:
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Field Description

Actions Location Choose the location for the action buttons you
add to the form.

Bottom. Places the action buttons on the bottom
of the form. (Default.)

Top: Places the action buttons on the top of the
form.

Top and Bottom: Places the buttons at both the
top and bottom of the form.

Action Command Choose an action for the button. For more
information, see Section 5.4, “Action Reference,”
on page 125.

Linebreaks Defines the number of lines you want inserted

after the action button.

6 Save the form.

5.3.3 Defining Events

The scripts you attach to an event handler are scoped to the appropriate control, not the browser
window.

+ “Defining an Event” on page 119
+ “Creating Custom Events” on page 120

Defining an Event

1 Select the form control where you want to define an event and open the property sheet.

2 Navigate to the Event property and add an event. Designer adds a row with the default event
name onEvent.
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4 Field Events X]

Specify event name and action expression values For field: recipient
= K
Event Mame Action Expression
onEvent
< >
@ [ Ok, ] [ Cancel

3 Click the Event Name field and select the onchange or onload event. For more information on
adding other events, see “Creating Custom Events” on page 120.

4 Click the Action Expression field. You can type the script directly in this field, or click the
button to access the Event Action Expression Builder.

5 Define the action script, check the syntax, then click OK. Repeat this procedure to add more
events to this control.

For more information on the onChange and onLoad events, see the events property description in
Section 5.5.4, “General Form Control Properties,” on page 131.

Creating Custom Events

You can create your own events to notify other controls of conditions or user actions on the form.
You create the event using the Events property. You can give the event any name. You must
explicitly fire the event by using the fireEvent() method and passing in the name of the event.

You might want to perform a query on the Groups container that returns only the groups that match
the values entered by a user. In the example shown in Figure 5-7, the user types a value in the name
field, When the user tabs to the next field, the contents of the drop-down list are populated from a
query launched by the namechange custom event.
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Figure 5-7 User Application Runtime Custom Event Sample
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The Name field defines an Events property that fires the namechange event on an onchange event.
The definition is shown in Figure 5-8.
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Figure 5-8 Sample field.FireEvent() Method

Specify event name and action expression values For field: name
g ¥
Evenk Mame Action Expression
onchange field. fireEvent("namechangs")
45 X
':'E:' [ o] 8 ] [ Cancel

The namechange event contains an expression that executes a query called groups.

122 User Application: Design Guide



Figure 5-9 Custom Event Definition Example

Specify event name and action expression values For Field: groups
CHED 4
Event Mame Action Expression
namechange ID% ault, globalQuery{"groups”, "groups”, {name:Form.getyalued"name"i});
% ¥
@ I QK ] [ Cancel ]

For more information on using queries, see Section 5.7, “Using DAL Queries in Forms,” on
page 170.

5.3.4 Using the Scripts Tab

Use the Scripts tab to define a script that has a page-level scope. A page-level scope means that the
script loads at page load time and is available through the life of the form. You can supply the script
in one of the ways described in Table 5-2.

Table 5-2 Script Types

Script Type Description

external The script is incorporated into the page by reference, using the supplied URL. The script
block will look something like this: <script type="test/javascript”
scr="http://some.server/custom. js”’></script>. The custom. js file is
imported at form load.

inline The script is inserted directly into the form in a <script> block.

Because these scripts are loaded at page load, the form controls and any of their associated event
handler scripts are not in scope when the page is loaded. Avoid coding dependencies between page-
level scripts and event-level scripts; however, you can call page-level scripts from within an event-
level script.

To add a link to an external JavaScript file:

1 With the Scripts tab open, click Add ¥ .
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2 Complete the fields as follows:

Field Description

ID Specify a meaningful name. This value displays in the
Event Action Expression Builder.

Type Select external.

URL/Inline Script

Click within the field so that the ECMAScript Editor button
displays to the right, then click the button to display the
editor as a dialog box.

Type the URL to the . js file in the Enter the URL String
field, then click Retrieve. The script is fetched and
displays in read-only mode. You can inspect the script,
but you cannot change it.

Infine scrigt Sorptl”

et o o+

S —r

[ TR e e —— [Ratciers

When you add an external link to a form, only the link is
stored and deployed, for example:

<script src="someURL.com/script.js'/>

TIP: Designer cannot validate this external reference. You
must ensure that it is accessible at runtime.

To create an inline script:

1 With the Scripts tab open, click Add .
2 Complete the fields as follows:
Field Description
ID Specify a meaningful name. This value displays in the
Event Action Expression Builder.
Type Select inline.
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Field Description

URL/Inline Script Click within the field so that the ECMAScript Editor button
displays to the right, then click the button to display the
editor as a dialog box.

Inine scrigh Sorpt

et o x o+

You add your JavaScript by using this ECMAScript Editor.
To learn more about using the editor, click the editor’s
help button.

For inline scripts, the following is inserted in the page:

<script>whatever you type</script>

Both inline and external scripts are executed at page load but before the page loads the controls. In
addition, they are also executed when specifically called on a form control event.

5.4 Action Reference

This section describes the actions you can add to forms. The actions are implemented as buttons.
You can specify a custom display label for each button.

Table 5-3 Valid Actions

Action Name Form Type Description

ApprovalAction Approval Causes the Approval activity to complete and follow the
approved flow path to the next activity. When you use this action,
you must set the Hide If Read Only form property to True;
otherwise the form fails validation when you submit it.

TIP: An ApprovalAction requires the Approval Activity
associated with the form to have an approved flow path exiting
the activity.
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Action Name Form Type

Description

CancelAction Request and
Approval

CommentAction Approval forms

DenyAction Approval

RefusalAction Approval

For request forms, Cancel returns the user to the Request
Resource Search Criteria form. For approval forms, Cancel
returns the user to the My Tasks list.

Generates a button with the default label set to View Comment
History. The button launches a Comments dialog box displaying
the processing history for each activity from the workflow start to
the present time. Data displayed includes Date, Activity Name,
User, and Comment as shown in the following example.

-2 Comments - Microsoft Internet Explorer Q@E|
[=

Task Comments

Date Activity User Comments
06/01/2006 09:29:48 AWM Start System W orkflows Started
06/01/2006 09:29:48 AM Start System W orkflow Forwarded
06/01/2006 09:30:18 &AM Single Approval System W orkflow Claimed
06/01/2006 09:30:30 AWM Single Approwal Jack Miller ves please

1-4ofd

Comments are updated and persisted to the workflow database
through the UpdateAction.

NOTE: Any forms containing this action must also contain a field
named apwaComment.

Causes the Approval activity to complete and follow the denied
flow path. When you use this action, you must set the Hide If
Read Only form property to True; otherwise, the form fails
validation when you submit it.

TIP: A DenyAction requires the Approval Activity associated with
the form to have a deny flow path exiting the activity.

Causes the Approval activity to complete and follow the refused
flow path. When you use this action, you must set the Hide If
Read Only form property to True; otherwise, the form fails
validation on submit.

TIP: A RefusalAction requires the Approval Activity associated
with the form to have a refusal flow path exiting the activity.

126 User Application: Design Guide



Action Name Form Type Description

SubmitAction Request and Initiates the workflow and causes the workflow to execute the
Approval forward flow type. The workflow passes any user-entered data to
the next activity in the workflow.

UpdateAction Approval Causes the Approval activity to write a user comment to the
workflow database. There is typically a text area associated with
an apwaComment form field. If the user enters text in this field
and clicks this action, it is persisted to the afcomment table in the
workflow database. The comment can be retrieved and viewed
through the CommentAction (described above). The following
example shows a text area and an update action button (labeled
UpdateAction):

Single Approval

Please select the appropriate button to approve or reject the request.

Requested by Allison Blake Recipient: Allisan
Blake

Request Date: 06/05/2006

Reason:

Comment:

View Comment Histary ” Updateaction

NOTE: The form must contain a field named apwaComment;
otherwise, the provisioning request definition fails validation.

For more information about apwaComment, see Section 5.5.3,
“Controls for User-Entered Comments,” on page 130.

The following table describes the properties you can set on actions.

Table 5-4 Action Properties

Property Name Description

Display Label Specifies the text to display on the button.

Visible If True, specifies whether the action is visible at runtime.

Block On Error If True, specifies that the action is blocked if any of the form’s controls fail

validation. This is recommended for the SubmitAction. You should not set it to
False if the action button submits data; otherwise, invalid data can be submitted,
causing unexpected results.

Designer does not allow you to set this property to False for the ApprovalAction,
DenyAction, or RefusalAction.
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Property Name Description

Hide If Read Only  If True, specifies that the action is hidden when the form is read-only. A form can be
read-only when the user opens a task without claiming it first. If your form contains
the ApprovalAction, DenyAction, or RefusalAction, this property must be set to
True. If it is set to False, you encounter a validation error and cannot deploy the
form.

5.5 Form Control Reference

This section describes the controls you can add to a form.
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Table 5-5 Control Types and Supported Data Types

Data Types

Control Type Resource
Boolean Date Decimal DN Integer  String Time

Request

CheckBoxPickList X X X X X

DatePicker X

DateTimePicker X

DNContainer X

DNDisplay X

DNLookup X

DNMaker X

DNQuery X

Global List X

Html X

Localized Label X

MVCheckbox X X X X

MVEditor X X X X

Password X

PickList X X X X

Static List X X X X

Text X X X X

Text Area X

Title X

TrueFalseCheckBox X

TrueFalseRadioButtons x

TrueFalseSelectBox X

+ Section 5.5.1, “Data Type for Roles Based Request Forms,” on page 130

+ Section 5.5.2, “Data Type for Resource Based Request Forms,” on page 130
+ Section 5.5.3, “Controls for User-Entered Comments,” on page 130

+ Section 5.5.4, “General Form Control Properties,” on page 131

+ Section 5.5.5, “CheckBoxPickList,” on page 132

+ Section 5.5.6, “DatePicker,” on page 133

+ Section 5.5.7, “DateTimePicker,” on page 135

+ Section 5.5.8, “DNContainer,” on page 136
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+ Section 5.5.9, “DNDisplay,” on page 138

+ Section 5.5.10, “DNLookup,” on page 139

+ Section 5.5.11, “DNMaker,” on page 144

+ Section 5.5.12, “DNQuery,” on page 146

+ Section 5.5.13, “Global List,” on page 148

+ Section 5.5.14, “Localized Label,” on page 149

+ Section 5.5.15, “Html,” on page 150

+ Section 5.5.16, “MVCheckbox,” on page 151

+ Section 5.5.17, “MVEditor,” on page 153

+ Section 5.5.18, “Password,” on page 158

+ Section 5.5.19, “PickList,” on page 159

¢ Section 5.5.20, “Static List,” on page 161

+ Section 5.5.21, “Text,” on page 163

+ Section 5.5.22, “Text Area,” on page 164

+ Section 5.5.23, “Title,” on page 165

+ Section 5.5.24, “TrueFalseCheckBox,” on page 166
+ Section 5.5.25, “TrueFalseRadioButtons,” on page 167
+ Section 5.5.26, “TrueFalseSelectBox,” on page 167

5.5.1 Data Type for Roles Based Request Forms

Designer supports a specialized form control called nrfRequestDN of data type Role Request. The
control type is Text. It is defined by default when you create a copy of the standard roles based
provisioning request definitions. It represents the Role Request object.

5.5.2 Data Type for Resource Based Request Forms

Designer supports a specialized form control called nrfResourceRequestDN of data type Resource
Request. The control type is Text. It is defined by default when you create a copy of the standard
resource based provisioning request definitions. It represents the Resource Request object. You can
add this control only once. nrfResourceRequestDN is the field name and it cannot be changed in the
GUL.

5.5.3 Controls for User-Entered Comments

Designer supports a special internal control you can add to a form to allow users to add comments to
a workflow or to view previously entered comments. Comments are required on forms that use
CommentAction or UpdateAction. The comments are not part of the workflow data so you cannot
access them via the flowdata object. The comments are special data items stored in the afcomment
table of the workflow database. The comments are persisted as long as the row for the requestid in
the afprocess table exists.
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To create a form that supports user comments:

1 Add a control to your form. Select Comment as the data type. The Form Field name is
automatically defined as apwaComment and the Control Type is TextArea. A single form can
contain only one comment field.

2 Add a CommentAction or UpdateAction to the form.
For more information, see Section 5.4, “Action Reference,” on page 125.

5.5.4 General Form Control Properties

The properties in the following table are available for each control.

Table 5-6 General Properties

Property Name Description

Display label Specifies the label to display to identify the control. It is localizable.

Editable Specifies if the control is editable (True). Otherwise, it displays as read-only.
Events Specifies an event for the control. Possible values include the following:

+ OnChange: Fires when one of the following occurs:
+ Immediately after onload.
+ Another script changes the value of the control.

* The user commits a change to the data value associated with the
control. This occurs when the user has tabbed out of the control
or otherwise caused it to lose focus. For example, this can
happen when the user tabs away from the control (for text entry
based controls like Text, TextArea, DatePicker), or when the user
selects a different entry choice for choice-based controls like
PickList, MVCheckbox, and StaticList).

+ onlLoad: The onload event for a control fires just once, when the control
is loaded into the page for the first time. It can be used to set initial
values or preselect entries; however, there is no guarantee that
controls load in a particular order.

Multivalued This is a read-only property. It specifies if the control supports multivalue
attributes (True).

Required Specifies whether the control requires user input (True).

Tooltip Specifies the text for the control’s tooltip. It is localizable.

Visible Specifies whether the control is displayed in the user interface (True).

Sort Order

List-based controls sort content alphabetically. For DN-based lists, the sort order is alphabetical
based on the Display expression property result. For all other types, the sort order is based on the
display label.
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5.5.5 CheckBoxPickList

Use the CheckBoxPickList control to allow users to view and choose one or more values from a
dynamically generated list of choices displayed as check boxes.

When the associated data type is a DN retrieved from the Identity Vault, you can display the check
box label as the fully qualified DN or use the Display expression property to specify the attributes to
display instead.

Figure 5-10 Sample CheckBoxPickList Control

CheckBoxPickList: [Nasia [lewrope [ClMorth america  [south smerica

Table 5-7 CheckboxPickList Properties

Property Name Description

Entity Key for DN expression lookup When you populate this control with a DN retrieved from the
Identity Vault and you want that value to display in a user-
friendly fashion, you should choose an entity from the drop-
down list and specify a set of attributes in the Display
expression property.

Leave this value blank if you want to display the full DN or CN
value retrieved from the Identity Vault.

The entity you choose must have the directory abstraction layer
View property set to True and be the entity whose DN you are
retrieving from the Identity Vault.

Display expression Required when you specify an Entity Key for DN expression
Lookup. Choose the attributes to display as the check box
labels. For example, to display the user entity’s first and last
name attributes, construct an expression like this: FirstName
LastName.

The attribute’s directory abstraction layer properties for View,
Read, Search, and Required must be set to True.

Allow multiple selections When this option is set to True, users can select more than one
entry.
Field cell style Apply an HTML style attribute to the field body.

Example: padding-top:5px;background-color:red

Field CSS class name(s) Apply one or more CSS class styles to the field body. You can
view the classes that are available for your User Application
portal by logging into the User Application, navigating to
Administration > Application Configuration > Theme
Administration, then clicking the Preview button for the portal
theme you are using.

If you leave the field blank, it defaults to the nv-fontExtraSmall
class.

Example: nv-fontMedium nv-backgroundColor3

Separate class names with spaces.
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Property Name Description

Label cell style Apply an HTML style attribute to the field label.
Example: color:red

Label CSS class name(s) Apply one or more CSS class styles to the field label. You can
view the classes that are available for your User Application
portal by logging into the User Application, navigating to
Administration > Application Configuration > Theme
Administration, then clicking the Preview button for the portal
theme you are using.

If you leave the field blank, it defaults to the nv-formFieldLabel
class.

Example: nv-color5
Separate class names with spaces.

Show 2 lists When this option is set to True, two lists are displayed, one for
the unselected values and another for the selected values.

The Allow multiple selections property must be set to True. If set
to False, Show 2 lists is ignored.

Sort entries When this option is set to True, sorts results in ascending order.
For details, see “Sort Order” on page 131.

5.5.6 DatePicker

Use this control for display and entry of a date and time. This allows users to choose a date from a
pop-up calendar or type a date in a text field. At runtime, the form automatically validates the date
by using the format for the user’s locale and time zone. If the user enters an incorrect format, the
form displays an error message. The DatePicker control’s tooltip displays the valid date format. The
default DatePicker control looks like this:

Figure 5-11 Sample DatePicker Control

DatePickerControl; 05/25/2006 10:47.25 AM 3

When the Show date picker property is True, the form displays the date field along with a button.
When the user clicks the button, the form launches a calendar for the user to select the date. The
calendar pop-up looks like this:
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Figure 5-12 Sample Calendar Control
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Table 5-8 DatePicker Control Properties

Property name

Description

Datetime indicator

Day headers

Field cell style

Field CSS class
name(s)

Field Width in pixels

Label cell style

Label CSS class
name(s)

Month names

When this option is set to False, the Calendar pop-up does not display the time.

A comma-separated, single-quoted list of values displayed by the Calendar pop-
up to indicate the day of the week. This value is localizable.

Apply an HTML style attribute to the field body.
Example: padding-top:5px;background-color:red

Apply one or more CSS class styles to the field body. You can view the classes
that are available for your User Application portal by logging into the User
Application, navigating to Administration > Application Configuration > Theme
Administration, then clicking the Preview button for the portal theme you are
using.

If you leave the field blank, it defaults to the nv-fontExtraSmall class.
Example: nv-fontMedium nv-backgroundColor3
Separate class names with spaces.

Use this field to configure the field’s visible width on the form. The default is 200
pixels.

Apply an HTML style attribute to the field label.
Example: color:red

Apply one or more CSS class styles to the field label. You can view the classes
that are available for your User Application portal by logging into the User
Application, navigating to Administration > Application Configuration > Theme
Administration, then clicking the Preview button for the portal theme you are
using.

If you leave the field blank, it defaults to the nv-formFieldLabel class.
Example: nv-color5
Separate class names with spaces.

A comma-separated, single-quoted list of values displayed by the Calendar pop-
up to indicate the month name. This value is localizable.
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Property name Description

Show date picker When this option is set to True, displays the calendar pop-up. If it is set to False,
the calendar pop-up does not display. Users must type the date in the text field by
using the proper format for their locale.

5.5.7 DateTimePicker

Use this control for display and entry of a date and time for a Time data type. This allows users to
choose a date and time from a pop-up calendar or type a value in a text field. At runtime, the form
automatically validates the date and time by using the format for the user’s locale and time zone. If
the user enters an incorrect format, the form displays an error message. The DateTimePicker tooltip
displays the valid date format. The default control looks like this:

Figure 5-13 Sample DateTimePicker Control

DateTimePicker 11/17/2006 10:38:17 &M E

When the Show date picker property is set to True, the form displays a text field followed by a
calendar button. When the user clicks the calendar button, the form launches a calendar control for
the user to select the date and time values. The calendar pop-up looks like this:

Figure 5-14 DateTimePicker Calendar Control
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Table 5-9 DateTimePicker Control Properties

Property name Description

Day headers A comma-separated, single-quoted list of values displayed by the Calendar pop-
up to indicate the day of the week. This value is localizable.

Field width in pixels  Use this field to configure the field’s visible width on the form. The default is 200
pixels.

isDateTime When this option is set to False, the Calendar pop-up does not display the time.
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Property name Description

Month names A comma-separated, single-quoted list of values displayed by the Calendar pop-
up to indicate the month name. This value is localizable.

Show date picker When this option is set to True, it displays the calendar pop-up. If it is set to False,
the calendar pop-up does not display. Users must type the proper format for the
locale when they type the date in the text field.

5.5.8 DNContainer

Use this control to allow users to select a container object from within the root container that you
specify. You can use this control to limit the user to a subtree of a container. This is a specialized
version of the DNLookup control.

Figure 5-15 DNContainer Control With Root Container Specified

DhContainer:

QI

Table 5-10 DNContainer Control Properties

Property name

Description

Entity key used for object lookup

Field cell style

Field CSS class name(s)

Field width in pixels

Label cell style

Choose an entity from the drop-down list. The entity that you choose
limits the users ability to look up objects within the specified entity’s
container. If you specify an entity key and a root container, the entity
key takes precedence.

Apply an HTML style attribute to the field body.
Example: padding-top:5px;background-color:red

Apply one or more CSS class styles to the field body. You can view
the classes that are available for your User Application portal by
logging into the User Application, navigating to Administration >
Application Configuration > Theme Administration, then clicking the
Preview button for the portal theme you are using.

If you leave the field blank, it defaults to the nv-fontExtraSmall class.
Example: nv-fontMedium nv-backgroundColor3
Separate class names with spaces.

Use this field to configure the field’s visible width on the form. The
default is 200 pixels.

Apply an HTML style attribute to the field label.

Example: color:red
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Property name Description

Label CSS class name(s) Apply one or more CSS class styles to the field label. You can view

the classes that are available for your User Application portal by
logging into the User Application, navigating to Administration >
Application Configuration > Theme Administration, then clicking the
Preview button for the portal theme you are using.

If you leave the field blank, it defaults to the nv-formFieldLabel class.
Example: nv-color5

Separate class names with spaces.

Root container Specify a root container for lookups when users click the Object
Selector button.

Show clear button If set to True, the form displays the Reset field button

Show object history button If set to True, the form displays the Show history button.

Show object selector button If set to True, the form displays the Object Selector button.

Displaying the Container Description Instead of the Container O/OU Name

Some additional steps are required to take advantage of an Identity Manager 4.0 DNContainer form
field enhancement. This enhancement allows you to display the container description instead of the
container O/OU name.

To enable the DNContainer enhancement, you need to manually update the Designer install to add
properties to the DNContainer control. Then, you need to create a DAL entity corresponding to the
container for which you want to display an attribute. Finally, you need to use the form editor to
choose the entity and attribute.

1

Locate the following file in your Designer install:

/opt/novell/idm/Designer/plugins/
com.novell_core.scriptengineshell_4.0.1.0.*/1ib/UlRegistry.jar

Back it up first, then use a suitable jar/zip tool to modify the file within the jar:
com\novel I\srvprv\impIN\uictrI\UlControlRegistry.xml
Locate the <ctrl key="DNContainer" section and add the following properties at the end:

<prop name="display-entitydef"” type="string"” since="1.9">
<display-label rb-key="LAB DIS ENTITYDEF"/>

</prop>

<prop name="display-exp" type="expression' since='"1.9">
<display-label rb-key="LAB_DIS_EXPRESSION"/>

</prop>

4 Put this file back into the JAR in its original location and start Designer.

5 In Designer, create a new DAL entry with an unused name, such as myDescriptionLookup.

For the base class of this DAL entry, choose Organization, and pick the attribute you want to
show (for example Description).

When the DAL editor is open, change the LDAP name of the class to Top. (This allows you to
view the Description for Organizations, Organizational Units, and so forth.)

To use the new DAL entry, open a PRD and go to a form. Add or pick a dn/DNContainer field.
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9 Fill in the two new fields (Entity key for DN expression lookup, Display expression) with the
values specified above (myDescriptionLookup, Description).

10 Deploy the new DAL entry and the PRD.
11 On the User Application, clear the cache or restart the server.

12 Test the new PRD to ensure that the descriptions are shown instead of the cn in the
DNContainer control.

Make sure the containers you are going to show have a Description value; otherwise, cn is
used. Containers, by default, leave this value blank.

5.5.9 DNDisplay

Use this control to display a read-only DN. You populate the control from flowdata. The control can
display the full DN or a set of attributes associated with the DN depending on the properties you set.
The DNDisplay control cannot be modified by the workflow engine. For this reason, it is not
available for post activity mapping.

Figure 5-16 Sample DNDisplay

This is a DHDisplay control

Display DR: cn=kkilpatrick,ou=uzers,,ou=idmsample-doc,o=novell
Figure 5-17 Sample DNDisplay with Display Expression Specified

This is a DHDisplay control
Display DM: Kelly Kilpatrick

Table 5-11 DNDisplay Control Properties

Property name Description
Display expression Leave this value blank if you want to display the full DN or CN
value.

If you want to mask the DN by displaying attributes instead,
launch the expression builder and select the desired attributes
from the list. (You must first specify an Entity key for DN
expression lookup.)

For example, to show the user entity’s first and last name
attributes, construct an expression like this: FirstName
LastName.

Make sure the attribute’s View, Read, Search, and Required
properties are set to True in the directory abstraction layer. See
Section 3.7.2, “Attribute Properties,” on page 72.
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Property name

Description

Entity key for DN expression lookup

Field cell style

Field CSS class name(s)

Label cell style

Label CSS class name(s)

Leave this value blank if you want to display the full DN or CN
value retrieved from the Identity Vault.

If you want to mask the DN or CN by displaying attributes
instead, choose the entity from the drop-down list and specify a
set of attributes in the Display expression property.

The entity you choose must:

* Have the directory abstraction layer View property set to
True.

+ Be the entity of the DN you are working with.

For more information, see Section 5.6, “Working with
Distinguished Names,” on page 168.

Apply an HTML style attribute to the field body.
Example: padding-top:5px;background-color:red

Apply one or more CSS class styles to the field body. You can
view the classes that are available for your User Application
portal by logging into the User Application, navigating to
Administration > Application Configuration > Theme
Administration, then clicking the Preview button for the portal
theme you are using.

If you leave the field blank, it defaults to the nv-fontExtraSmall
class.

Example: nv-fontMedium nv-backgroundColor3
Separate class names with spaces.

Apply an HTML style attribute to the field label.
Example: color:red

Apply one or more CSS class styles to the field label. You can
view the classes that are available for your User Application
portal by logging into the User Application, navigating to
Administration > Application Configuration > Theme
Administration, then clicking the Preview button for the portal
theme you are using.

If you leave the field blank, it defaults to the nv-formFieldLabel
class.

Example: nv-colorb

Separate class names with spaces.

5.5.10 DNLookup

Use this control to allow users to search and retrieve DNs from the Identity Vault. You can initialize
the control with a DN from the flowdata. You set properties to control the entities and containers that
the user can search and the format of the DN.
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Figure 5-18 Sample DNLookup Control
Dt Loakup:
The buttons associated with the DNLookup control are described in Table 5-12.

Table 5-12 DNLookup Control Buttons

Button Description
Launches an object lookup dialog box. You define whether the dialog box displays
containers or objects via the Object Selector type property. The following is an

example of an object lookup:

A Object Lookup - Microsoft Internet Explorer:

Object Lookup T & -0

Search object list: [example: 2%, Lar®, D, *r)

Description % “ﬁ Search

Select an object from the list:
Description

hccounting

Executive Management

Human Resources

Improve Customer Service task force
Information Technology

Marketing

Sales

1-7of 7

The attributes shown in the drop-down list (Description in the above example) are
specified in the directory abstraction layer. The availability of this button is
controlled by the Show object selector property.

Show history. Allows users to view the history of objects that they have searched.
= They can select from this list or clear its contents. The availability of this button is
controlled by the Show object history button property.

Reset field. Deletes the field contents. The availability of this button is controlled
by the Show clear button property.
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Table 5-13 DNLookup Control Properties

Property Name

Description

Display expression

Entity key for DN expression lookup

Field cell style

Field CSS class name(s)

Label cell style

This property only applies when you initialize the control from
flowdata. Leave this value blank if you want to display the full DN
or CN value.

If you want to mask the DN by displaying attributes instead,
launch the Expression Builder and select the desired attributes
from the list. (You must first specify an Entity key for DN
expression lookup.)

For example, to show the user entity’s first and last name
attributes, construct an expression like this: FirstName
LastName.

Make sure the attribute’s View, Read, Search, and Required
properties are set to True in the directory abstraction layer. See
Section 3.7.2, “Attribute Properties,” on page 72.

This property only applies when you initialize the control from
flowdata. Leave this value blank if you want to display the full DN
or CN value retrieved from the Identity Vault.

If you want to mask the DN or CN by displaying attributes
instead, choose the entity from the drop-down list, then specify a
set of attributes in the Display expression property.

The entity you choose must:

+ Have the directory abstraction layer View property set to
True.

+ Be the entity of the DN you are working with.

For more information, Section 5.6, “Working with Distinguished
Names,” on page 168.

Apply an HTML style attribute to the field body.
Example: padding-top:5px;background-color:red

Apply one or more CSS class styles to the field body. You can
view the classes that are available for your User Application
portal by logging into the User Application, navigating to
Administration > Application Configuration > Theme
Administration, then clicking the Preview button for the portal
theme you are using.

If you leave the field blank, it defaults to the nv-fontExtraSmall
class.

Example: nv-fontMedium nv-backgroundColor3
Separate class names with spaces.
Apply an HTML style attribute to the field label.

Example: color:red
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Property Name

Description

Label CSS class name(s)

Apply one or more CSS class styles to the field label. You can
view the classes that are available for your User Application
portal by logging into the User Application, navigating to
Administration > Application Configuration > Theme
Administration, then clicking the Preview button for the portal
theme you are using.

If you leave the field blank, it defaults to the nv-formFieldLabel
class.

Example: nv-color5

Separate class names with spaces.
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Property Name

Description

Object Selector type

Field width in pixels

Show clear button

Determines whether the object selector dialog box performs an
Object Lookup or a Container Lookup. The following is an
example of an Object Lookup:

[ Object Lookup - Mozilla Ejﬁlgl

Object Lookup ?T 0

Search object list: [example: a%, Lar®, ID, ]

First Mame | “‘% Search

paramlist: Causes the object selector dialog box to perform an
object lookup. You specify the lookup criteria via the Entity key
for DN Expression lookup property.

container: Causes the object selector dialog box to display one
or more containers for selection. The containers for searching
are determined by the Search container property, which is
specified in the directory abstraction layer for the entity named in
the required Entity Key for DN Expression lookup property. For
example, if the Entity key for DN Expression lookup property is
Group, the search container is set to %group-root% by default. If
no search container is used, the search root specified during the
User Application installation is used.

Use this field to configure the field's visible width on the form.
The default is 200 pixels.

If this option is set to True, the form displays the Reset field
button.
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Property Name Description

Show object history button If this option is set to True, the form displays the Show history
button.

Show object selector button If this option is set to True, the form displays the object selector
button.

5.5.11 DNMaker

Use this control to allow users to construct a DN value by specifying a naming value and choosing a
container.

Figure 5-19 Sample DNMaker Control

Dhthaker: ch= @ E

Table 5-14 DNMaker Control Buttons

Button Description

Launches an object selector for container searches like the one shown below.

[ Container, Lookup - Mozilla

Container Lookup ? 8 _ O

Root Directory: ou=groups, ou=idmsarnple-doc, o=novell

Search container list: (Example: &%, Lar®, 1D, *r]

& Search

Select a container from the list:

= groups

The container search root is defined for the entity specified in the Entity used for
object lookup property. The availability of this button is controlled by the Show
object selector property.
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Button Description

Show history. Allows users to view the history of objects that they have searched.
= They can select from this list or clear its contents. The availability of this button is
controlled by the Show object history button property.

If the root container is specified for lookups, the Show history button is not shown
even if the property is set to True. This has been done for security reasons.

Reset field. Deletes the field contents. The availability of this button is controlled
by the Show clear button property.

Table 5-15 DNMaker Control Properties

Property Description

Entity key used for object lookup A required field. Choose an entity from the drop-down list. This
determines the search that is launched when the user clicks the
object selector button.

If you specify an entity key and a root container, the entity key takes
precedence

Naming attribute The naming attribute used to construct the final DN. This value
displays next to the control’s display label as an extra hint to the user.

Field cell style Apply an HTML style attribute to the field body.
Example: padding-top:5px;background-color:red

Field CSS class name(s) Apply one or more CSS class styles to the field body. You can view
the classes that are available for your User Application portal by
logging into the User Application, navigating to Administration >
Application Configuration > Theme Administration, then clicking the
Preview button for the portal theme you are using.

If you leave the field blank, it defaults to the nv-fontExtraSmall class.
Example: nv-fontMedium nv-backgroundColor3
Separate class names with spaces.
Label cell style Apply an HTML style attribute to the field label.
Example: color:red

Label CSS class name(s) Apply one or more CSS class styles to the field label. You can view
the classes that are available for your User Application portal by
logging into the User Application, navigating to Administration >
Application Configuration > Theme Administration, then clicking the
Preview button for the portal theme you are using.

If you leave the field blank, it defaults to the nv-formFieldLabel class.
Example: nv-color5

Separate class names with spaces.
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Property

Description

Root container

Show clear button
Show object history button

Show object selector button

Specify a root container for lookups when users click the object
selector button. If you do not specify a Root container, the User
Application uses the container for the entity in the directory
abstraction layer property called Search Container. If a search
container is not specified for the specified entity, then the Root
Container DN specified during the User Application installation is
used. If you specify an entity key and a root container, the entity key
takes precedence.

If this option is set to True, the form displays the Reset field button.
If this option is set to True, the form displays the Show history button.

If this option is set to True, the form displays the object selector
button.

5.5.12 DNQuery

DNQuery is a specialized version of the DNLookup control. Like DNLookup, DNQuery allows
users to search and retrieve DNs from the Identity Vault; however, with the DNQuery, the object
selector content can be driven by the result of a directory abstraction layer Queries object rather than

from properties.

Table 5-16 DNQuery Control Properties

Property Name

Description

DAL global query key

DAL global query parameter(s)

Display expression

Specifies the key of the DAL Queries object you want
executed. You can select it from the Event Action Expression
Builder. For more information about using DAL queries, see
Section 5.7, “Using DAL Queries in Forms,” on page 170. For
more information about defining DAL queries, see

Section 3.4, “Working with Queries,” on page 61.

Specifies the value for the query parameters. For example,
this passes the String Sales to the Queries parameter called
groupname:

(function QQ{return
{""groupname":"Sales"}}NQ;

When you populate the control with initial data from a Data
Item Mapping value, use this property to specify the attributes
to display.
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Property Name

Description

Entity key for DN expression lookup

Field cell style

Field CSS class name(s)

Field width in pixels

Label cell style

Label CSS class name(s)

Show clear button

Show object selector button

This property only applies when you initialize the control from
flowdata. Leave this value blank if you want to display the full
DN or CN value retrieved from the Identity Vault.

If you want to mask the DN or CN by displaying attributes
instead, choose the entity from the drop-down list, then
specify a set of attributes in the Display expression property.

The entity you choose must:

+ Have the directory abstraction layer View property set to
True.

+ Be the entity of the DN you are working with.

For more information, Section 5.6, “Working with
Distinguished Names,” on page 168.

Apply an HTML style attribute to the field body.
Example: padding-top:5px;background-color:red

Apply one or more CSS class styles to the field body. You can
view the classes that are available for your User Application
portal by logging into the User Application, navigating to
Administration > Application Configuration > Theme
Administration, then clicking the Preview button for the portal
theme you are using.

If you leave the field blank, it defaults to the nv-fontExtraSmall
class.

Example: nv-fontMedium nv-backgroundColor3
Separate class names with spaces.

Use this field to configure the field’s visible width on the form.
The default is 200 pixels.

Apply an HTML style attribute to the field label.
Example: color:red

Apply one or more CSS class styles to the field label. You can
view the classes that are available for your User Application
portal by logging into the User Application, navigating to
Administration > Application Configuration > Theme
Administration, then clicking the Preview button for the portal
theme you are using.

If you leave the field blank, it defaults to the nv-formFieldLabel
class.

Example: nv-color5
Separate class names with spaces.
If set to True, the form displays the Reset field button

If set to True, the form displays the Object Selector
button.
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5.5.13 Global List

Use this control to allow users to select a single entry from a drop-down list. The contents of the list
are defined in a directory abstraction layer global list element.

Figure 5-20 Sample Global List Control

GloballistCantral: i Click here to select a walue .. '

Click here to ze

[de] German

[en] Englizh

[Bx] Spanizh

[fr] French

[it] Italian [

Table 5-17 Global List Properties

Property Name Description

DAL global list key Specifies the unique identifier of the global list. This
must correspond to the key specified in the
directory abstraction layer.

Field cell style Apply an HTML style attribute to the field body.
Example: padding-top:5px;background-color:red

Field CSS class name(s) Apply one or more CSS class styles to the field
body. You can view the classes that are available
for your User Application portal by logging into the
User Application, navigating to Administration >
Application Configuration > Theme Administration,
then clicking the Preview button for the portal
theme you are using.

If you leave the field blank, it defaults to the nv-
fontExtraSmall class.

Example: nv-fontMedium nv-backgroundColor3
Separate class names with spaces.
Label cell style Apply an HTML style attribute to the field label.

Example: color:red
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Property Name

Description

Label CSS class name(s)

Apply one or more CSS class styles to the field
label. You can view the classes that are available
for your User Application portal by logging into the
User Application, navigating to Administration >
Application Configuration > Theme Administration,
then clicking the Preview button for the portal
theme you are using.

If you leave the field blank, it defaults to the nv-
formFieldLabel class.

Example: nv-color5

Separate class names with spaces.

For more information about global lists, see Section 3.3, “Working with Lists,” on page 57.

5.5.14 Localized Label

Use this control if you want to allow the user to provide translated text for the field. This control
displays the standard icon that indicates the text can be localized.

Figure 5-21 LocalizedLabel Control

localizedLabel:

2

If the user clicks the icon, they are able to type the text for each language supported by the User
Application driver. The list of languages displayed for this control is determined by the contents of

the locale resource group called base-resgrp.

Figure 5-22 LocalizedLabel Control

localizedLabel:

trueFalseRadiobuttons: . o
date: ChanEE[Ch-II'Iﬂ_:Z.
Chine=e (Taiwan):
Field: Dutch:
Field0: English: *
Reason for request: * French:
E German:
ltalian:
Japanese:
Portuguese:
Russian:
Spanizh:
Swedizh:
4
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Table 5-18 LocalizedLabel Control Properties

Property Name Description

Field CSS class name(s) Apply one or more CSS class styles to the field
body. You can view the classes that are available
for your User Application portal by logging into the
User Application, navigating to Administration >
Application Configuration > Theme Administration,
then clicking the Preview button for the portal
theme you are using.

If you leave the field blank, it defaults to the nv-
fontExtraSmall class.

Example: nv-fontMedium nv-backgroundColor3
Separate class names with spaces.

Label CSS class name(s) Apply one or more CSS class styles to the field
label. You can view the classes that are available
for your User Application portal by logging into the
User Application, navigating to Administration >
Application Configuration > Theme Administration,
then clicking the Preview button for the portal
theme you are using.

If you leave the field blank, it defaults to the nv-
formFieldLabel class.

Example: nv-color5

Separate class names with spaces.

5.5.15 Html

Use this control to add HTML fragments to the Form Detail. You can do this by specifying the
HTML fragments in the HTML content property. In addition, you can conditionally add the HTML
fragment via an event on the form control. In either case, specify the HTML through the use of an
anonymous function, such as: ( function() { return "<yourTag yourAttr="your attr
value®™ /7>"; } ) O:;

For example:

(function(){ return "<table bgcolor="#C0COCO"><th colspan="3*
align="center">Table Header Goes Here</th><tr><td>Value 1.1</td><td>Value
1.2</td></tr><tr><td>Value 2.1</td><td>Value 2.2</td></tr></table>"; })(

Table 5-19 HTML Control Properties

Property Name Description

Field cell style Apply an HTML style attribute to the field body.

Example: padding-top:5px;background-color:red
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Property Name Description

Field CSS class name(s) Apply one or more CSS class styles to the field
body. You can view the classes that are available
for your User Application portal by logging into the
User Application, navigating to Administration >
Application Configuration > Theme Administration,
then clicking the Preview button for the portal
theme you are using.

If you leave the field blank, it defaults to the nv-
fontExtraSmall class.

Example: nv-fontMedium nv-backgroundColor3
Separate class names with spaces.

Label cell style Apply an HTML style attribute to the field label.
Example: color:red

Label CSS class name(s) Apply one or more CSS class styles to the field
label. You can view the classes that are available
for your User Application portal by logging into the
User Application, navigating to Administration >
Application Configuration > Theme Administration,
then clicking the Preview button for the portal
theme you are using.

If you leave the field blank, it defaults to the nv-
formFieldLabel class.

Example: nv-color5

Separate class names with spaces.

5.5.16 MVCheckbox

Use this control to display a set of labeled check boxes. You specify the label and its associated
values through the List item property. A sample MV Checkbox control is shown below.

Figure 5-23 Sample MVCheckbox Control

MvCheckboxContral: [] Blue [| Green [ ] Red [] ¥ellow

Table 5-20 MVCheckbox Control Properties

Property Name Description

Field cell style Apply an HTML style attribute to the field body.

Example: padding-top:5px;background-color:red
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Property Name

Description

Field CSS class name(s)

Label cell style

Label CSS class name(s)

List item

Apply one or more CSS class styles to the field body. You can view
the classes that are available for your User Application portal by
logging into the User Application, navigating to Administration >
Application Configuration > Theme Administration, then clicking
the Preview button for the portal theme you are using.

If you leave the field blank, it defaults to the nv-fontExtraSmall
class.

Example: nv-fontMedium nv-backgroundColor3
Separate class names with spaces.

Apply an HTML style attribute to the field label.
Example: color:red

Apply one or more CSS class styles to the field label. You can view
the classes that are available for your User Application portal by
logging into the User Application, navigating to Administration >
Application Configuration > Theme Administration, then clicking
the Preview button for the portal theme you are using.

If you leave the field blank, it defaults to the nv-formFieldLabel
class.

Example: nv-colorb
Separate class names with spaces.

Allows you to define a set of static values that comprise the check
box labels and values. Click the List property button to launch the
list value dialog box shown here:

Spamcily hary sl vy vkoms For st e It chucos:
+ X
ey [
R R

Yol Yol
B By

TIP: To retrieve user-entered values for this control, use flowdata.getObject() and not
flowdata.get(). If you use flowdata.get(), you get only the first value.

For more information on preselecting values, see the Section 9.2.3, “Form Control Examples,” on

page 326.
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5.5.17 MVEditor

Use this control to allow users to display, edit, or add multiple values in a drop-down list box. You
can load the data dynamically from the Identity Vault, or allow users to enter the values.

The control’s appearance varies depending on the data type of the control and the properties that you
specify. For example, if the data type is a DN, you can set properties that display specific attributes
related to the DN. You can also enable an object selector button that allows users to search and select
values by setting the Entity key for DN expression lookup property.

There are also properties that let you specify a DAL Global Query to execute or specify a root DN to
drive the object picker.

Table 5-21 MVEditor with Object Selector Properties Set Control Buttons

Button Description
Launches a search dialog box called an object
selector. The object selector dialog box looks like
this:

a Object Lookup - Microsoft Internet Explorer.

Object Lookup T & _ 0O

Search object list: [example: 3%, Lar™, ID, 1)

Description 5 search

Select an object from the list:
Description

Acocounting

Executive Management

Human Resources

Improve Customer Sendce task force
Information Technology

Mharketing

Sales

1-Fof 7

The user can select a value from the list to populate
the control. The attribute displayed in the drop-
down list (Description in the above example) is
specified in the directory abstraction layer. You
specify it in the attribute’s UlControl property. See
“Attribute Ul Control Properties” on page 74. The
availability of this button is controlled by the Show
object selector property.
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Button Description

Show history. Allows users to view the history of
objects that they have searched. They can select
from this list or clear its contents. The availability of
this button is controlled by the Show object history
button property.

Reset field. Deletes the field contents. The
availability of this button is controlled by the Show
clear button property.

If you do not set the object lookup properties, the MVEditor displays a simple edit control.

Figure 5-24 Sample MVEditor without Object Lookup Properties Set

MvEditorControl: | Jack Miller v | [*#][=]

Table 5-22 MVEditor Control Buttons

Button Description

Adds an item to the end of the list.
E Deletes the selected list item.
Edits the selected list item.

TIP: When the MVEditor control’s Editable property is set to False, this control is read-only and the
form does not display any MVEditor control buttons.

Table 5-23 MVEditor Control Properties

Property Name Description

Add data entry text field When this option is set to True and there is a single row of
data (and the data is not a DN), the control displays a data
entry text field. The text field is displayed when the field is
empty or contains only one value. Otherwise, the drop-
down list is displayed. If more than one row of data exists,
then the drop-down list always displays.

DAL Global Query Specify this value if you want the control populated by the
results of the Global Query that you specify. You specify
the key name. You can select it from the Event Action
Expression Builder. For more information about using
queries in forms, see Section 5.7, “Using DAL Queries in
Forms,” on page 170. For information about defining
queries, see Section 3.4, “Working with Queries,” on
page 61.
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Property Name

Description

DAL Global Query Parameter(s)

Display expression

Enforce uniqueness

Entity key for DN expression lookup

Field cell style

Specifies the value for the query parameters. For example,
this passes the String Sales to the queries parameter
called groupname.

(function Q{return
{""groupname™:"Sales"}});

Leave this value blank if you want to display the full DN or
CN value.

If you want to mask the DN or CN by displaying attributes
instead, launch the Expression Builder and select the
desired attributes from the list. (You must first specify an
Entity key for DN expression lookup.)

For example, to show the user entity’s first and last name
attributes, construct an expression like this: FirstName
LastName.

Make sure the attribute’s View, Read, Search, and
Required properties are set to True in the directory
abstraction layer. See Section 3.7.2, “Attribute Properties,”
on page 72.

Forces user-entered list items to be unique.

Leave this value blank if you want to display the full DN or
CN value retrieved from the Identity Vault.

If you want to mask the DN or CN by displaying attributes
instead, choose the entity from the drop-down list and
specify a set of attributes in the Display expression

property.
The entity you choose must

* Have the directory abstraction layer View property set
to True.

+ Be the entity whose DN you are retrieving from the
Identity Vault.

See Section 5.6, “Working with Distinguished Names,” on
page 168 for more information.

Apply an HTML style attribute to the field body.

Example: padding-top:5px;background-color:red
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Property Name

Description

Field CSS class name(s)

Label cell style

Label CSS class name(s)

Field width in pixels

Ignore case

Lower bound (for numbers only)

Maximum length

Minimum length

Number of lines displayed

Numbers only

Apply one or more CSS class styles to the field body. You
can view the classes that are available for your User
Application portal by logging into the User Application,
navigating to Administration > Application Configuration >
Theme Administration, then clicking the Preview button for
the portal theme you are using.

If you leave the field blank, it defaults to the nv-
fontExtraSmall class.

Example: nv-fontMedium nv-backgroundColor3
Separate class names with spaces.

Apply an HTML style attribute to the field label.
Example: color:red

Apply one or more CSS class styles to the field label. You
can view the classes that are available for your User
Application portal by logging into the User Application,
navigating to Administration > Application Configuration >
Theme Administration, then clicking the Preview button for
the portal theme you are using.

If you leave the field blank, it defaults to the nv-
formFieldLabel class.

Example: nv-color5
Separate class names with spaces.

Use this field to configure the field’s visible width on the
form. The default is 200 pixels.

If this option is set to True, ignore case when enforcing
unigueness.

Minimum integer or decimal value.

Maximum number of characters for string values. The
control blocks input when this value is reached.

Minimum number of characters for string values. The
control validates that the user enters at least this number
of characters.

The number of lines displayed by the control. This is not
the number of records retrieved or displayed, but the
vertical size of the control. If you set this number to 10 and
there are only 5 records to display, the control size is still
10 lines.

You can set the number of lines to 1 or to 3 or greater. You
cannot set it to 2 because it does not leave enough space
for the browser to display scroll bars. If you set it to 2,
Designer generates a warning in the Project Checker view
and resets it to 3.

If this option is set to True, only numbers can be entered.
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Property Name Description

Object Selector type Determines whether the object selector dialog box
performs an Object Lookup or a Container Lookup. The
following is an example of an Object Lookup:

B Object Lookup - Mozilla

Object Lookup T & _ M0

Search object list: [example: a%, Lar®, 1D, *r)

First Mame | “%Search

paramlist: Causes the object selector dialog box to perform
an object lookup. You specify the lookup criteria via the
Entity key for DN expression lookup property.

container: Causes the object selector to display one or
more containers for selection. The containers for searching
are determined by the Search container property, which is
specified in the directory abstraction layer for the entity
named in the Entity key for DN expression lookup property.
For example, if the Entity key for DN expression lookup
property is Group, the search container is set to %group-
root% by default. If no search container is used, the search
root specified during the User Application installation is
used.

Resolve DN When set to False, the DN is displayed rather than the
Display expression. Consider using this when you expect a
large number of DNs to be returned, and you are
concerned about performance.

Root Container Specify a root container for lookups when users click the
object selector button. If you specify an entity key and a
root container, the entity key takes precedence.

Show object history button When this option is set to True, displays the Object History
button next to the control.
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Property Name Description

Show object selector button When this option is set to True, displays the Object
Selector button next to the control.

Sort entries When this option is set to True, sorts the results in
ascending order. For details, see “Sort Order” on
page 131.

Upper bound (for Numbers only) The maximum numeric value users can enter.

TIP: To retrieve user-entered values for this control, use flowdata.getObject() and not
flowdata.get(). If you use flowdata.get(), you get only the first value.

For more information about preselecting items, see Chapter 9, “Working with ECMA Expressions,”
on page 317.

5.5.18 Password

Use the Password control to allow users to mask all of the user’s entries with the * character.

The password control can only be submitted. It does not support any script such as getValues() or
setValues().

Table 5-24 Password Control Properties

Property Name Description

Field width in pixels Use this field to configure the field’s visible width on
the form. The default is 200 pixels.

Lower bounds (for numbers only) The lowest number allowed for decimal or integer
values.
Maximum length Maximum number of characters for string values.

The control blocks input when this value is reached.

Minimum length Minimum number of characters for string values.
The control validates that the user enters at least
this number of characters.

Number of characters allowed Specifies the number of characters a user is
allowed to enter. This is related to Field width in
pixels.

Upper bound (for numbers only) The highest number allowed for decimal or integer
values.

Validation Mask (regular expression) An expression used for validating the field’s data.

Designer provides a default set of validation masks
by default. You must enable them through Windows
> Preferences > Provisioning > Validation Mask.
For more information, see Section 2.3, “Setting
Provisioning View Preferences,” on page 25.
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5.5.19 PickList

Use the PickList control to allow users to view and choose one or more values from a dynamically
generated list of choices. The list items are DN or CN values retrieved from the Identity Vault. You
can display the full DN or CN or use the PickList properties to specify the attributes to display
instead.

Figure 5-25 Sample PickList Control without DN Masking

PickList without DN Maszking: ch=achung, ou=Users, ou=idimsa ~
ch=asmith,ou=users,ou=idmsal

ch=hhender,ou=uszers,ou=idms

Figure 5-26 Sample PickList Control with DN Masking

PickList with DM Mazking: Angie Chung ~
April Smith
Bill Bender o
Table 5-25 PickList Control Properties
Property Name Description
Allow multiple selections When this option is set to True, the user can select

more than one list value using their platform-
specific multi-select keys.

When this option is set to True, the control displays
a minimum of three lines regardless of the value
specified in the Number of lines displayed property.
If this value is False, the Number of lines displayed
property is used.

Display expression Leave this value blank if you want to display the full
DN or CN value.

If you want to format the DN or CN by displaying
attributes instead, launch the Expression Builder
and select the desired attributes from the list. (You
must first specify an Entity key for DN expression
lookup.)

For example, to show the user entity’s first and last
name attributes, construct an expression like this:
FirstName LastName.

Make sure the attribute’s View, Read, Search, and
Required properties are set to True in the directory
abstraction layer. See Section 3.7.2, “Attribute
Properties,” on page 72.
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Property Name

Description

Entity key for DN expression lookup

Field cell style

Field CSS class name(s)

Field width in pixels

Label cell style

Label CSS class name(s)

Leave this value blank if you want to display the full
DN or CN value retrieved from the Identity Vault.

If you want to mask the DN or CN by displaying
attributes instead, choose the entity from the drop-
down list and specify a set of attributes in the
Display expression property.

The entity you choose must:

+ Have the directory abstraction layer View
property set to True.

+ Be the entity whose DN you are retrieving
from the Identity Vault.

Apply an HTML style attribute to the field body.
Example: padding-top:5px;background-color:red

Apply one or more CSS class styles to the field
body. You can view the classes that are available
for your User Application portal by logging into the
User Application, navigating to Administration >
Application Configuration > Theme Administration,
then clicking the Preview button for the portal
theme you are using.

If you leave the field blank, it defaults to the nv-
fontExtraSmall class.

Example: nv-fontMedium nv-backgroundColor3
Separate class names with spaces.

Use this field to configure the field's visible width on
the form. The default is 200 pixels.

Apply an HTML style attribute to the field label.
Example: color:red

Apply one or more CSS class styles to the field
label. You can view the classes that are available
for your User Application portal by logging into the
User Application, navigating to Administration >
Application Configuration > Theme Administration,
then clicking the Preview button for the portal
theme you are using.

If you leave the field blank, it defaults to the nv-
formFieldLabel class.

Example: nv-colorb

Separate class names with spaces.
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Property Name Description

Number of lines displayed The number of lines displayed by the control. This
is not the number of records retrieved or displayed,
but the vertical size of the control. If you set this
number to 10 and there are only 5 records to
display, the control size is still 10 lines.

The number of lines displayed is related to the
Allow multiple selections setting. When Allow
multiple selections is set to True, the number of
lines displayed is always 3 (or more). When Allow
multiple selections is set to False, you can set the
number of lines to 1 or to 3 or greater. You cannot
set it to 2 because it does not leave enough space
for the browser to display scroll bars. If you set it to
2, Designer generates a warning in the Project
Checker view and resets it to 3.

Show 2 lists When this option is set to True, two lists are
displayed. A list on the left displays the unselected
values, and the list on the right displays the
selected values.

The Allow multiple selections property must be set
to True. If set to false Show 2 lists is ignored.

Sort Entries When this option is set to True, sorts results in
ascending order. For details, see “Sort Order” on
page 131.

TIP: To retrieve user-entered values for this control, use flowdata.getObject() and not
flowdata.get(). If you use flowdata.get(), you get only the first value.

For more information on displaying the control with a preselected option, see Section 9.2.3, “Form
Control Examples,” on page 326.

5.5.20 Static List

Use this control to display a list of items in a drop-down list from which users can select a single
item. The list items are static and are stored with the provisioning request definition. The text “Click
here to select” only appears if the field is not set to Required.

Figure 5-27 Sample Static List Control

String Form Controls Test user is: Admin

StaticlistControl:  Click here to select a value ... i
GlobalListCont rol: Click here to zelect a walue ..
Connechicut

b aine
PickListContral: Mazzachuzetts

Mew Harmpshire
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Table 5-26 Static List Properties

Property Name

Description

Field cell style

Field CSS class name(s)

Field width in pixels

Label cell style

Label CSS class name(s)

Apply an HTML style attribute to the field body.
Example: padding-top:5px;background-color:red

Apply one or more CSS class styles to the field body. You can view
the classes that are available for your User Application portal by
logging into the User Application, navigating to Administration >
Application Configuration > Theme Administration, then clicking
the Preview button for the portal theme you are using.

If you leave the field blank, it defaults to the nv-fontExtraSmall
class.

Example: nv-fontMedium nv-backgroundColor3
Separate class names with spaces.

Use this field to configure the field’s visible width on the form. The
default is 200 pixels.

Apply an HTML style attribute to the field label.
Example: color:red

Apply one or more CSS class styles to the field label. You can view
the classes that are available for your User Application portal by
logging into the User Application, navigating to Administration >
Application Configuration > Theme Administration, then clicking
the Preview button for the portal theme you are using.

If you leave the field blank, it defaults to the nv-formFieldLabel
class.

Example: nv-color5

Separate class names with spaces.
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Property Name

Description

List item

Allows you to define a set of labels and values that comprise the
static list. Click the List property button to launch the list value
dialog box shown here:

i Values for static list 3

Spamcily hary sl vy vkoms For st e It chucos:

Click Add to add list items. Each list item must have a unique key.
The dialog box automatically generates a unique key when you
insert a new list item. You can click the key name and change it. A
blank key (null) is valid, so it is possible to have a list item with a
blank key and a blank label. The displayed label is the one defined
for the default language.

55.21 Text

Use the Text control for data display or user input. User input is validated depending on the control’s

data type.

Figure 5-28 Sample Text Control

TextControl:

Table 5-27 Text Control Properties

Property Name

Description

Field cell style

Apply an HTML style attribute to the field body.

Example: padding-top:5px;background-color:red
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Property Name Description

Field CSS class name(s) Apply one or more CSS class styles to the field body. You can
view the classes that are available for your User Application portal
by logging into the User Application, navigating to Administration >
Application Configuration > Theme Administration, then clicking
the Preview button for the portal theme you are using.

If you leave the field blank, it defaults to the nv-fontExtraSmall
class.

Example: nv-fontMedium nv-backgroundColor3
Separate class names with spaces.

Field width in pixels Use this field to configure the field's visible width on the form. The
default is 200 pixels.

Label cell style Apply an HTML style attribute to the field label.
Example: color:red

Label CSS class name(s) Apply one or more CSS class styles to the field label. You can
view the classes that are available for your User Application portal
by logging into the User Application, navigating to Administration >
Application Configuration > Theme Administration, then clicking
the Preview button for the portal theme you are using.

If you leave the field blank, it defaults to the nv-formFieldLabel
class.

Example: nv-colorb
Separate class names with spaces.
Lower bounds (for numbers only) The lowest number allowed for decimal or integer values.

Maximum length The maximum length for string values. Blocks input when this
length is reached.

Minimum length The minimum length for string values. Validates that the user
enters a string at least this long.

Number of characters allowed Specifies the number of characters a user is allowed to enter. This
is related to Field width in pixels.

Upper bound (for numbers only) The highest number allowed for decimal or integer values.

Validation Mask (regular expression) An expression used for validating the field’s data. Designer
provides a default set of validation masks by default. You must
enable them through Windows > Preferences > Provisioning >
Validation Mask. For more information, see Section 2.3, “Setting
Provisioning View Preferences,” on page 25.

5.5.22 Text Area

Use this control to display or accept input of multi-line data. Users can select multiple lines of data
using the multi-select key combination for their platform.
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Figure 5-29 Sample Text Area Control

TexthreaContral:

Table 5-28 Text Area Control Properties

Property Name

Description

Field cell style

Field CSS class name(s)

Label cell style

Label CSS class name(s)

Number of columns displayed

Number of lines displayed

Apply an HTML style attribute to the field body.
Example: padding-top:5px;background-color:red

Apply one or more CSS class styles to the field
body. You can view the classes that are available
for your User Application portal by logging into the
User Application, navigating to Administration >
Application Configuration > Theme Administration,
then clicking the Preview button for the portal
theme you are using.

If you leave the field blank, it defaults to the nv-
fontExtraSmall class.

Example: nv-fontMedium nv-backgroundColor3
Separate class names with spaces.

Apply an HTML style attribute to the field label.
Example: color:red

Apply one or more CSS class styles to the field
label. You can view the classes that are available
for your User Application portal by logging into the
User Application, navigating to Administration >
Application Configuration > Theme Administration,
then clicking the Preview button for the portal
theme you are using.

If you leave the field blank, it defaults to the nv-
formFieldLabel class.

Example: nv-color5
Separate class names with spaces.

The visible width of the control; the number of
characters wide.

The number of lines to display at one time.

5.5.23 Title

Use this read-only control to label your form or provide instructions.
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Table 5-29 Title Control Properties

Property Name Description

Display title in signed ~ When this option is set to False and the form is a signed form (using digital

form document signatures), the title control is not displayed.
Font-size Specify small, medium, or large.
Style class Choose a font style (such as bold) and colors from a palette.

5.5.24 TrueFalseCheckBox

Use this control to allow the user to select or deselect a choice. The values returned by the control
are true (selected) and false (not selected). The returned values are always strings.

NOTE: This control returns a boolean value of True or False depending on the selection made by
the user. The display values of the control can be set to a more user friendly or informative value
such as Yes/No or Accept/Reject depending on the intended use of the form; however, the
underlying value always returns either True or False. If the control is used to return anything other
than True or False or more than two values, for example (Yes/No/Maybe), by default it returns the
value as False if it is not True.

You can initialize the control from a JavaScript Boolean Object. The field.getValue() returns a
JavaScript Boolean Object.

Use setvalues(['"true"]) not setvalues[true]), the setvalues() method expects a string or
an array of string values.

Table 5-30 TrueFalseCheckBox Control Properties

Property Name Description

Field cell style Apply an HTML style attribute to the field body.
Example: padding-top:5px;background-color:red

Field CSS class Apply one or more CSS class styles to the field body. You can view the classes

name(s) that are available for your User Application portal by logging into the User
Application, navigating to Administration > Application Configuration > Theme
Administration, then clicking the Preview button for the portal theme you are
using.

If you leave the field blank, it defaults to the nv-fontExtraSmall class.
Example: nv-fontMedium nv-backgroundColor3
Separate class names with spaces.

Field width in pixels Use this field to configure the field’s visible width on the form. The default is 200
pixels.

Label cell style Apply an HTML style attribute to the field label.

Example: color:red
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Property Name Description

Label CSS class Apply one or more CSS class styles to the field label. You can view the classes

name(s) that are available for your User Application portal by logging into the User
Application, navigating to Administration > Application Configuration > Theme
Administration, then clicking the Preview button for the portal theme you are
using.

If you leave the field blank, it defaults to the nv-formFieldLabel class.
Example: nv-color5

Separate class names with spaces.

5.5.25 TrueFalseRadioButtons

Use this control to display a choice of True or False as a set of radio buttons.

Figure 5-30 Sample TrueFalseRadioButtons Control

TrueF alzeRadiobuttons: 'f:"' Falze @ True

This control has no custom properties.

NOTE: This control returns a Boolean value of True or False depending on the selection made by
the user. The display values of the control can be set to a more user friendly or informative value
such as Yes/No or Accept/Reject depending on the intended use of the form; however, the
underlying value always returns either True or False. If the control is used to return anything other
than True or False or more than two values, for example (Yes/No/Maybe), by default it returns the
value as False if it is not True.

5.5.26 TrueFalseSelectBox

Use this control to display a choice of True or False in a drop-down list.

Figure 5-31 Sample TrueFalseSelectBox Control

TrueFalzeSelectbox:

NOTE: This control returns a Boolean value of True or False depending on the selection made by
the user. The display values of the control can be set to a more user friendly or informative value
such as Yes/No or Accept/Reject depending on the intended use of the form; however, the
underlying value always returns either True or False. If the control is used to return anything other
than True or False or more than two values, for example (Yes/No/Maybe), by default it returns the
value as False if it is not True.
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Table 5-31 TrueFalsSelectBox Properties

Property Name Description

Field width in pixels Use this field to configure the field’s visible width on
the form. The default is 200 pixels.

5.6 Working with Distinguished Names
The following controls provide specialized support for distinguished names (DNs):

+ DNDisplay
+ DNLookup
+ DNMaker

+ MVEditor

+ PickList

This section describes the specialized support, including the following:

+ Section 5.6.1, “Formatting DNs,” on page 168
+ Section 5.6.2, “Working with Object Selectors,” on page 168

5.6.1 Formatting DNs

If you have a DN value, you can display either the DN or a set of attributes related to that DN. For
example, if the control displays the DN of a user entity, you could display the user entity's First
Name and Last Name attributes instead. The controls that support this feature are DNDisplay,
DNLookup, MVEditor, and Picklist.

You define the attributes to display in the control’s Display Expression property. This display
expression resolves at runtime by replacing the attribute keys with the attribute values.

5.6.2 Working with Object Selectors

In some cases, you might want the user to search for and select a DN from a list of possible values.
The object selector dialog box (also called the object lookup dialog box) provides this functionality.
The contents of the object selector dialog box are controlled by the form control’s properties (see
Table 5-32), and by how DAL properties are defined (see “DNLookup Control Type Definitions and
Object Selector Contents” on page 169).

The object selector only supports attributes of String or DNLookup data types whose directory
abstraction layer access properties for required and searchable are set to true.

Table 5-32 Properties for Defining the Object Selector Dialog Box

Property Description

Entity key for DN expression lookup This is the key to the directory abstraction layer entity whose
DN you want to search for or display. This is a required field.
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Property

Description

Object selector type

Show object selector button

paramlist: Causes the object selector dialog box to perform an
object lookup. You specify the lookup criteria via the Entity key
for DN expression lookup property.

container: Causes the object selector dialog box to display
one or more containers for selection. The containers for
searching are determined by the Search container property
that is specified in the directory abstraction layer for the entity
named in the Entity key for DN expression lookup property.
For example, if the Entity key for DN expression lookup
property is Group, the search container is set to %group-
root% by default. If no entity is specified you will get an error
message about missing or bad Container Selector properties

If this option is set to True, the object selector button shows up
on the control. Otherwise, it does not.

DNLookup Control Type Definitions and Object Selector Contents

When you specify an Entity key for DN expession lookup, the object selector’s contents are defined

by the attribute’s DNLookup control type definition (in the directory abstraction layer). For

example, if you specified the User entity as the object lookup and the manager as the attribute, the
object selector would allow the user to search on the First Name and Last Name attributes because

the object selector uses the manager’s DNLookup control type definition to determine the lookup
criteria. The DNLookup definition for the manager entity is shown in Figure 5-32.

Figure 5-32 Manager Attribute on User DNLookup Property Definition

+ UI Control

Specify any Formatting or special controls used in displaving the attribute:

Data Type: DM
Format Type: | =Mone >

Control Type: | DMLookup

+ DMLookup Display

Select the Entity and Attributes to display for the Lookup operation:

Lookup Entity:

Lookup aktributes

First Mane

|:| Perform Automatic Query

ap | |Last Mame

Manager Lookup A

¥ %

The resulting object selector is shown in Figure 5-33.
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Figure 5-33 Sample Object Selector

[ Object Lookup - Mozilla

Object Lookup ?7 4 _ O

Search object list: [example: 3%, Lar®, |0, *r)

- Learch

Lazt Mame

You can change the attributes that are used by the object selector by changing the Lookup attributes.
To allow other attributes in the object selector:

1 Determine if the desired attribute is defined for the entity specified as the Lookup Entity. (In
this example, it is Manager Lookup.)

2 If the attribute you want is available on the lookup entity, you can just add it to the Lookup
Attributes. Make sure that it has the Search and Read properties set to True; otherwise, they
won’t appear in the object selector dialog box.

3 If the attribute does not already exist for the Lookup Entity, you must do the following:

+ Add the attribute to the Lookup Entity. For example, to display another attribute in a
manager lookup like the one above, add the attribute to the Manager Lookup entity. For
more information, see Section 3.2.3, “Adding Attributes,” on page 55.

+ Add the attribute to the DNLookup definition.

+ Deploy the changed definitions. In this example, you’d redeploy the Manager Lookup
entity (if you added a new attribute to its definition) and the User entity because you
changed the definition of the manager attribute.

+ Refresh the application server’s DirectoryAbstractionLayerDefinitions cache.

5.7 Using DAL Queries in Forms

The Query objects defined in the directory abstraction layer let you predefine LDAP searches that
you can then execute from a workflow form. The information in this section illustrates how you can
define a query and use it in a form.

Suppose that you want to distribute calling cards to certain employees, but you only want to
distribute calling cards to employees who work at home, and whose homes are located outside of the
local office’s area code. You create a workflow form that allows the employee to:

+ Verify that they qualify to receive a card.
+ Submit a request for a card if they do qualify.
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On your form, you allow users to enter the area code of their own local office (and based on that area
code) review a list of users that qualify for a card. The runtime form is shown in Figure 5-34.

Figure 5-34 Sample Calling Card Request Form

% Resource Request - Mozilla Firefox

Welcome Bill
My Wiork
Ny Tasks
* Request Resource

iy Requests

My Settings

Enter Proxy Mode
Edit dvailability

My Proxy Assignments

iy Delegate Assignments

Fle Edt bWew Go Bookmarks Tools Help

G@-p - & ) BY [V rttpufocahoste0s0fbmicresteAmRessurceRequest.do v @ G, |

Novelle Identity Manager

Friday, January
Identity Self-Service Requests & Approvals Logout Help
Request Resource
Step 3 of 3: Confirm and complete resource request,

* - indicates required.

Resource: CallingCard
Recipient: Bill Brown
Resource Search Criterda: Accounts
Description: CallingCard

Farm Detall

Get A Calling Card for Calls Outside Your Local Office Area Code
OfficeAreaCode: [212 |

The Calling Card is for Work At Home Employees Who Live Outside the Area Code of the Local Office
) Alison Elake (555) 5551222 -~
Candidates: Aingie Chung (555 5551202 2
Anthony Palani (555 5551202 v/

If you do not see your name in the above list you do not qualify for the calling card, please press Cancel.

Done

The data in the Candidates Picklist control is populated from the results of a query that is defined as
shown in Figure 5-35.
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Figure 5-35 Calling Card Queries Definition

@ Employees Qutside Local Area Code ®

General
Provide a user-friendly label For the query:
Ky | EECutsidelocalireaCode |

Display Label: | Employvees Outside Local Area Code | ﬁ?

Query Entity: |User ~ |

~ Parameters
Define parameter references;

+ ¢ & B
Parameter Keys Parameter Display Labels
| Area_odeParam | | Area Code | ¥

+ Query Conditions
Provide conditions For the query entity selected above:

(4P add Candition Grouping

[% Remove Condition Grouping o

|Telephane Mumber V| |n0t starts with W | FehreaCodeParams | E b4

« Search
Provide search constraints For the query:

Search Root: | Ol=idmsample-alh, o=novell | @

Search Scope: | <Default= w |

Max Search Entries: |D R | (0=use runtime setking)

The query takes a single input parameter, AreaCodeParam, for the user-entered area code. The
query then searches the User entity (in the idmsample-alh container) and returns the users whose
telephone numbers do not start with the same value entered in the AreaCodeParam.

The form has an input field called OfficeAreaCode. It is the text field where the user enters the area
code of the local office. The properties for OfficeAreaCode are show in Figure 5-36.

172 User Application: Design Guide




Figure 5-36 OfficeAreaCode Properties

Form Controls
+ X 4 ¥
Form Field Name Data Type Control Type
title string Title
iOfficedreaCode | string Text
title2 string Title
Candidates dn PickList
title3 string Title

Outline | = Properties 23

Property

Fields .~ Actions | Scripts

Display Label

Editable

Required

Wisible

Multivalued

Events

Field width in pixels

lower bound (For Numbers only)
Maximum length

Minimum length

Mumber of characters allowed
Tooltip

Upper bound (for Numbers only)
Walidation Mask{regular expression)

Linebreaks

—— -

Yalue
OfficeAreaCode
true
false
true
false
onchange
200

3
3
40

Notice that the Text control defines an onchange event. The onchange event fires when the user tabs
from the Text control. The onchange event fires the getCandidates custom event as shown in Figure

5-37.

Figure 5-37 OnChange Event Properties

B4 Field Events _|
Specify event name and action expression values For field: OfficeAreaCode
4+ €
Event Mame Action Expression
onchange field.fireEvent{"getCandidates")
@ I oK l [ Cancel

The getCandidates event is defined as a property on the Candidates Picklist control.
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Figure 5-38 Candidates PickList Properties

Form Controls

+ X ¢ ¥

Form Field Name Data Type Control Type Linebreaks

title string Title 1

OfficeireaCode string Text 1

title2 string Title 1

e I [ S —
title3 string Title 1

Outline | = Properties 22

Property
Display Label
Editable
Required
visible
Multivalued
Entity key for DN expression lookup
Events
Display expression
Allow multiple selections (trueffalse)
Field width in pixels
Number of lines displayed
Sort entries
Tooltip

Fields .~ Actions | Scripts

Value
Candidates
true
false
true
true
User
getCandidates
FirstName Lastiame TelephoneMumber
false
200
3
true

When the event is fired, the getCandidates event performs an action expression that calls the
globalQuery() method (as shown in Figure 5-39). This method populates the value of the
Candidates PickList control with the results of the query called EEOutsideLocalAreaCode (defined
in Figure 5-35 on page 172). It passes the value of the OfficeAreaCode text field as the query’s input

parameter AreaCodeParam.

Figure 5-39 GetCandidates Event

Specify event name and action expression values for field: Candidates

B4 Field Events X

4 K
Event Name Action Expression
getCandidates IDYaulk. globalQuery"Candidates”, "EEOutsideLocalareaCode”, {AreaCodeParam:form.getValue "OfficeareaCade")});

@
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5.8 Printing Forms

You can add a Print button to a request form by using JavaScript.

TIP: Approval forms automatically contain a Print button.

To add the ability to print a request form, add the URL to the JavaScript library PrintForm_js. The
library is located in the User Application WAR at this URL: ./javascript/JUICE/form/
PrintForm_js. Two techniques for including a print button are described below:

+ To display a print preview popup when submitting a request form (after data is validated), add
the following to the form onload event:

form. interceptAction("'SubmitAction™, "around",
function (invocation)

{var pf = new PrintForm(*'SubmitAction™);
pf.printFormlnterceptor(invocation);

});
+ To add a Print button next to one of the fields on your form, add the following script to the
field’s onload event:

var ctrl = JUICE.UICtriUtil.getControl(field.getName());

var btn = JUICE.UICtriUtil._addButton(ctrl, "printid”, "Print", "Print",
"javascript:var p = new PrintFormQ);
p-printFormAfterValidation(\"printid\");");

5.9 Providing Direct Access to a Form

If you want users to be able to go directly to a form, you need to make some changes within the
WAR file for the User Application and redeploy the WAR file.

1 Inthe WEB-INF/struts-config.xml file, specify roles=""authUser" within the following
action statement:

<action path="/getAFResourceList" scope="request" name="apwaListForm"
type=""com.novell._.srvprv.apwa.actions.GetResourcelList" roles="authUser">

2 Also in the WEB- INF/struts-config.xml file, specify roles=""guest, authUser within
the following action statement:

<action path="/createAFResourceRequest' scope="request’” name=""apwaDetail"
type="com.novell.srvprv.apwa.actions.ProcessResourceRequest"
roles=""guest,authUser'>

3 Also in the WEB- INF/struts-config.xml file, add the following action mapping:

<action path="/getGuestResourceList” scope="request' name="apwalListForm"
type="com.novell.srvprv.apwa.actions.GetResourceList" roles="guest'>
<forward name="success'" path="tiles.guestResourcelList"/>
<forward name="displaySelector" path="tiles.guestSelector"/>
</action>

4 In the WEB-INF/tiles-defs.xml file, add the following definitions:
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<definition name="tiles.guestSelector”™ extends="_unauthenticatedLayout'>
<put name="title" value="JSP_TITLE_SELECTOR"/>
<put name="body" value="/jsps/tiles/selector.jsp'"/>
</definition>
<definition name="tiles.guestResourcelList"
extends=""_unauthenticatedLayout">
<put name="title" value="JSP_TITLE_RESOURCE_LIST"/>
<put name="body" value="/jsps/tiles/resourcelList.jsp"/>
</definition>

5 Redeploy the WAR file.
The URL for accessing a form directly must use this format:

http://1ocalhost:8080/1DMProv/

getAFResourcelList.do?apwaLeftNavIltem=JSP_MENU_RESOURCE_REQUEST_ CLASSIC&wfdn=P
RDEFDN

The parameter PRDEFDN must be replaced with the DN of the request definition. Here’s a complete
example that includes this parameter:

http://1ocalhost:8080/1DMProv/
getAFResourcelList.do?apwalLeftNavItem=JSP_MENU_RESOURCE_REQUEST_CLASSIC&wfdn=c
n=TestPRDEF,cn=RequestDefs,cn=AppConfig,cn=Test-
Antelope,cn=TestDrivers,o=novell
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Creating the Workflow for a
Provisioning Request Definition

This section provides details on creating the workflow for a provisioning request definition. Topics
include:

*

*

*

*

Section 6.1, “About the Workflow Tab,” on page 177

Section 6.2, “Adding Activities to a Workflow,” on page 182

Section 6.3, “Adding Flow Paths,” on page 186

Section 6.4, “Configuring Flow Paths,” on page 187

Section 6.5, “Guidelines for Creating Workflows,” on page 189

Section 6.6, “Guidelines for Creating Roles Based Workflows,” on page 197
Section 6.7, “Guidelines for Creating Resource Based Workflows,” on page 207
Section 6.8, “Debugging a Workflow,” on page 213

Section 6.9, “Provisioning Multiple Individuals with One Workflow Instance,” on page 213
Section 6.10, “Making Distinguished Name References Portable,” on page 216
Section 6.11, “Configuring Digital Signature Support,” on page 216

6.1 About the Workflow Tab

You use the Workflow tab to display the Workflow page. You use the Workflow page to define the
behavior of the workflow for the provisioning request definition. The Workflow page consists of a
canvas, a palette, and associated views.
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Figure 6-1 Workflow Page
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6.1.1 Canvas

The canvas provides a graphical view of the activities in the workflow. When you create a new
provisioning request definition that is not based on a template, the canvas is blank except for a Start
activity and Finish activity.

If you right-click anywhere on the canvas, a menu is displayed. The menu includes the following
commands:

Table 6-1 Workflow Menu

Iltem Description
Delete Deletes the selected activity or flow path.
Show Activity Ids Switches the workflow editor between displaying activity names

and Activity Ids.

Use the Activity Id property to specify a meaningful value for the
Activity Id. By default, the value is ActivityNN where NN is a
unique number (associated with the order in which the activity was
added to the palette). When errors associated with activities are
detected during validation, Designer identifies the activity in which
the error occurred by activity ID. When this is the case, turn on the
display of activity IDs in order to locate the activity on the canvas.

You can specify whether activity names or activity lds are
displayed by default by choosing Window > Preferences >
Provisioning > Workflows > Diagram Preferences > Show Activity
Ids.
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Iltem Description

Show Flow Path Types Turns the display of flow path types (for example, forward,
approved, denied) on and off. When Show Flow Path Types is
turned on, a label is displayed on each flow path indicating the
flow path type.

Show Properties Displays the Properties view for the selected activity. If no activity
is selected, it displays the Properties view for the Workflow itself.

Show Data Item Mapping Displays the Data Item Mapping view for the selected activity.

Show E-Mail Notification Displays the E-Mail Notification view for the selected activity.

You can use the Zoom and Scale sliders on the toolbar to make it easier to view the workflow:

+ Zoom: Increases or decreases the magnification of the workflow display. You can make
portions of the workflow display larger and view more detail, or make the workflow display
smaller and view more of the workflow. Click the rectangle to the right of the Zoom slider to
return to 100% magnification.

+ Scale: Increases or decreases the spacing between items in the workflow display. For example,
if your workflow has items with many flowpaths between them, you can increase the scale to
make it easier to see individual flow paths. Click the rectangle to the right of the Scale slider to
return to 100% scale.

6.1.2 Palette

The palette provides icons for activities that can be dragged onto the canvas to create the workflow.
It also provides tools for manipulating the icons and for linking activities:

Creating the Workflow for a Provisioning Request Definition 179



Figure 6-2 Workflow Palette
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The palette includes the following tools:

Table 6-2 Workflow Palette

Tool

Description

Select

Marquee

Flow Path

Activities (for example,
Start, Approval, Log)

Selects individual nodes or flow paths. To select a node, click the Select
tool, then click a node.

Selects multiple nodes or flow paths. Use this tool to move items as a
group. To select multiple items, click the Marquee tool, then click in an area
outside of the items that you want to select. Hold down the mouse button
and drag over the items that you want to select, then release the mouse
button.

When multiple items are selected, only the properties for the first item
selected are displayed in the Properties view (see Section 6.1.3, “Views,”
on page 181 for information about Views).

Creates flow paths between nodes. Flow paths provide connection logic for
connecting nodes. For information about connecting nodes, see
Section 6.3, “Adding Flow Paths,” on page 186.

Inserts the selected activity into the workflow. For information about adding
activities, see Section 6.2, “Adding Activities to a Workflow,” on page 182.

For detailed descriptions of the activities, see Chapter 7, “Workflow Activity
Reference,” on page 219.
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6.1.3 Views

The Workflow page also includes the Properties, Data Item Mapping, and E-Mail Notification
views:

Figure 6-3 Workflow Views
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You can right-click the icon for an activity to select a view from a context menu. Not all activities
utilize all views. The following table identifies the views and the activities that use them:

Table 6-3 Views for Activities

Activity Properties E-Mail Notification Data Item Mapping
Start X X
Approval X X X
Log X

Branch X

Merge X

Condition X

Mapping X X
Workflow Status X X
E-Mail X X

Role Binding X

Resource Request X

Role Request X

Start Workflow X X
Finish X X

Integration X X
Entitlement X X
Entity X X
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6.2 Adding Activities to a Workflow

1 Click the Workflow tab. A graphical representation of the workflow for the provisioning request
definition is displayed:

P EE

|

¥ Finish

Because every workflow must have a Start activity and Finish activity, these activities are
added to the canvas automatically. The Start Activity is connected to the Finish Activity with a
forward link.

2 To add an activity to the workflow, click the icon for the desired activity in the palette and drag
the icon onto the workspace.

You can insert an activity between activities that are linked by a flow path by dropping the
activity onto the flow path. For information about defining flow paths between activities, see
Section 6.3, “Adding Flow Paths,” on page 186. After you have added an activity to the
workflow, you should set the properties of the activity (see Section 6.2.1, “Setting the General
Properties of an Activity,” on page 182). For detailed information about configuring the
different types of activities, see Chapter 7, “Workflow Activity Reference,” on page 219 and
Chapter 8, “Working with Integration Activities,” on page 269.

6.2.1 Setting the General Properties of an Activity
1 Right-click the activity icon for which you want to set properties and select Show Properties
from the menu.
You can also display the Properties tab by selecting Show Properties from the PRD menu.

o —

of cut
=|Copy

N 3¢ Delete
Select Al
v Show Activity Ids
»  Show Flow Path Types
& approval_t

Lorararad 3 -
§ianed Show Properties
Show Data Item Mapping

/ Edit Activity Id...
= \nf]dppmva\j
7
-

The Properties view is displayed:

2 Click in the column for a property to set the property. For information about the properties for
each activity, see Chapter 7, “Workflow Activity Reference,” on page 219.

Each activity has a default name. We strongly recommend that you replace the default names of
activities with a descriptive Activity Id that describe the specific purpose of the activity in the
workflow. This makes it easier to understand the workflow when you look at the graphical
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display of the workflow. It also makes comments displayed in the User Application easier to
understand. For example, the following figures show comments in the User Application using
default IDs and descriptive IDs.

Figure 6-4 Activities in User Comments Using Default Names
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Figure 6-5 Activities in User Comments Using Descriptive Names
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To change the Activity Id:

1 Right-click the activity icon for which you want to change the Activity Id and select Edit

Activity 1d.

of Cut

[:Z/Copy

¥ Delete
Select All
v Show Activity Ids
v Show Flow Path Types

Show Properties
Show Data Item Mapping

The Edit Activity Id wizard displays.
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@ Edit Activity Id

Enter a value to be used for the activity id. The Activity Id must be unique and must be a valid Java identifier.

Activity Id: | approval_B

@ Badh Mext E Cancel

2 Type the Activity Id name you want to use. The name can include letters, numbers, and the
underscore (_) character.

3 If the activity was not used to define any expressions, click Finish. If the activity was used in
expressions, click Next. The wizard displays the expressions where the Activity Id should be
updated with the new name.

@ Edit Activity Id

The various expressions which will be updated is listed below

Update  Updated Expressions
%] New_Mame.getName(locale)
M 1Dvault.get{New_Name.getAddressee(), 'user', ‘Firsthame')
V]  1DVault.get(New_Name,getAddressee(),'user', manager’)
& 'Log New_MName'
W (approval_A.getaction()).equals(DENIED") || (New_Name.getAction()).equals("DENIED")
W  (approval_A.getAction()).equals(DENIED") || (New_Name.getAction()).equals("DENIED")

Finish ][ Cancel ]

4 Review the items displayed in the panel. For items that you do not want updated, deselect the
checkbox in the Update column.

5 Click Finish when complete.
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6.2.2 Defining the Data Item Mappings

You use the Data Item Mapping view to map data from the data flow into fields in a form (pre-
activity mapping) and to map data from the form back to the data flow (post-activity mapping).

1 Right-click the activity icon for which you want to set data item mappings and select Show
Data Item Mapping from the menu.

You can also display the Data Item Mappings tab by selecting Show Data Item Mapping from
the PRD menu.

The Data Item Mapping view is displayed:

| Overview |workFlaw Forms| |
Properties Email Motification | Data Flow | Provisioning View | Paolicy Set | Project Checker | =0
& pre Ackivity " Post Ackiviby
Source Expression | Target Form Field | Data Type
approval . gethameilocales) Litle skring
subheading string
inikiator inikiator skring
recipient recipient skring
process,getTimestampi ) initiakedTime date
flowdata, get{'reason’y reason skring
apwaCormment skring
< | b

2 For pre-activity mapping, click in the Source Expression field for the item that you want to
map, then specify an expression. For post-activity mapping, click in the Target Expression field
for the item that you want to map, then specify an expression.

Pre-activity maps can be used for
+ Initializing form control values.
+ Setting default values for form controls.
+ Populating complex form controls with data lists derived from LDAP queries.

+ Passing data from form controls of a previous activity to a form control in the current
activity.

+ Calling external Java classes to process data.
Post-activity maps can be used for

+ Creating new data items in flowdata.

+ Moving form control data from an activity into flowdata.

+ Calling external Java classes to process data.

For detailed information about data item mapping for the different types of activities, see
Chapter 7, “Workflow Activity Reference,” on page 219.

The Start Activity can have hard-coded strings, system variables like process locale and
recipient, and Identity Vault expressions (created using the ECMA Expression Builder VDX
Expr Panel) in pre-activity maps.

Leave the Source Expression blank in pre-activity maps for form fields that the user is expected
to fill in. Alternatively, create a source expression to supply a default value for form fields that
the user is expected to fill in. In either case the form field needs to be defined as editable. See
Section 5.5.4, “General Form Control Properties,” on page 131 for information about setting
the properties of form fields.
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6.2.3 Defining the E-Mail Notification Settings

You use the E-Mail Notification view to select an e-mail template, and to specify expressions to
provide values for named parameters included in the e-mail template. E-mails are sent when a new
Approval activity starts (to notify approvers that they have work to do) and when the Finish activity
completes (to notify the initiator that the workflow is done).

1 Right-click the activity icon for which you want to set properties and select Show E-Mail
Notification from the menu.

You can also display the E-Mail Notification tab by selecting Show E-Mail Notification from
the PRD menu.

The E-Mail Naotification view is displayed:

o |
| Overyiew lWorkFIow Forms | Signature Declarations| |
Properties|Data Item Mapping nail Motificatio =0
Email Template Icn=Provisioning Approval Completed Motification, cn=D0efault Motification Collection, cn=security j
Source | Targek
process. getMame!) Signature Declarations requestTitle
process,getRequestId) requestId
process, getTimestarmp(,taString() requestSubmissionTime
process,getApprovalStatus) requestStatus
IDVault, getdinitiator, ‘user’, ‘FirstMame"y + ' + IDVault, getlinitiakor, 'user’, LastMame") initiatorFullMarne
IDVault, getirecipient, ‘user’, ‘FirstMama" + ' ' + IDVault, get{recipient, 'user’, 'LastMame") recipientFullMarne
d | >

2 Click the E-Mail Template field, then select an e-mail template from the list of defined
templates.

Editing an e-mail template: You can edit an e-mail template in Designer. To do this, select an
Identity Vault in the Modeler, then scroll to Default Notification Collection in the Outline View.
Right-click a template, then select Edit Template.

Localized e-mail templates: By default, Designer displays the default e-mail notification
templates. When you select a default template, the e-mail is in the user’s default language (if
the default is a supported language). You can set the Show all localized e-mail templates
preference to True so that Designer also allows you to select from the list of localized e-mail
templates. The localized templates have the same name as the default, but the Java language
code is appended to the name of the e-mail template. For example, cn=Provisioning
Notification Activity_es, cn=Default Notification Collection, cn=security indicates this is the
Spanish language version of this template. When you select a localized template, the e-mail is
in the language of the template regardless of the user’s default language.

3 Click in the Source field for a Target token and specify an ECMAScript expression that assigns
a value to the token.

See Chapter 7, “Workflow Activity Reference,” on page 219 for information about e-mail
notification settings.

6.3 Adding Flow Paths

1 Click the Flow Path tool in the palette:
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2 Click the activity from which you want the flow path to begin, then click the activity on which
you want the flow path to end:

™ start ﬁiﬁ

& Approval
¥& Finish

The activities are connected.

3 To configure the flow path, click the Select tool in the palette, right-click the flow path, then
select Show Properties.

For information about configuring flow paths, see Section 6.4, “Configuring Flow Paths,” on
page 187.
6.4 Configuring Flow Paths

After you have added a flow path to a workflow diagram, you can specify the path type. For details
on adding flow paths to a workflow, see Section 6.3, “Adding Flow Paths,” on page 186.

To configure a flow path:

1 Click the flow path in the workflow diagram.
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The flow path types are described in the following table:

Flow Type

Description

forward

approved

denied

refused

timedout

error

true

false

Forwards control to the next activity in a workflow.
The forward flow path is available after all activities except:
+ Approval
+ Condition
+ Finish
Determines what happens when a user approves a request.
The approved flow path is valid only after the Approval activity.
Determines what happens when a user denies a request.
The denied flow path is valid only after the Approval activity.
Determines what happens when a user refuses a request.
The refused flow path is valid only after the Approval activity.

Determines what happens when an Approval activity times out because
the user did not respond.

The timedout flow path is valid only after the Approval activity.

Determines what happens when an Approval or Condition activity
terminates with an error.

The error flow path is valid only after the Approval and Condition
activities.

Determines what happens when a conditional expression evaluates to
True.

The True flow path is valid only after the Condition activity.

Determines what happens when a conditional expression evaluates to
False.

The False flow path is valid only after the Condition activity.

If the Properties tab is not displayed, right-click the flow path in the workflow diagram and select

Show Properties.

6.5 Guidelines for Creating Workflows

To create well-formed workflows, you need to understand the rules for adding activities and flow
paths. In addition, you need to understand how to manipulate workflow data. See the following

topics:

+ Section 6.5.1, “Rules for Activities,” on page 190

+ Section 6.5.2, “Rules for Flow Paths,” on page 190

+ Section 6.5.3, “Understanding Workflow Data,” on page 193

Creating the Workflow for a Provisioning Request Definition

189



NOTE: You can validate a provisioning request definition before you deploy it. For more
information, see Section 2.6, “Validating Provisioning Objects,” on page 26.

6.5.1 Rules for Activities

When adding activities to a workflow, follow these rules:

+ A workflow must have only one Start activity and one Finish activity.

+ A workflow can have zero or more of the following activity types:

Approval activity
Log activity

Branch activity
Merge activity
Condition activity
Mapping activity
Workflow Status
E-Mail activity

Role Request activity
Role Request Binding activity
Start Workflow
Integration
Entitlement

Entity

Each Branch activity must have a corresponding Merge activity.

The role activities (Role Request and Role Request Binding) can only be used for workflows
that support roles.

The resource activities (Resource Request and Resource Request Binding) can only be used for
workflows that support resources.

To ensure that the provisioning step is performed, a workflow must have at least one
Entitlement activity or Entity activity.

6.5.2 Rules for Flow Paths

When adding flow paths to a workflow, follow these rules:

*

With the exception of the Start activity, all activities can have one or more incoming flow paths.
The Start activity cannot have any incoming flow paths.

The Finish activity cannot have any outgoing flow paths.
There can be only one flow path out of the Start activity. The flow path type must be forward.

There can be between one and five flow paths out of the Approval activity. The valid flow path
types are approved, denied, refused, timedout, and error. At runtime, only one of the flow paths
is executed.

There can be only one flow path out of the Entitlement, Entity, Log, and Merge activities. The
flow path type must be forward.
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+ There can be two or three flow paths out of the Condition activity. The valid flow path types are
true, false, and error. The true and false flow paths are required; the error flow path is optional.

+ There can be one or more flow paths out of the Branch activity. The flow path type must be
forward for each path. At runtime, all of the flow paths execute.

+ Flows paths out of Role Binding activities must connect to the Finish activity.

The following table summarizes the rules for adding flow paths into and out of an activity:

Table 6-4 Number of Flow Paths Permitted for Each Activity

Activity Inbound Paths  Outbound Paths

Start 0 1 Must always be forward.

Approval lton 1 to 5 Approved, denied, refused, timedout, or error
Log lton 1 Must always be forward

Branch lton lton

Merge lton 1 Must always be forward

Condition lton 2 to 3 True and false are required; error is optional
Mapping lton 1

Workflow Status lton 1 Must always be forward

E-Mail lton 1 Must always be forward

Role Request Binding 1 1 Must always be forward and connect to Finish activity
Role Request 1 2 forward, error

Resource Request 1 1 Must always be forward and connect to Finish activity
Binding

Resource Binding 1 2 forward, error

Start Workflow 1 2 forward, error

Finish lton 0

Integration lton 1 to 4 Success, timedout, error, fault

Entitlement lton 1 Must always be forward

Entity lton 1 Must always be forward

The following table summarizes which activity types can be a source or target for each of the
available flow path types:

Table 6-5 Flow Path Types Allowed for Each Activity

Activity Forward Approved Denied Refused Iltmedo True False Error Success Fault

Start Source
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Timedo

Activity Forward Approved Denied Refused ut True False Error Success Fault
Approval Target Source/ Source Source/ Source/ Target Target Source
Target /Target Target Target [Target
Log Source/ Target Target Target Target Target Target Target
Target
Branch  Source/ Target Target Target Target Target Target Target
Target
Merge Source/ Target Target Target Target Target Target Target
Target
Conditio Target Target Target Target Target Sourc Source/ Source
n e/ Target /Target
Target
Mapping Source Target Target Target Target Target Target Target
Workflow Source/
Status Target
E-Malil Source/
Target
Role Source/ Target Target Target Target Target
Request Target
Binding
Role Source/ Target Target Target Target Source
Request Target [Target
Resourc Source/ Target Target Target Target Target
e Target
Request
Binding
Resouce Source/ Target Target Target Target Source
Request Target [Target
Start Source/ Target Target Target Target Source
Workflow Target [Target
Finish Target  Target Target Target Target Target Target Target
Integratio Source/ Source/ Source Source Source
n Target Target [Target
Entitteme Source/ Target Target Target Target Target Target Target
nt Target
Entity Source/ Target Target Target Target Target Target Target
Target
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6.5.3 Understanding Workflow Data

When you’re creating a workflow, you can manipulate workflow data to suit the needs of your
provisioning application.

+ “Data Objects and Variables” on page 193

+ “Creating New Data Items” on page 195

+ “Modifying Data Items” on page 195

+ “Working with Complex Data Item Mappings” on page 195

+ “Moving Form Control Data to Flowdata” on page 196

+ “Moving Flowdata to Form Controls” on page 196

+ “About Mapping Activity Operations” on page 196

Data Objects and Variables

The workflow uses a single process object to manage information about the process. A separate
activity object is created for each activity in the workflow and form data is maintained for each
activity that provides for user interaction.

The data objects associated with each user interface control on a form (text field, drop-down list, and
so forth) can be modified immediately prior to the execution of the corresponding activity (Start
activity or Approval activity). In addition, this data can be retrieved immediately after execution of
the activity. After control has been passed to the next activity, the form control data is no longer
available. For this reason, the workflow provides a special object called flowdata that allows you to
define your own data items. You can add your own variables to this object to keep track of
information that is important to your workflow, including form data that would otherwise be lost.

The following table summarizes the categories of workflow data:

Table 6-6 Categories of Workflow Data

Data Object Lifetime Editable Creator

process Workflow No System

activities Workflow No System

activity forms Activity Yes System and workflow designer
flowdata Workflow Yes Workflow designer

NOTE: The workflow designer is the person who creates the workflow in Designer.

The following table describes the variables for each type of object:

Table 6-7 Data Variables in a Workflow

Object Variable Description

process approvalStatus The current status of the process.
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Object

Variable

Description

approval-
activity-name

form-name

flowdata

category

container dn

description

group container dn

id

initiator

locale

name

provisioning driver dn

recipient

user container dn

requestiD
timestamp

action

addressee
name
timestamp
user

workld

custom-form-controls

custom-variables

The provisioning category (for example, Entitlements)
selected by the person who initiated the request.

The distinguished name of the container defined for the
user application at install time.

The description of the provisioning request definition.

The distinguished name of the group container defined for
the user application at install time.

The unique IDVault ID (CN) of the provisioning request
definition.

The distinguished name of the person who initiated the
request.

The current locale.
The workflow process name.

The distinguished name of the provisioning driver defined
for the user application at install time.

The distinguished name of the intended target of the
provisioned resource.

The distinguished name of the user container defined for
the user application at install time.

The ID for the provisioning request.
The time the process was initiated.

The action taken by the user.

The current addressee for the approval activity.

The name of the activity.

The time that the activity was queued on the work list.
The user who is associated with the current activity.

The system generated unique ID of the current workflow
activity.

Any user interface control you add to a form.

Any custom variables you create to hold data needed for
the workflow.

If you use one of the installed templates to create your
workflow, the flowdata object can have a variable called
reason, which contains text copied from the reason field
on the initial request form.
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You can reference these objects in ECMAScript expressions. Script expressions in a workflow can

at any time refer to data items that are bound upstream in the flow. However, workflow expressions
cannot refer to data items that are created downstream (because these data items don’t exist yet) or

to data bound on other branches in a flow that supports parallel processing (because these branches
could be executing concurrently with the current activity).

Creating New Data Items

You can create a new data item on the flowdata object by specifying a post-activity target expression
on the Data Item Mapping tab for the Start or Approval activities. If you specify a name for a new
data item in the Target Expression column, this automatically creates the variable. Any activity
executed after this activity can then access the data item.

For example, you might want to map the form field called reason to the target expression
flowdata.myReason. The variable myReason then becomes a new data item that is available to all
activities executed later in the workflow.

Modifying Data Items

You can modify a data item by specifying a pre-activity expression on the Data Item Mapping tab
for the Start or Approval activities. For example, to prepend a dollar sign to a price, you might map
the following source expression to a target form field called Price:

"$" + flowdata.get( cost”)
When the form displays to the user, the Price data appears as follows:
BXX . XX

Another example might be computing the total cost by adding the tax to the base cost. To do this,
you could map the following source expression to a target form field called TotalCost:

Number (flowdata.get("cost")) + Number(flowdata.get("tax"))

Working with Complex Data Item Mappings

All data in the flowdata object is maintained in XML, so you can create data items in a hierarchical
fashion as well. For example, suppose you have a workflow form that allows a user to ask for access
to two internal systems, one for accounts payable and one for receivables. Suppose the form has
(among other fields) two Yes/No fields named Acct_Pay and Acct_Rec. In the post-activity data item
mappings, you might create two mappings as follows:

Table 6-8 Complex Data Item Mapping Examples

Source Form Field Target Expression
Acct_Pay flowdata.SystemAccess/AcctPay
Acct_Rec flowdata.SystemAccess/AcctRec

This would create an XML element named SystemAccess with two child elements named AcctPay
and AcctRec. One reason to structure data in this way is for clearer organization and management of
data in complex workflows containing many forms and data items. To retrieve data from these
hierarchies, the following syntax would be used:
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flowdata.get(”SystemAccess/AcctPay”)

For complete details on building ECMAScript expressions, see Chapter 9, “Working with ECMA
Expressions,” on page 317.

Moving Form Control Data to Flowdata

All form controls you create (except for DNDisplay) are automatically made available for use in
pre-activity and post-activity expressions on the Data Item Mapping tab for the activity that uses the
form. For example, suppose you want to make a user’s entry data in control ACONTROL on form
AFORM in AACTIVITY available for use in a subsequent activity. To do this, you would select
AACTIVITY in the workflow, select the Data Item Mapping tab, and click the Post Activity Mapping
radio button. Next to the source form field ACONTROL, you would then enter a target expression in
the following format:

flowdata.my_ ACONTROL

Any subsequent activity in the workflow would then be able to access this data by using pre-activity
source expressions such as these:

flowdata.get("my_ACONTROL”)
flowdata.getObject("my_ACONTROL”)

Moving Flowdata to Form Controls

You can also move flowdata values into form controls. The simplest case is moving a single text
value into a form control. In the example above, suppose ACONTROL is a simple text entry field.
In this case, to move it into another text entry field in an activity called ZACTIVITY, you would
select ZACTIVITY in the workflow, select the Data Item Mapping tab, and click the Pre Activity
Mapping radio button. Next to the target form field, you would then enter this source expression:

flowdata.my ACONTROL

To move more complex form control data (for example, a MultiValue DN control) into another form
control, you can use the getObject() expression syntax. For example, assuming ACONTROL is a
MultiValue DN control, you could use this source expression:

flowdata.getObject("my_ACONTROL?)

To move data into a form control, you need to be aware of type constraints. For example, you should
not try to move text-based data into a numeric control, or a Boolean value into a DN control.
About Mapping Activity Operations

In the mapping activity, the source expressions are evaluated before they are assigned to the target
expression. If the source expression does not exist prior to the mapping activity, no value is assigned
to the target expression.

For example, if flowdata.get(“textfield”) maps to flowdata.copyoftextfield and
flowdata.get("copyoftextfield") maps to flowdata.copyoftextfield2, the value of
flowdata.copyoftextfield2 is empty at the end of the mapping activity because the value of the
flowdata.copyoftextfield is assigned only after the mapping activity.
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To assign values to the target expression, you can use either of these options:

+ Multiple mapping-activities.
+ Single mapping-activity but repeat the source expression.

& Errar Log ﬁ, Project Checker Data Itern Mapping &2 | (51 Problems

+ %X 49
Source Expression Target Expression
Flowdaka, getltexkhield]) Flowsdaka, copyofte:xtfield
Flovudata. get('textField") Flovedata. nokcopyoftesxtfield
o+ 102M of 2544 [

When you repeat the source expression, the flowdata.get(“textfield””) maps to
flowdata.copyoftextfield and flowdata.get("textfield") maps to flowdata.copyoftextfield2.

6.6 Guidelines for Creating Roles Based
Workflows
Roles based workflows must follow the same guidelines outlined in Section 6.5, “Guidelines for

Creating Workflows,” on page 189. In addition, roles based workflows have their own unique
requirements. They are described in the following sections:

*

Section 6.6.1, “About Role Approval Workflows,” on page 197

*

Section 6.6.2, “Writing Custom Role Workflows,” on page 199

*

Section 6.6.3, “About Separation of Duties Approval Workflows,” on page 203

*

Section 6.6.4, “Customizing the Standard Separation of Duties Workflow,” on page 206

6.6.1 About Role Approval Workflows

Role approval workflows are specialized workflows that provide support for role approval and
revocation on the User Application’s Roles tab. The Roles Based Provisioning Module includes a
read-only Role Approval workflow (named Role Approval) whose design pattern supports:

+ The ability to process role approvals in either serial or quorum mode.

+ The retrieval of approver DNs from the role object (nrfRequest). If you create a custom
workflow, the approvers must be defined in the workflow; however, this might lead to
addressee evaluation problems and less security concerning who can approve a role.

+ The ability to display the role using localized display names.
+ All nrfRequest object mappings for request and approval forms.
+ Logging and reporting functions.
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+ Read-only display of request information. The role approval workflow does not allow changes
to the request. Approvers have only the ability to approve or deny the role request.

+ An e-mail notification is sent to all approvers of role approval workflows. A completed
notification e-mail is sent upon completion of the role approval workflow. The recipient e-mail
address is used when the workflow is intended to be assigned to a user identity.

This pattern is shown in Figure 6-6 on page 198.

Figure 6-6 Default Role Approval Workflow
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The components of this workflow, and their responsibilities are summarized in Table 6-9.

Table 6-9 Standard Role Approval Activities

Activity Name Activity Type Description

Start Start Logical starting point for all workflows. For role
approvals it must instantiate the nrfRequest object.

Set up counter Mapping Sets up the counter for the number of approvers in
case the mode is Serial.

Localize Display Mapping Sets up the display labels for each of the
associated display names for the user’s locale.
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Activity Name Activity Type Description

Check for Processing ~ Condition Determines whether the approval is a quorum
Type condition by setting the Condition property to this
ECMA expression:

nrfRequest. isQuorumProcess()

If the quorum condition exists, control proceeds to
the Approve Role Request (Quorum). If the
quorum condition does not exist, control proceeds
to the Approve Role Request (Serial).

You specify the processing type for the role
approval when you set up the Roles Catalog.

Approve Role Request  Approval This is where the decision to approve or deny the

(Quorum) request is recorded as part of the workflow
instance. The quorum condition required to make
the process successful is retrieved from the
nrfQuorum attribute of the nrfRequest object.

Approve Role Request Approval This is where the decision to approve or deny the
(Serial) request is recorded as part of the data flow
associated with the workflow instance.

The workflow loops through the list of approvers
found in the nrfRequest object. The request is
approved if all approvers in the serial process
approve the request. The request is denied upon
the first rejection from an approver in the serial

process
Deny Assignment of Role Binding Changes the deny attribute in the nrfRequest
Role object to true.
Approve Assignment of Role Binding Changes the approve attribute in the nrfRequest
Role object to true.
Finish Finish Logical end point of all workflows.

To use the standard Role Approval workflow in your user application, you must specify your own
users as Trustees. For information on setting the Trustees property, see Section 4.2.6, “Modifying
Settings of a Provisioning Request Definition,” on page 98.

6.6.2 Writing Custom Role Workflows

If the standard role approval workflow does not support your business needs, and cannot be
customized to do so, you can write your own. At a minimum, a custom role approval workflow
must:

+ Contain two Role Binding activities

One Role Binding activity must be set to approved and the other set to denied. You must link
each of the Role Binding activities to the Finish activity. If the workflow does not meet this
requirement, it is invalid, and Designer prevents you from deploying it. The Role Service driver
needs these values to set the status for the workflow and to then apply the logic to associate the
role to the identity.
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*

Contain the following control in the request form:
+ Form Field Name: nrfRequestDN
+ Data Type: Role Request
+ Control Type: Text

*

Instantiate the nrfRequestDN in the Pre Activity Data Item Mapping.

*

Contain the following in the Post Activity Data Item Mapping:
+ Source Form Field: nrfRequestDN
+ Target Expression: flowdata.nrfRequestDN
+ Data Type: dn

*

Not contain the following ECMA expressions in the Data Item Mapping or Properties
definitions because they might return null:

¢ getApprovalDNQ
¢ getAllApproversDNQ
¢ getAllSodApproversDN(Q)

Because Designer and the User Application user interface do not allow entry of approvers for
custom role approval workflows, you must specify the approvers in the workflow itself.
Therefore, if you create a custom workflow based on a copy of the Role Approval or SoD
Conflict Approval provisioning request definitions, you must remove the ECMA methods from
Data Item Mapping or Properties definitions.

In the following example, a user requests a role and the user’s manager approves it.
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Figure 6-7 Sample Custom Role Approval Workflow
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The components of this workflow, and their responsibilities are summarized in Table 6-10.

Table 6-10 Sample Custom Workflow Components

Activity Name Activity Type Description

Start Start Logical starting point of all workflows.

Localize Display Mapping Sets up the display labels for the user’s
locale.

Manager Approval Approval This is where the decision to approve or

deny the request is recorded as part of the
workflow instance. The role request approval
is needed only by the requestor’s manager.
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Activity Name Activity Type Description

Approve Assignment of Role Role Binding Changes the approve attribute in the
nrfRequest object to true.

Deny Assignment of Role Role binding Changes the deny attribute in the
nrfRequest object to true.

Finish Finish Logical end point of all workflows.

The data item mapping for the sample custom role approval workflow is defined in Table 6-11

Table 6-11 Sample Custom Role Approval Workflow Data Item Mapping

Activity Name Property Type Property Value

Start Data Item Pre Activity =~ Source Expression: None
Target Form Field: nrfRequestDN
Data Type: dn
Data Item Post Activity ~ Source Form Field: nrfRequestDN

Target Expression: flowdata.nrfRequest/DN

Data Type: DN

Localize Display Data Item Source and

Target mapping

Manager Approval Addressee Property Addressee
IDVault.get(recipient, "user®, "manager®)

Data ltem Pre ACtIVIty D Pra dctiviey (O Post Activiey

Souree Expression Target Form Fisld Data Type
title: string

subheading string
NrfRequest.getCn() Requesthumbsr dn
NrfRequest.getRequester() Requesteriame dn
NrfRequest.get CategoryLocaleString(locals) Operation string
NrfRequest get SourceDNDisplayMame(localz) SourceDN string
NrfRequest,qetTargetDMDisplayNametlorale) TargetDM string
NrfRequest getRequestDate() RequestDate date
MrfRequest.getStartDatet) StartDate date
NrfRequest getEndDate() EndDate date

NrfRequest . getDescription() Description string
NrfRequest.getStatusl ocaleString(locale) CurrentStatus string

Data Item Post Activity None

Approve Assignmentof Action Property approved
Role

Deny Assignment of Action Property denied
Role

Finish None
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6.6.3 About Separation of Duties Approval Workflows

Separation of Duties approval workflows are specialized workflows that allows a Separation of
Duties constraint to be overridden. The Roles Based Provisioning Module includes a read-only
Separation of Duties Approval workflow (hamed SoD Conflict Approval) whose design pattern
supports:

+ The ability to process SoD conflicts in either serial or quorum mode.

+ The retrieval of SoD approver DNs from the request object (nrfRequest). If you create a custom
workflow, the approvers must be defined in the workflow; however, this might lead to
addressee evaluation problems and less security concerning who can approve an SoD.

+ The ability to display the SoD using localized display names.

+ All nrfRequest object mappings for request and approval forms.

+ Logging and reporting functions.

+ Read-only display of requests. Approvers can only approve or deny the SoD conflict.

+ An e-mail notification is sent to all approvers per SoD conflict found for SoD workflow
approvals. A completed notification e-mail is sent upon completion of the SoD approval
workflow. The recipient e-mail address is used when the workflow is intended to be assigned to
a user identity.

This pattern is shown in Figure 6-6 on page 198.

The roles subsystem allows one Separation of Duties approval flow for the Role subsystem. If you
choose to use a custom SoD approval flow, make sure that it works for all SoD situations.
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Figure 6-8 Standard SoD Approval Workflow
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The components of the workflow are described in the following table:
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Table 6-12 Standard SoD Constraint Exception Approval Workflow Activities

Activity Name

Activity Type

Description

Start

Localize Display

Localize SoD Name

Check for Processing Type

Approve SoD Conflict (Quorum)

Approve SoD Conflict (Serial)

Deny SoD Conflict
Approve SoD Conflict
Has More SoD Conflicts and

Increment SoD Counter

Finish

Start

Mapping

Mapping

Condition

Approval

Approval

Role Binding
Role Binding
Condition and

Mapping activity

Finish

Logical starting point of all workflows.

Sets up the display labels for each of the
associated Display Names for the user’s locale
for the SoD conflicting Role.

Sets up the display labels for each of the
associated Display Names for the user’s locale
for the SoD conflcting Role.

Determines whether the approval is a quorum
condition by setting the Condition property to
this ECMA expression:

nrfRequest. isSodQuorumProcess()

If the quorum condition exists, control proceeds
to the Approve SoD Conflict (Quorum). If the
guorum condition does not exist, control
proceeds to the Approve SoD Conflict (Serial).

You specify the processing type for the role
approval when you set up the Roles Catalog.

This is where the decision to approve or deny
the request is recorded as part of the workflow
instance. The quorum condition required to
make the process successful is retrieved from
the nrfQuorum attribute of the nrfRequest
object.

This is where the decision to approve or deny
the request is recorded as part of the data flow
associated with the workflow instance.

The workflow loops through the list of
approvers found in the nrfRequest object. The
request is approved if all approvers in the serial
process approve the request. The request is
denied upon the first rejection from an approver
in the serial process

Changes the deny attribute in the nrfRequest
object to true.

Changes the approve attribute in the
nrfRequest object to true.

Loops through the SoD requests.

Logical end point of all workflows.

Creating the Workflow for a Provisioning Request Definition

205



6.6.4 Customizing the Standard Separation of Duties Workflow

Separation of Duties conflict approval workflows are complex. Therefore, it is not recommended
that you write a custom version. Rather, it is recommended that you add new activities to a copy of
the standard SoD approval workflow. For example, you might want to add additional logging or
messages. This example illustrates a customized workflow that includes a new logging activity.

Figure 6-9 Adding Activities to the SoD Workflow
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The Log Activity properties are shown in Figure 6-10.

Figure 6-10 Log Activity Properties

Property
Name

iy L5=0
Audit true

Author TOMRales

Message “Securiey alert for separation of duties conflict, Approval process correlation id is: "+ MrfRequest.getCarrelationId()

Comment: "Security alert for separation of duties conflict, Approval process correlation id is: "+ MrfRegquest, getCorrelationldf)

SoD Conflict approval workflows must follow the same rules as the role approval workflows as
described on Section 6.6.2, “Writing Custom Role Workflows,” on page 199.
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6.7 Guidelines for Creating Resource Based
Workflows

Resource based workflows must follow the same guidelines outlined in Section 6.5, “Guidelines for
Creating Workflows,” on page 189. In addition, resource based workflows have the unique
requirements described in the following sections:

+ Section 6.7.1, “About Resource Approval Workflows,” on page 207

+ Section 6.7.2, “Writing Custom Resource Workflows,” on page 209

6.7.1 About Resource Approval Workflows

Resource approval workflows are specialized workflows that provide support for resource approval
and revocation on the User Application’s Roles tab. The Roles Based Provisioning Module includes
a read-only Resource Approval workflow (named Resource Approval) whose design pattern
supports:

+ The ability to process resource approvals in either serial or quorum mode.

+ The retrieval of approver DNs from the resource object (nrfResourceRequest). If you create a
custom workflow, the approvers must be defined in the workflow; however, this might lead to
addressee evaluation problems and less security concerning who can approve a resource.

+ The ability to display the resource using localized display names.
+ All nrfResourceRequest object mappings for request and approval forms.
+ Logging and reporting functions.

+ Read-only display of request information. The resource approval workflow does not allow
changes to the request. Approvers have only the ability to approve or deny the resource request.

+ An e-mail notification is sent to all approvers of resource approval workflows. A completed
notification e-mail is sent upon completion of the resource approval workflow. The recipient e-
mail address is used when the workflow is intended to be assigned to a user identity.

This pattern is shown in Figure 6-11 on page 208.
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Figure 6-11 Default Resource Approval Workflow
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The components of this workflow, and their responsibilities are summarized in Table 6-13.

Table 6-13 Standard Resource Approval Activities

Activity Name Activity Type Description

Start Start Logical starting point for all workflows. For
resource approvals it must instantiate the
nrfResourceRequest object.

Set up counter Mapping Sets up the counter for the number of approvers in
case the mode is Serial.

Localize Display Mapping Sets up the display labels for each of the

associated display names for the user’s locale.
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Activity Name Activity Type Description

Check for Processing ~ Condition Determines whether the approval is a quorum
Type condition by setting the Condition property to this
ECMA expression:

nrfResourceRequest. isQuorumProcess()

If the quorum condition exists, control proceeds to
the Approve Resource Request (Quorum). If the
quorum condition does not exist, control proceeds
to the Approve Resource Request (Serial).

Approve Resource Approval This is where the decision to approve or deny the

Request (Quorum) request is recorded as part of the workflow
instance. The quorum condition required to make
the process successful is retrieved from the
nrfQuorum attribute of the nrfResourceRequest

object.
Approve Resource Approval This is where the decision to approve or deny the
Request (Serial) request is recorded as part of the data flow

associated with the workflow instance.

The workflow loops through the list of approvers
found in the nrfResourceRequest object. The
request is approved if all approvers in the serial
process approve the request. The request is
denied upon the first rejection from an approver in
the serial process

Deny Assignment of Resource Request Changes the deny attribute in the
Resource Binding nrfResourceRequest object to true.
Approve Assignment of Resource Request Changes the approve attribute in the
Role Binding nrfResourceRequest object to true.
Finish Finish Logical end point of all workflows.

To use the standard Resource Approval workflow in your user application, you must specify your
own users as Trustees. For information on setting the Trustees property, see Section 4.2.6,
“Modifying Settings of a Provisioning Request Definition,” on page 98.

6.7.2 Writing Custom Resource Workflows

If the standard resource approval workflow does not support your business needs, and cannot be
customized to do so, you can write your own. At a minimum, a custom resource approval workflow
must:

+ Contain two Resource Request Binding activities

One Resource Request Binding activity must be set to approved and the other set to denied.
You must link each of the Resource Request Binding activities to the Finish activity. If the
workflow does not meet this requirement, it is invalid, and Designer prevents you from
deploying it. The Role and Resource Service driver needs these values to set the status for the
workflow and to then apply the logic to associate the resource to the identity.

Creating the Workflow for a Provisioning Request Definition
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*

Contain the following control in the request form:
+ Form Field Name: nrfResourceRequestDN
+ Data Type: Resource Request
+ Control Type: Text

*

Instantiate the nrfResourceRequestDN in the Pre Activity Data Item Mapping.

*

Contain the following in the Post Activity Data Item Mapping:
+ Source Form Field: nrfResourceRequestDN
+ Target Expression: flowdata.nrfResourceRequestDN
+ Data Type: dn

*

Not contain the following ECMA expressions in the Data Item Mapping or Properties
definitions because they might return null:

¢ getApprovalDNQ
¢ getAllApproversDNQ
¢ getAllSodApproversDN(Q)

Because Designer and the User Application user interface do not allow entry of approvers for
custom resource approval workflows, you must specify the approvers in the workflow itself.
Therefore, if you create a custom workflow based on a copy of the Resource Approval
provisioning request definition, you must remove the ECMA methods from Data Item Mapping
or Properties definitions.

In the following example, a user requests a resource and the user’s manager approves it.
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Figure 6-12 Sample Custom Resource Approval Workflow
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The components of this workflow, and their responsibilities are summarized in Table 6-14.

Table 6-14 Sample Custom Workflow Components

Activity Name Activity Type Description

Start Start Logical starting point of all workflows.

Localize Display Mapping Sets up the display labels for the user’s
locale.

Manager Approval Approval This is where the decision to approve or

deny the request is recorded as part of the
workflow instance. The resource request
approval is needed only by the requestor’s
manager.
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Activity Name Activity Type Description

Approve Assignment of Role Role Binding Changes the approve attribute in the
nrfResourceRequest object to true.

Deny Assignment of Role Role binding Changes the deny attribute in the
nrfResourceRequest object to true.

Finish Finish Logical end point of all workflows.

The data item mapping for the sample custom resource approval workflow is defined in Table 6-15

Table 6-15 Sample Custom Resource Approval Workflow Data Item Mapping

Activity Name Property Type Property Value

Start Data Item Pre Activity =~ Source Expression: None
Target Form Field: nrfResourceRequestDN
Data Type: dn
Data Item Post Activity ~Source Form Field: nrfResourceRequestDN

Target Expression: flowdata.nrfResourceRequest/DN

Data Type: DN

Localize Display Data Item Source and

Target mapping

Manager Approval Addressee Property Addressee
IDVault.get(recipient, "user®, "manager®)

Data ltem Pre ACtIVIty D Pra dctiviey (O Post Activiey

Souree Expression Target Form Fisld Data Type
title: string

subheading string
NrfRequest.getCn() Requesthumbsr dn
NrfRequest.getRequester() Requesteriame dn
NrfRequest.get CategoryLocaleString(locals) Operation string
NrfRequest get SourceDNDisplayMame(localz) SourceDN string
NrfRequest,qetTargetDMDisplayNametlorale) TargetDM string
NrfRequest getRequestDate() RequestDate date
MrfRequest.getStartDatet) StartDate date
NrfRequest getEndDate() EndDate date

NrfRequest . getDescription() Description string
NrfRequest.getStatusl ocaleString(locale) CurrentStatus string

Data Item Post Activity None

Approve Assignmentof Action Property approved
Resource

Deny Assignment of Action Property denied
Resource

Finish None
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6.8 Debugging a Workflow

When testing a workflow, you might need to see the values of the variables you’re using in the flow.
Some options include:

+ Section 6.8.1, “Using the Log Activity,” on page 213

+ Section 6.8.2, “Using the Workflow Database,” on page 213

+ Section 6.8.3, “Changing Log Levels,” on page 213

6.8.1 Using the Log Activity

Use the Log activity to display messages containing the variables you need to look at. After you’ve
configured the Log activity, you can then see the messages in the console. In the Log activity, you
can use scripting expressions in the Message property to retrieve the values you need. For example,
you might use this expression to log a message containing the value of a variable defined on the
flowdata object:

flowdata.get("my_variable”)

For details on using the Log activity, see Section 7.3, “Log Activity,” on page 238.

6.8.2 Using the Workflow Database

Look in the workflow database to see how the data associated with the flowdata object changes as
the workflow progresses from one activity to the next. To see this data, you can look at the
afdocument table.

6.8.3 Changing Log Levels

During the debugging process, you can change the log levels associated with the workflow system
(com.novell.soa.af.impl), the provisioning requests component of the User Application
(com.novell.srpr.apwa), and the evaluation of server side scripts (com.novell.soa.script). This
approach might generate more information than you need, but sometimes it can be helpful. To
change logging levels, go to the Logging page within the Administration tab of the User
Application.

6.9 Provisioning Multiple Individuals with One
Workflow Instance
You can configure a provisioning request definition so that one individual (for example, a manager)

can provision multiple individuals (for example, members of a, or a group) with one workflow. The
provisioning request definition can be configured to provision any one of the following:

+ Multiple individual users from the default user container

+ All members of a group from the default group container (for example, Sales, Marketing, HR,
IT)

+ All members of any arbitrary Identity Vault container
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To create this type of workflow, create the provisioning request definition as you normally would.
On the Overview panel, select Single Flow Provision Members from the Flow Strategy list.

+ Section 6.9.1, “Basic Steps for Using the Workflow,” on page 214

+ Section 6.9.2, “Setting up the Workflow for a Manager to Use,” on page 215

6.9.1 Basic Steps for Using the Workflow

This section describes the basic steps for using a workflow that utilizes the Single Flow Provision
Members flow strategy.

1 Log into the user application as a user application administrator.

2 Click Requests and Approvals.

3 Click Request Resources.

Novelle Identity Manager

Welcome Admin

Moy Wi ok
+ My Tasks

»

Request Resource

Moy Requests

»

Moy Settings

Enter Proxy Mode

Edit Awailahility

Moy Proxy Assignments
Moy Delegate Assignments

Moy Team's Wark
Team Tasks

Regqupst Team Resources
Team ;equests

Moy Team's Settings

»

»

Team Proxy Assiznments
Team Delegate Assignments

Team Awailability

4 Select the provisioning category to which the provisioning request belongs, then click OK.

Request Team Resources

Step 1 of 41 Select the category of the resource vou are requesting,

Resource Search Critera: Al
Accounts

Continue | Entitlements

Groups

You should see a workflow that is marked with an icon that contains a cluster of people:

214 User Application: Design Guide



Request Team Resources

Step 2 of 41 Select the resource from the list,

Resource Resource Search Criteria  Description
& strategy SingleFlowProvisionmMembers Accounts Strategy_SingleFlowProvisiontMembers
1-10f1
Back |

5 Click the name of the workflow.
A form is displayed that provides three methods of selecting multiple users to provision:
+ Specify one or more recipients
+ Specify a group
+ Specify a container

Request Team Resources
Step 3 of 40 Select a user [or users, if the resource you selected was marked "tMultiple Recipients Allowed") for whorn
you are requesting a resource,
Selection Type:®
* Specify Recipient
Recipient: ;I

=l QA

" Specify Group

= Specify Container

Continue |

6 Specify the recipients, then click Continue.

6.9.2 Setting up the Workflow for a Manager to Use

To enable a Manager to use a workflow that uses the Single Flow Provision Members flow strategy,
you need to perform these additional setup steps:

1 Log in to iManager as an administrator.

2 In Roles and Tasks, select Provisioning Configuration.

3 Select Provisioning s.

4 Setup the if itis not already set up.

5 Bind the workflow to the by defining a Provisioning Request using the Provisioning
Configuration Role and Task.
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6.10 Making Distinguished Name References
Portable

When you use a DN in an expression in a provisioning request definition, the expression might fail
if you the provisioning request definition to an Identity Vault with a different structure. You
typically specify DNs in:

+ Overview panel: Trustee specification.

+ User activity: Addressee and escalation addressee.

*

Entity activity: Entitlement reference and entity DN.

*

Many other expressions, for example, IDVault.get(dn, class, attribute).

Some expressions, such as recipient, are portable. The following expressions, which are used by
default in the User activity, are also portable:

IDVault.get(recipient,’user’, manager’)
IDVault.get(approval_A.getAddressee(), user”, manager’)

To ensure that your DN expressions are portable across Identity Vaults, you can use one of the
following variables:

+ ROOT_CONTAINER: for example ou=idm-prov,o=novell

+ PROVISIONING_DRIVER: for example cn=UserApplication,cn=TestDrivers,o=novell
+ USER_CONTAINER: for example ou=users,ou=idm-prov,o=novell

+ GROUP_CONTAINER: for example ou=groups,ou=idm-prov,o=novell

These variables are defined during installation of the user application and are resolved at runtime by
the ECMAScript engine. You can find them in the ECMA Expression Builder under the process
node. Suppose you wanted to reference an entitlement at the following DN:

“cn=myEntitlement,cn=UserApplication,cn=TestDrivers,o=novell”
You could use the following expression to make the DN portable to any identity vault:
“’cn=MyEntitlement,” + PROVISIONING_DRIVER

You can use this technique for users and groups also.

NOTE: Trustees are not expressions so you cannot use this technique with Trustees.

6.11 Configuring Digital Signature Support

This section describes how to use Designer to configure provisioning request definitions to support
digital signatures. To configure a provisioning request definition to support digital signatures, follow
the steps outlined in the following table.
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Table 6-16 Steps for Specifying Digital Signature Support in Workflows

Step Task

Description

1 Create one or more digital
signature declarations.

2 Specify whether a digital signature
is required to initiate a
provisioning request.

3 Specify whether a digital signature
is required for each approval step
within the workflow.

4 Determine the forms that contain
a title control.

See Section 6.11.2, “Creating a Signature Declaration,”
on page 218.

In the Workflow panel, click the Start activity and set the
following properties:

+ Digital Signature Required: See Section 6.11.1,
“Digital Signature Workflow Properties,” on
page 217.

+ Signature Declaration: Choose a signature
declaration from the drop-down list. The list is only
populated if you completed Step 1 (above).

Each approval step can have more than one outgoing
link. You must specify the Digital Signature Required
property and the Signature Declaration properties for
each approval step and each outgoing flow path. For a
description of the property settings, see Section 6.11.1,
“Digital Signature Workflow Properties,” on page 217.

Title controls have a property called Display title in signed
form document. Determine for your application and use
of digital signatures whether this property should be set
to true or false. For more information on this property,
see Section 5.5.23, “Title,” on page 165.

+ Section 6.11.1, “Digital Signature Workflow Properties,” on page 217

+ Section 6.11.2, “Creating a Signature Declaration,” on page 218

6.11.1 Digital Signature Workflow Properties

Table 6-17 Digital Signature Settings

Setting Description

Digital Signature Type Specifies whether the digital signature uses data or form as its type:

+ Data: Specifies that the XML signature serves as the user
agreement. When you select Data, the XML data is written to the

audit log.

+ Form: Specifies to generate a PDF document that includes the
digital signature declaration. This document serves as the user
agreement. The user can preview the generated PDF document
before submitting a request or approval. When you select Form,
the PDF document (encapsulated in XML) is written to the audit

log.

Digital Signature Declaration  Specifies a digital signature confirmation string that certifies the user’s
signature. See Section 6.11.2, “Creating a Signature Declaration,” on

page 218.
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6.11.2 Creating a Signature Declaration
1 Open the Signature Declarations tab.

s_'}:i. Designer. - DAL Query ID Vault - Designer, |ZHE|E|
File Edit Yiew Project Tools Lwe PRD ‘Window Help

Ci= (=) @ i o ﬁl‘)Daslgnerl

Bl *DAL Query ID Vaul: X =8

Edit Signature Declarations

&+ | #%

Signature Declaration 10 Language Signature Declaration

<

R

Crverview | Workflow | Forms | Signature Declarations

[ % §

2 Click to add a row, then fill in the fields as follows:

Field Description

Signature Declaration ID A unique identifier for the signature declaration. This ID is displayed in
the drop-down for the “Digital Signature Declaration” on page 217.

Language Choose a language and specify the signature declaration translation for
that language. The signature declaration string is also exported as part
of the Provisioning view’s Export > Export Localization to File so that
you can send the declaration to be localized as part of the rest of the
User Application display labels and strings.

Signature Declaration The string to display in a form as the signature declaration.

3 Click Save.
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Workflow Activity Reference

This section provides details on configuring the different types of workflow activities. Topics in this
section include:

+ Section 7.1, “Start Activity,” on page 219

+ Section 7.2, “Approval Activity,” on page 222

+ Section 7.3, “Log Activity,” on page 238

+ Section 7.4, “Branch Activity,” on page 240

+ Section 7.5, “Merge Activity,” on page 241

+ Section 7.6, “Condition Activity,” on page 241

+ Section 7.7, “Mapping Activity,” on page 242

+ Section 7.8, “Workflow Status,” on page 243

+ Section 7.9, “E-Mail Activity,” on page 244

+ Section 7.10, “Role Request Binding Activity,” on page 246

+ Section 7.11, “Role Request Activity,” on page 247

+ Section 7.12, “Resource Request Binding Activity,” on page 252

+ Section 7.13, “Resource Request Activity,” on page 252

+ Section 7.14, “Start Workflow Activity,” on page 255

+ Section 7.15, “Finish Activity,” on page 257

+ Section 7.16, “Integration Activity,” on page 260

+ Section 7.17, “Entitlement Activity,” on page 262

+ Section 7.18, “Entity Activity,” on page 264
The display names for all activities can be localized by clicking the Localize Strings button (see
Section 2.10, “Localizing Provisioning Objects,” on page 37) for the activity name property.
Activity display names are also exported as part of the Provisioning view’s Export > Export
Localization to File (see Section 2.10.3, “Exporting and Importing Data to Localize,” on page 39) so

that you can send the activity names to be localized as part of the rest of the User Application
display labels and strings.

7.1 Start Activity

The Start activity is the first activity to execute in a workflow. It begins execution when the user
makes a request to provision a resource. After the user makes the request, the Start activity displays
the initial request form to the user. On the initial request form, the user can be asked to specify a
comment that indicates the reason for the request.

You can customize the initial request form to suit your application requirements. For details on
customizing forms, see Chapter 5, “Creating Forms for a Provisioning Request Definition,” on
page 1009.

Before displaying the form to the user, the Start activity performs any pre-activity data mappings
specified for the activity.

Workflow Activity Reference 219



After the user submits the form, the Start activity performs any post-activity data mappings specified
for the activity. These mappings typically include copying data from form fields into the flowdata
object.

+ Section 7.1.1, “Properties,” on page 220
+ Section 7.1.2, “Data Item Mapping,” on page 221
+ Section 7.1.3, “E-Mail Notification,” on page 222

7.1.1 Properties

The Start activity has the following properties:

Table 7-1 Start Activity Properties

Property Name Description

Name Provides a name for the activity.
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Property Name Description

Display Name Allows you to override the provisioning request definition’s display name. This is

Override the name that displays in the Resource column when the user selects My
Requests or Requests . The name can be a constant or the result of an ECMA
expression, and it can be localized for each supported locale. To access the
dialog boxes that let you specify the constant or ECMA expression, the Localize
Strings button in the Value column.

@ Localization @

@ Specify the lacalized string walues For the Display Mame Override.
Dukch: | k -
English: ‘Resource Approval for Group ' + flowdata, get('group’) @ -
French: 'FR: Resource Approval For Group '+ flowdata, get{'group) @ -
GErman: k -
Italian: k -
Japanese: k -
Portuguese: k -
Spanish: k -
zh-cn: k -
zh-tw: k-

To specify a constant, click k and type the value in the field. The value is
displayed exactly as entered in this field.

To specify an ECMA expression, click E# and specify the expression.

TIP: If the value is an ECMA expression, any constants within the expression
must be in single quotes.

If you specify both a constant and ECMA expression, the runtime displays
whichever value was the last one entered as shown in the dialog box (above).

Digital Signature Type See Digital Signature Type in Table 6-17 on page 217.

7.1.2 Data Item Mapping

To bind the data items associated with the Start activity, you define pre-activity and post-activity
mappings. The pre-activity mappings initialize data in the request form with constants or values
retrieved from the flowdata object. The post-activity mappings move form data back into the
flowdata object.

Workflow Activity Reference 221



Table 7-2 Start Activity Data Item Mappings

Setting

Description

Pre-Activity

Post-Activity

Source Expression

Target Expression

Allows you to specify one or more pre-activity mappings. When
this option is selected, you can double-click a cell in the Source
Expression column to specify where the initial request form gets
data for a particular target form field.

The Pre-activity Mapping expression is evaluated twice before
the form is presented, once during the initial presentation to the
form and then again prior to the post to ensure that all the
values on the form have a valid type, even those that were not
initialized. Because of this behavior, any calls made to external
systems are made twice. For example, a call that retrieves a
unique counter for a value makes two calls that allocates two
counters with the last one requested being used.

NOTE: When the Pre-Activity option is selected, the cells in the
Target Form Field column are not editable.

Allows you to specify one or more post-activity mappings. When
this radio button is selected, you can double-click a cell in the
Target Expression column to specify where data from a form
field should be copied after the form has been processed.

The DNDisplay control is not available for post activity
mappings.

NOTE: When the Post-Activity option is selected, the cells in
the Source Form Field column are not editable.

Specifies a source expression for a pre-activity mapping. When
you click a cell in the Source Expression column, the ECMA
Expression Builder displays to help you define your expression.

Specifies a target expression for a post-activity mapping. When
you click a cell in the Target Expression column, the ECMA
Expression Builder displays to help you define your expression.

For details on building ECMA expressions, see Chapter 9, “Working with ECMA Expressions,” on

page 317.

7.1.3 E-Mail Notification

Not supported with this activity.

7.2 Approval Activity

The Approval activity is a user-facing activity that displays an approval form to the user. On the
approval form, the user can approve, deny, or refuse a provisioning request. The Approval activity
can have multiple outgoing flow paths, but only one of the paths is executed at runtime.
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You can customize the approval form to suit your application requirements. For details on
customizing forms, see Chapter 5, “Creating Forms for a Provisioning Request Definition,” on
page 109.

Before displaying the form to the user, the Approval activity performs any pre-activity data
mappings specified for the activity.

After the user submits the form, the Approval activity performs any post-activity mappings specified
for the activity. These mappings typically include copying data from form fields into the flowdata
object.

+ Section 7.2.1, “Properties,” on page 223

*

Section 7.2.2, “Data Item Mapping,” on page 229
Section 7.2.3, “E-Mail Notification,” on page 230
Section 7.2.4, “Addressing an Approval Activity,” on page 231

*

*

7.2.1 Properties

The Approval activity has the following properties:

Table 7-3 Approval Activity Properties

Property Name Description

Name Provides a name for the activity.
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Property Name

Description

Addressee

Reminder Start

Reminder Interval

Specifies a dynamic expression that identifies the addressee for the
activity. The addressee is the approver of the workflow.

The addressee is determined at runtime, based on evaluation of the
expression. Designer validates that the expression is a valid ECMA
expression. It cannot validate whether the expression resolves to a
valid object (such as a role) or whether that object will exist at
runtime.

For information on specifying addressees (such as specifying a role
as the approver), see “Specifying the Addressee Property” on
page 232.

For more information about developing valid Addressee
expressions, and about how Addressee interacts with the Approver
Type property, see Section 7.2.4, “Addressing an Approval Activity,”
on page 231.

TIP: To simplify the process of testing a new workflow, you can set
the addressee to be the recipient. This removes the need to log out
of the User Application and log in again as a manager each time
you want to test your forms. This technique is particularly useful
when the workflow involves multiple levels of approval. After the
testing phase is complete, you can change the addressee to the
correct value.

For details on building ECMA expressions, see Chapter 9, “Working
with ECMA Expressions,” on page 317. For descriptions of the
system variables available in a workflow, see Section 6.5.3,
“Understanding Workflow Data,” on page 193.

Specifies a dynamic expression that defines, in milliseconds, the
time at which the first reminder e-mail should be sent. The start
value is an offset from the time of the first assignment associated
with the activity. You can pick predefined expressions that represent
common intervals (for example, hour, day, week) in the ECMAScript
Variables pane of the ECMA Expression Builder.

This is part of the reminder e-mail function. If this activity is
considered important and needs to be acted on quickly, you can
configure the activity to send a reminder e-mail to the activity
addressee. For example, you can set the reminder settings to send
areminder e-mail 5 days before the activity times out, and on a daily
basis until the activity times out. To do this, specify a Reminder Start
time, a Reminder Interval, and the e-mail to be sent (see

Section 7.2.3, “E-Mail Notification,” on page 230).

For details on building ECMA expressions, see Chapter 9, “Working
with ECMA Expressions,” on page 317. For descriptions of the
system variables available in a workflow, see Section 6.5.3,
“Understanding Workflow Data,” on page 193.

Specifies a dynamic expression that defines the interval between
which reminder e-mails are sent. You can pick predefined
expressions that represent common intervals (for example, hour,
day, week) in the ECMAScript Variables pane of the ECMA
Expression Builder.
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Property Name

Description

Escalation Addressee

Escalation Count

Escalation Interval

Not available when the approver type is Multiple or Quorum

Specifies a dynamic expression that identifies the user who should
get this task if the timeout limit has been reached.

The escalation addressee is determined at runtime, based on how
the expression is evaluated.

For details on building ECMA expressions, see Chapter 9, “Working
with ECMA Expressions,” on page 317. For descriptions of the
system variables available in a workflow, see Section 6.5.3,
“Understanding Workflow Data,” on page 193.

Not available when the approver type is Multiple or Quorum.

Specifies the number of times to retry the activity in the event of a
timeout.

When an activity times out, the workflow process can try to
complete the activity again, depending on the escalation count
specified for the activity. With each retry, the workflow process can
escalate the activity to another user. In this case, the activity is
reassigned to another user (the user’s manager, for example) to
give this user an opportunity to finish the work of the activity. If the
last retry times out, the activity can be marked as approved, denied,
refused, timedout, or in error, depending on the final timeout action
specified for the activity.

The Timeout interval (see Timeout in this table) takes precedence
over the Escalation Interval. For example, if you set the timeout to
10 minutes, and specify an Escalation Count of 3 and Escalation
Interval of 5 minutes, the activity finishes after 10 minutes without
attempting all of the retries. In this example, the second retry would
be canceled, and the workflow would finish processing for the
activity. At the conclusion of the activity, the workflow engine would
follow the link defined by the final timeout action.

Not available when the approver type is Multiple or Quorum.

Specifies a dynamic expression that defines the period of time
allotted for the addressee to complete the task. The escalation
interval applies each time the activity is executed by the addressee.

The Timeout interval (see Timeout in this table) takes precedence
over the Escalation Interval. For example, if you set the timeout to
10 minutes, and specify an Escalation Count of 3 and Escalation
Interval of 5 minutes, the activity will finish after 10 minutes without
attempting all of the retries. In this example, the second retry would
be canceled, and the workflow would finish processing for the
activity. At the conclusion of the activity, the workflow engine would
follow the link defined by the final timeout action.

For details on building ECMA expressions, see Chapter 9, “Working
with ECMA Expressions,” on page 317. For descriptions of the
system variables available in a workflow, see Section 6.5.3,
“Understanding Workflow Data,” on page 193.
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Property Name

Description

Escalation Reminder Start

Escalation Reminder Interval

Final Timeout Action

Timeout

Not available when the approver type is Multiple or Quorum.

Specifies a dynamic expression that defines the time at which the
first reminder e-mail (see Reminder Start in this table) should be
sent to the Escalation Addressee. The start value is an offset from
the time of the escalation assignment. You can pick predefined
expressions that represent common intervals (for example, hour,
day, week) in the ECMAScript Variables pane of the ECMA
Expression Builder.

Not available when the approver type is Multiple or Quorum.

Specifies a dynamic expression that defines how often messages
are sent to the Escalation Addressee after the first escalation
reminder is sent. You can pick predefined expressions that
represent common intervals (for example, hour, day, week) in the
ECMAScript Variables pane of the ECMA Expression Builder.

Determines the final state of the request in the event that the
workflow times out. The choices are

* approved
+ denied
+ refused
+ timedout

¢ error

Specifies a dynamic expression that defines the period of time
allotted for the addressee to complete the task. The timeout interval
applies each time the activity is executed by the addressee.

The Timeout setting takes precedence over the Escalation Count
and Escalation Interval values. If the Timeout setting for the activity
is reached before one or more of the escalation attempts have been
tried, the activity finishes processing without executing these
escalation attempts. For example, if you set the timeout to 10
minutes, and specify an Escalation Count of 3 and Escalation
Interval of 5 minutes, the activity finishes after 10 minutes without
attempting all of the escalation attempts. In this example, the
second escalation attempt would be canceled, and the workflow
would finish processing for the activity. At the conclusion of the
activity, the workflow engine would follow the link defined by the
final timeout action.

For details on building ECMA expressions, see Chapter 9, “Working
with ECMA Expressions,” on page 317. For descriptions of the
system variables available in a workflow, see Section 6.5.3,
“Understanding Workflow Data,” on page 193.
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Property Name

Description

Time Units

Form

Determines the unit of measure used for the timeout interval. The
choices are

+ Milliseconds

+ Days

+ Hours

+ Minutes

+ Seconds
Specifies the name of the approval form to display at runtime, or lets
you define a new form. Select the name of the form you want to use

or create new form. When you choose to create a new form, the
Create New Form Wizard launches and looks similar to this.

@ Create new Form

Form

Farrn narme

bpproval_form1

Seleck nodes in khe tree using check box marks and hit "Finish". &ll selected nodes will be included as string
fields in the new form,

= process
approval3tatus
cakegory
description
id
initiator
locale
name
recipient
requestd
tirmestamp
USER,_COMTAIMER.
GROUP_COMNTAINER
ROOT_COMTAIMER
PROYISIONING_DRIVER
= Flowdata
reason

Edit form upan "Finish"

=)

Finish H Cancel ]

Select the data items to include in the form from the data items
listed, then click Finish. The Approval Form Wizard generates each
of the selected data items as a String type field in the new form.

An Approval activity must have a form associated with it. If no form
is specified, an error message is displayed at runtime.
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Property Name

Description

Exclude Requestor

Approver Type

Notify by E-Mail

Quorum

Digital Signature Type

Priority

Specifies whether requestors can approve their own provisioning
requests.

* True: The requestor is not allowed to approve their own
provisioning requests.

+ False: The requestor is allowed to approve their own
provisioning requests.

Specifies the number of addresses that are allowed and the
approval pattern that is enforced for this activity. The choices are

+ Normal: Action by the addressee is required to complete the
approval.

* Group: Action by one addressee in the group is required to
complete the approval.

+ Multiple: Action by all of the addressees is required to
complete the approval.

You cannot use post activity data item mapping with the
Multiple Approver Type.

+ Quorum: Action by a percentage of addressees or an
absolute number of addressees (see Quorum property in this
table) is required to complete the approval.

You cannot use post-activity data item mapping with the
Quorum Approver Type.

For information about how the Approver Type property interacts with
the Addressee property, see Section 7.2.4, “Addressing an
Approval Activity,” on page 231.

Specifies whether this activity should send e-mail notifications. Set
to True to notify by e-mail; otherwise, set to False.

You specify the e-mail to send using the E-Mail Notification tab (see
Section 7.2.3, “E-Mail Notification,” on page 230).

To use this feature, the Notify participants by E-Mail parameter for
the provisioning request definition must be set to True (see Table 4-
3, “Overview Properties,” on page 99).

Not available when the approver type is Normal, Group, or Multiple.

Allows you to specify a constant value or to create an ECMA
expression that specifies a percentage (for example, '75%’) of
approvals that is required before a quorum is achieved, or an
absolute number (for example, '3’) of approvals that are required
before a quorum is achieved.

See Digital Signature Type in Table 6-17 on page 217.

Specifies a dynamic expression that defines the priority of the
approval activity. Valid priority values are 1, 2, or 3. You can also
define an expression to determine the priority from workflow data.
For example, flowdata.get("Priority').

In the User Application, users can sort the list of tasks by the priority
values of the tasks.
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NOTE: To enable delegation to a group DN, you can have an approver type of Group or Normal,
but the Addressee value must be an expression that returns the user DNs for each member of that
group For example, IDVault.get(groupdn, ‘sales’, ‘members”)

7.2.2 Data Item Mapping

To bind the data items associated with the Approval activity, you define pre-activity and post-
activity mappings. The pre-activity mappings initialize data in the approval form with constants,
values retrieved from the flowdata object, system process variables, system activity variables, and
data retrieved via expression calls to the directory abstraction layer. The post-activity mappings
move form data back into the flowdata object.

Table 7-4 Approval Activity Data Item Mappings

Setting

Description

Pre Activity

Post Activity

Source Expression

Allows you to specify one or more pre-activity mappings. When this option
is selected, you can double-click a cell in the Source Expression column to
specify where the approval form gets data for a particular target form field.

The Pre-activity Mapping expression is evaluated twice before the form is
presented, once during the initial presentation to the form and then again
prior to the post to ensure that all the values on the form have a valid type,
even those that were not initialized. Because of this behavior, any calls
made to external systems are made twice. For example, a call that
retrieves a unique counter for a value makes two calls that allocates two
counters with the last one requested being used.

NOTE: When the Pre-Activity choice is selected, the cells in the Target
Form Field column are not editable.

Allows you to specify one or more Post Activity mappings. When this option
is selected, you can double-click a cell in the Target Expression column to
specify where data from a form field should be copied after the form has
been processed.

You cannot use Post Activity mapping with the Multiple and Quorum
approver types (see Section 7.2.1, “Properties,” on page 223).

The DNDisplay control is not available for post activity mappings.

The form for an Approval activity includes a special internal control called
apwaComment. This control causes user comments to be written to the
workflow database. It should not have a post-activity mapping. For more
information on this control, see Section 5.5.11, “DNMaker,” on page 144.

NOTE: When the Post-Activity option is selected, the cells in the Source
Form Field column are not editable.

Specifies a source expression for a pre-activity mapping. When you click a
cell in the Source Expression column, the ECMA Expression Builder
displays to help you define your expression.
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Setting Description

Target Expression Specifies a target expression for a post-activity mapping. When you click a
cell in the Target Expression column, the ECMA Expression Builder
displays to help you define your expression.

For details on building ECMA expressions, see Chapter 9, “Working with ECMA Expressions,” on
page 317.

7.2.3 E-Mail Notification

To enable e-mail notification for the Approval activity, you need to specify the e-mail template to
use, as well as source expressions for target tokens in the e-mail body.

Table 7-5 E-mail Notification Settings for the Approval Activity

Setting Description

Notify Specifies that this e-mail notification is a notification e-
mail.

Reminder Specifies that this e-mail notification is a reminder e-mail.

Retry Reminder Specifies that this e-mail notification is a retry reminder e-
mail.

Show System Tokens Displays system tokens (for example, TO, CC, BCC,

REPLYTO) in the Target column.

E-Mail Template Specifies the name of the e-mail template to use. By
default, the Approval activity uses the Provisioning
Notification template.

You can edit an e-mail template in Designer. For more
information, see “Editing an e-mail template:” on
page 186.
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Setting

Description

Source/Target

Specifies the source expressions for target tokens in the e-
mail body.

The list of target tokens is determined by the selected e-
mail template. You cannot add new tokens, but you can
assign values to the tokens by building your own source
expressions. At runtime, source expressions are
evaluated to determine the value of each token.

The available target tokens are listed below:

¢ TO

¢ CC

+ BCC

¢ REPLYTO

* recipientFullName

+ initiatorFullName

* requestTitle

+ userFirstName
If you use a provisioning request definition template to
create your workflow, each token has a default source
expression. The default expressions retrieve values from
the workflow process (the process object) or from the data

abstraction layer (IDVault object). You can modify these
expressions to suit your application requirements.

NOTE: When you create a workflow for use with the
Resource Request portlet, and you use the “ _default_” as
the expression for the TO token, the addressee
expression must be an IDVault expression.

For details on building ECMA expressions, see Chapter 9,
“Working with ECMA Expressions,” on page 317.

NOTE: E-mail notification is supported only when the Notify participants by E-Mail check box is
selected on the Overview tab, and the Notify by E-Mail property for the Approval activity is set to

True.

7.2.4 Addressing an Approval Activity

To address an Approval activity, you must enter a valid expression for the Addressee property. The
Addressee is the approver for the activity. The number of approvals that are required to approve the
activity is determined by the relationship between the Addressee property and the Approver Type
property as described in “Relationship Between Addressee and Approver Type” on page 234. This

section includes the following topics:

+ “Specifying the Addressee Property” on page 232

+ “Valid Addressee Expressions” on page 233
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+ “Relationship Between Addressee and Approver Type” on page 234
+ “Troubleshooting Invalid Addressees” on page 238

Specifying the Addressee Property

To build the addressee expression:

1 Click the %7 button in the Addressee property Value column.

Marne
Addresses

Approval
IDVault.getirecipient, 'user','manager')

C2J

Designer launches the dialog box where you can add or remove an expression. The following
dialog only displays when the Approver Type is Group, Multiple, or Quorum.

@ Provisioning Request Definition Property Modification

Specify addressee expression(s) For the appraval

+ X

Rales
IDVault, getrecipient, 'user','manager”y

':':’:' [ K ] [ Cancel

]

2 Click + to add a new addressee expression by using the Expression Builder.

FurchonMelheds
3 ' EcMasrel

T | | T e | |

You can choose one of the ECMAScript Objects to build the addressee expression, or use the
Identity Vault or Search Roles buttons to select a specific object. The Search Roles button is not

available when Approver Type is Normal.
2a To specify a Role as the Addressee, click Search Roles.
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@ Role Search @

Search for Role

Select role

Search Criteria

Identifier (CM):

Display Mame:

Description:

Cateqgory: L3
Role Lewvel: Al v

Matching Roles

Role:

@ Canicel

2b In the dialog box, specify the CN, Display Name, Description, Role Category, and Role
Level on which you want to search.

For CN, Display Name, and Description, you can enter a wildcard (such as S*, *S) or
regular expressions (such as [A-Zoo-z]*).

You can enter a value for all of the fields or none of the fields. If you do not supply a value
in a particular field, the search returns all of the possible values for that field. If you enter
values in one or more of the fields, the values are ANDed together to create the search
filter. The search occurs on the roles defined locally. Roles matching the search criteria are
displayed in the Matching Roles selection list.

2c Select a role from the Roles selection list, then click OK. The role is added to the
expression area.

3 Click OK after you are satisfied with expression.

Valid Addressee Expressions
An Addressee expression must resolve to one of the following at runtime:

+ Avalid individual addressee that can be a user DN, a group DN, or a role DN.

+ A valid list of addressees (for example, created using a Java vector object) that can contain
multiple User DNs, multiple group DNs, or multiple role DNs, or a mixture of both.

Because the addressee is the approver, the maximum number of approvals possible equals the
number of Addressees (the number of User DNs plus the number of Group DNs or Role DNs) and
does not include or count the individual members of a Group or Roles.

NOTE: A Group DN or a Role DN is always processed to contribute a single vote (that is, when one
member of a group or role claims an activity, the rest of the members of the group or role can no
longer see or claim the activity), regardless of the Approver Type.

The following table provides examples of valid addressee expressions that you can create using the
ECMA Expression Builder.
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Table 7-6 Examples of Addressee Expressions

Type of Expression Example

Individual user DN "cn=jdoe,ou=users,ou=mysample,o=myorg"
Individual group DN "cn=Accounting,ou=groups,ou=mysample,o=myorg"”

Individual role DN "CN=Administer
Drugs,CN=Level10,CN=RoleDefs,CN=RoleConfig,CN=AppConfig, "
+ PROVISIONING_DRIVER~

A vector of DNs (can ~ function DNVector() { v=new java.util_Vector();

include user, group, or v.add("CN=jdoe, " + USER_CONTAINER); v.add("CN=Accounting, "

role DNs + GROUP_CONTAINER); v.add("CN=jsmith," + USER_CONTAINER);
v.add("CN=bsmith," + USER_CONTAINER);

v.add("CN=Administer
Drugs,CN=Level10,CN=RoleDefs,CN=RoleConfig,CN=AppConfig, "
+ PROVISIONING_DRIVER);

return v; };

DNVector();

Relationship Between Addressee and Approver Type

Because the addressee is the approver, the behavior of the workflow and the total number of
affirmative approvals needed varies depending on the type of Addressee that is specified by the
Addressee expression, and the Approver Type that is selected.

+ “Normal Approver Type” on page 234

+ “Group Approver Type” on page 235

*

“Multiple Approver Type” on page 236

*

“Quorum Approver Type” on page 237

Normal Approver Type

The following table describes the workflow behavior when different types of addressee are used
with the Normal Approver Type.

Table 7-7 Workflow Behavior with the Normal Approver Type

Addressee Value Description

Individual User DN + Only the user can see the Approval activity in his or her task list.

+ Only one approval is needed to complete the activity as Approved.

Individual Group DN + Each member of Group can see the activity in the task list.

* When one member claims the activity, it is removed from the task lists
of others.

+ Only one approval is needed to complete the activity as Approved.
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Addressee Value Description

Individual Role DN + Each member of the role can see the activity in the task list.

+ When one role member claims the activity, it is removed from the task
lists of others.

+ Only one approval is needed to complete the activity as Approved.

Multiple User DNs Not allowed.
Multiple Group DNs Not allowed.
Multiple Role DNs Not allowed.

Mixture of Users, Groups,  Not allowed.
and Roles

Group DNs and Proxy Processing

If a workflow is assigned to a Group and e-mail notification is used for the approvals, all members
of the group are sent an e-mail. If a proxy user is assigned to any members of the group, the
processing works as follows:

+ |f the approver is a single user then the e-mail notification is sent to both users (the original and
Proxy users).

+ If the approver is a group DN and one of the users in the group is assigned a proxy user, the
user who is the proxy is not notified by e-mail when a new request is placed in the task list.

If you want the proxy user to be notified by e-mail, assign the approval task to the members of
the group and set the approver type to Group Approver. For example, if you assign the approval
activity to:

IDVault.get("cn=Marketing,ou=groups,ou=idmsample,o=novell® , “group”,
"Member™)

When you set the approval type to Group, a notification is sent to each member's proxy, if the
member has a proxy. One member of the group can claim and act on the approval task which is
the same behavior as if you assigned it directly to the group DN.

Group Approver Type

The following table describes the workflow behavior when different types of addressee are used
with the Group Approver Type.

Table 7-8 Workflow Behavior with the Group Approver Type

Addressee Value Description

Individual User DN + Only the user can see the Approval activity in his or her task list.

+ Only one approval is needed to complete the activity as Approved.

Individual Group DN + Each member of Group can see the activity in his or her task list.

* When one member claims the activity, it is removed from task lists of
others.

+ Only one approval is needed to complete the activity as Approved.
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Addressee Value Description

Individual Role DN + Each member of the Role can see the activity in his or her task list.

+ When role one member claims the activity, it is removed from task
lists of others.

+ Only one approval is needed to complete the activity as Approved.
Multiple User DNs * Each user in the virtual group can see the activity in his or her task
list.

+ When one user from the virtual group claims the activity, the activity
is removed from the task lists of others.

+ Only one approval is needed to complete the activity as Approved.
Multiple Group DNs * Each member in each of the groups can see the activity in his or her
task list.

+ When one user from the virtual group claims the activity, the activity
is removed from the task lists of others in all of the groups.

+ Only one approval is needed to complete the activity as Approved.
Multiple Role DNs * Each member in each of the roles can see the activity in his or her
task list.

+ When one user from the one of the roles claims the activity, the
activity is removed from the task lists of others in all of the other roles.

+ Only one approval is needed to complete the activity as Approved.
Mixture of Users, Groups, + Each user and member of each Group or Role can see the activity in
and Roles his or her task list.

+ When one of the approvers claims the activity, the activity is removed
from the task lists of others.

+ Only one approval is needed to complete the activity as Approved.

Multiple Approver Type

The following table describes the workflow behavior when different types of addressee are used
with the Multiple Approver Type.

Table 7-9 Workflow Behavior with the Multiple Approver Type

Addressee Value Description

Individual User DN + Only the user can see the activity in his or her task list.

+ Only one approval is needed to complete the activity as Approved.

Individual Group DN + Each member of the group can see the activity in his or her task list.

+ When one member claims the activity, the activity is removed from
the task lists of others.

+ Only one approval is needed to complete the activity as Approved.

Individual Role DN + Each member of the role can see the activity in his or her task list.

+ When one role member claims the activity, the activity is removed
from the task lists of others in the role.

+ Only one approval is needed to complete the activity as Approved.
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Addressee Value Description

Multiple User DNs .

Multiple Group DNs .

Multiple Role DNs 4

Mixture of Users, Groups, .

and Roles

Each user can see the activity in his or her task list.
Each user can claim the activity.

Approval of each user is needed to complete the activity as
Approved.

Any single denial completes the activity as Denied.
Each member in each of the groups can see the activity in his or her
task list.

When one member from a group claims the activity, the activity is
removed from the task list of others in that Group.

Each group must supply one approval to complete the activity as
Approved.

Any single denial completes the activity as Denied.

Each member in each of the roles can see the activity in his or her
task list.

When one member from a role claims the activity, the activity is
removed from the task list of others in that role.

Each role must supply one approval to complete the activity as
Approved.

Any single denial completes the activity as Denied.
Each user and each member of each group or role can see the
activity in his or her task list.

Each user can claim the activity, and one member of each group or
role can claim the activity (then others in the group or role do not see
the task.)

Each user and one member of each group or role must approve to
complete the activity as Approved.

Any single denial completes the activity as Denied.

Quorum Approver Type

The following table describes the workflow behavior when different types of addressee are used
with the Quorum Approver Type.

Table 7-10 Workflow Behavior with the Quorum Approver Type

Addressee Value Description

Individual User DN .

*

Individual Group DN 4

Only the user can see the activity in his or her task list.
Only one approval is needed to complete the activity as Approved.

Each member of the group can see the activity in his or her task list.

When one member claims the activity, the activity is removed from the
task lists of others.

Only one approval is needed to complete the activity as Approved.

Workflow Activity Reference

237



Addressee Value Description

Individual Role DN + Each member of the role can see the activity in his or her task list.

+ When one member claims the activity, the activity is removed from the
task lists of others.

+ Only one approval is needed to complete the activity as Approved.

Multiple User DNs + Each user can see the activity in his or her task list.
+ All users can claim the activity simultaneously.
+ An absolute number or specified percentage of Addressees must
approve to complete the activity as Approved.
Multiple Group DNs + Each member in each group can see the activity in his or her task list.

+ One member of each group can claim the task (then others in the
group do not see the task).

+ An absolute number or specified percentage of Addressees must
approve to complete the activity as Approved.
Multiple Role DNs + Each member in each role can see the activity in his or her task list.

+ One member of each role can claim the task (then others in the roles
do not see the task).

+ An absolute number or specified percentage of Addressees must
approve to complete the activity as Approved.

Mixture of Users, Groups, * Each user and each member of each Group or Role can see the
and Roles activity in his or her task list.

+ Each user can claim the activity, and one member of each group or
role can claim the activity (then others in the group do not see the
task).

+ An absolute number or specified percentage of Addressees must
approve to complete the activity as Approved.

Troubleshooting Invalid Addressees

If the expression specified in the Addressee property of an Approval activity evaluates to a non-
existent DN (for example, if the expression was hard-coded incorrectly, calculated incorrectly, or
submitted incorrectly by a user selection), no indication is given that the workflow is not processing
normally, when it is in fact orphaned. The application server console displays a normal forward
message, and the Comment and Flow history shows a normal “assigned” message. To avoid this
problem, we recommend that you follow these best practices:

1. Use a Condition activity before the Approval activity and validate the addressee in the
Condition activity.

2. Since the addressee could still be deleted after the addressee is validated in the Condition
activity, you should specify, for the Approval activity, a timeout interval and a link that
performs the desired action in case the workflow times out.

7.3 Log Activity

The Log activity is a system activity that writes messages to a log. To log information about the state
of a workflow process, the Workflow System interacts with Novell Audit.
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NOTE: Novell Audit can be configured to send its information to Novell Sentinel for additional
logging and reporting features.

During the course of its processing, a workflow can log information about various events that have
occurred. Users can then use the Novell reporting tools to look at logged data.

Before you can use logging, you must enable logging in the user application.

NOTE: During the course of workflow execution, many system events are logged that are not
controlled by the Log activity. For example, the Workflow System writes a message to the log
whenever a workflow is started or stopped, or when it is approved, denied, or refused.

+ Section 7.3.1, “Properties,” on page 239
+ Section 7.3.2, “Data Item Mapping,” on page 240
+ Section 7.3.3, “E-Mail Notification,” on page 240

7.3.1 Properties

The Log activity has the following properties:

Table 7-11 Log Activity Properties

Property Name Description
Name Provides a name for the activity.
Audit Specifies whether log messages should be sent. When this property is set to

True, messages are sent to all log4j channels, including Novell Audit. When this
property is set to False, no log messages are sent.

Author Defines the author for the message. By default, the author is the initiator of the
provisioning request.

Message Specifies an ECMA expression that defines text for the log message. Typically,
this text indicates where this Log activity is being executed within the process and
provides other information that makes the log easy to understand.

For details on building ECMA expressions, see Chapter 9, “Working with ECMA
Expressions,” on page 317. For descriptions of the system variables available in
a workflow, see Section 6.5.3, “Understanding Workflow Data,” on page 193.

Comment Specifies an ECMA expression that defines text that can be displayed in the user
comments. You might use it to record the reason for a request or a request’s
completed approval status. Some examples include:

"Reason for request: "+ flowdata.get( reason”)
or

"Process has been " +
flowdata.get(I1DM_COMPLETED APPROVAL_STATUS?)
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7.3.2 Data Item Mapping

Not supported with this activity.

7.3.3 E-Mail Notification

Not supported with this activity.

7.4 Branch Activity

In a workflow that supports parallel processing, the Branch activity allows multiple users to act on
different areas of the work item in parallel. After the users have completed their work, the Merge
activity synchronizes the incoming branches in the flow.

A workflow can have multiple Branch activities, but each Branch activity must have an associated
Merge activity. All flow paths leading out of a Branch activity will execute.

The Branch activity does not support synchronization between the branches while they are
executing. Each branch must not depend on data being updated in another branch. The data
synchronization is enforced by the Merge activity. After the Merge activity completes, all of the data
set in the branches is available.

+ Section 7.4.1, “Properties,” on page 240
+ Section 7.4.2, “Data Item Mapping,” on page 240
+ Section 7.4.3, “E-Mail Notification,” on page 240

7.4.1 Properties

The Branch activity has the following properties:

Table 7-12 Branch Activity Properties

Property Name Description

Name Provides a name for the activity.

7.4.2 Data Item Mapping

Not supported with this activity.

7.4.3 E-Mail Notification

Not supported with this activity.
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7.5 Merge Activity

In a workflow that supports parallel processing, the Merge activity synchronizes the incoming
branches in the flow. The Merge activity is used in conjunction with the Branch activity, which
allows two users to act on different areas of the work item in parallel. After the users have completed
their work, the Merge activity synchronizes the incoming branches.

A workflow can have multiple Branch activities, but each Branch activity must have an associated
Merge activity.

+ Section 7.5.1, “Properties,” on page 241
+ Section 7.5.2, “Data Item Mapping,” on page 241
+ Section 7.5.3, “E-Mail Notification,” on page 241

7.5.1 Properties

The Merge activity has the following properties:

Table 7-13 Merge Activity Properties

Property Name Description

Name Provides a name for the activity.

7.5.2 Data Item Mapping

Not supported with this activity.

7.5.3 E-Mail Notification

Not supported with this activity.

7.6 Condition Activity

The Condition activity lets you add conditional logic to a workflow. This logic can be used to
control what happens when the workflow executes. In the Condition activity, you define logic as an
ECMA expression that evaluates to a Boolean value.

Each Condition activity must have two outgoing flow paths, one that handles conditions that
evaluate to True and another that handles conditions that evaluate to False. Optionally, a third flow
path can be added to handle error conditions that occur if the ECMA expression evaluation fails.

+ Section 7.6.1, “Properties,” on page 241
+ Section 7.6.2, “Data Item Mapping,” on page 242
+ Section 7.6.3, “E-Mail Notification,” on page 242

7.6.1 Properties

The Condition activity has the following properties:
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Table 7-14 Condition Activity Properties

Property Name Description
Name Provides a name for the activity.
Condition Expression Specifies an ECMA expression that returns True or False. The

value returned determines which flow path is followed after the
activity has finished executing.

TIP: If you need to test whether two objects are equal in a
conditional expression, you should use the == operator, rather
than the equals() method, unless you are certain that the
objects being compared are Java objects of the same type.
For instance, use this expression:

(approval_A.getAction() == "DENIED™)
instead of this one:

(approval_A.getAction()) .equals('DENIED™)

For details on building ECMA expressions, see Chapter 9,
“Working with ECMA Expressions,” on page 317. For
descriptions of the system variables available in a workflow,
see Section 6.5.3, “Understanding Workflow Data,” on
page 193.

7.6.2 Data Item Mapping

Not supported with this activity.

7.6.3 E-Mail Notification

Not supported with this activity.

7.7 Mapping Activity

The Mapping activity allows you to add or manipulate data in a workflow. It evaluates the source
expression and saves the result in the target expression of the associated data items. You can use it as
a way to combine data from parallel-processed approval forms after their data is moved to flowdata.

For example, in a parallel approval context you might need to collect data from more than one
approval form that is dependent on each other or needs to be calculated with each other. To
accomplish this, place a Mapping activity after a Merge activity and before any activities that
consume the results (for example, Condition, Entity, Provisioning or another Approval activity).

You can also use the Mapping activity to isolate calls to external Java routines that might manipulate
data and be resource intensive, thereby not slowing down user-based Approval activities in either
their pre-activity or post-activity mapping phase.

+ Section 7.7.1, “Properties,” on page 243

+ Section 7.7.2, “Data Item Mapping,” on page 243

+ Section 7.7.3, “E-mail Notification,” on page 243
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7.7.1 Properties

The Mapping activity has the following properties:

Table 7-15 Mapping Activity Properties

Property Name Description

Name Provides a name for the activity.

7.7.2 Data Item Mapping

To bind the data items associated with the Mapping activity, you define pre-activity and post-activity
mappings. The pre-activity mappings initialize data in flowdata with constants, values retrieved
from the flowdata object, system process variables, system activity variables, or data retrieved via
expression calls to the directory abstraction layer. The post-activity mappings move data into the
flowdata object.

Table 7-16 Mapping Activity Data Item Mappings

Setting Description

Source Expression Specifies a source expression. When you click a cell in the
Source Expression column, the ECMA Expression Builder
displays to help you define your expression. For example,

function list() { s=new java.lang.String(Q);
if (wi.XPath("count(flow-data/groups)® ) >
0) s="There was a group selected"; return
s;}; listQ);

Target Expression Specifies a target expression. When you click a cell in the
Target Expression column, the ECMA Expression Builder
displays to help you define your expression or you can click
the Map All button. An example of a target expression is:

flowdata. testexpression

7.7.3 E-mail Notification

Not supported with this activity

7.8 Workflow Status

The Workflow Status activity lets you specify the approval status (approved or denied) for
workflows that do not contain a provisioning activity (an Entitlement or Entity).

+ Section 7.8.1, “Properties,” on page 244
+ Section 7.8.2, “Data Item Mapping,” on page 244
+ Section 7.8.3, “E-Mail Notification,” on page 244
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7.8.1 Properties

The Workflow Status activity has the following properties:

Table 7-17 Workflow Status Activity Properties

Property Description

Name Specifies the name of the activity.

Workflow Status Specifies the approval status as an expression: either Approved
or Denied.

7.8.2 Data Item Mapping

Not supported with this activity.

7.8.3 E-Mail Notification

Not supported with this activity.

7.9 E-Mail Activity

The E-Mail activity provides a way to send an e-mail to interested parties outside of an approval
process.

+ Section 7.9.1, “Properties,” on page 244
+ Section 7.9.2, “Data Item Mapping,” on page 245
+ Section 7.9.3, “E-Mail Notification,” on page 245

7.9.1 Properties

The E-Mail activity has the following properties:

Table 7-18 E-Mail Activity Properties

Property Name Description
Name Provides a name for the activity.
Notify by E-Mail Specifies whether this activity should send e-mail notifications. Set to True to

notify by e-mail; otherwise, set to False.

You specify the e-mail to send by using the E-Mail Notification tab (see
Section 7.9.3, “E-Mail Notification,” on page 245).

To use this feature, the Notify participants by E-Mail parameter for the
provisioning request definition must be set to true (see Table 4-3, “Overview
Properties,” on page 99).
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7.9.2 Data Item Mapping

Not supported with this activity.

7.9.3 E-Mail Notification

To enable e-mail notification for this activity, you need to specify the e-mail template to use, as well
as source expressions for target tokens in the e-mail body.

Table 7-19 E-Mail Notification Settings for the E-Mail Activity

Setting Description

E-Mail Template Specifies the name of the e-mail template to use. By
default, the Approval activity uses the Provisioning
Notification template.

You can edit an e-mail template in Designer. For more
information, see “Editing an e-mail template:” on
page 186.
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Setting Description

Source/Target Specifies the source expressions for target tokens in the e-
mail body.

The list of target tokens is determined by the selected e-
mail template. You cannot add new tokens, but you can
assign values to the tokens by building your own source
expressions. At runtime, source expressions are
evaluated to determine the value of each token.

The available target tokens are listed below:

¢ TO

¢ CC

+ BCC

¢ REPLYTO

* recipientFullName

+ initiatorFullName

* requestTitle

+ userFirstName
If you use a provisioning request definition template to
create your workflow, each token has a default source
expression. The default expressions retrieve values from
the workflow process (the process object) or from the data

abstraction layer (IDVault object). You can modify these
expressions to suit your application requirements.

NOTE: When you create a workflow for use with the
Resource Request portlet, and you use the “ _default_” as
the expression for the TO token, the addressee
expression must be an IDVault expression.

For details on building ECMA expressions, see Chapter 9,
“Working with ECMA Expressions,” on page 317.

NOTE: E-mail notification is supported only when the Notify participants by E-Mail check box is
selected on the Overview tab, and the Notify by E-Mail property for the activity is set to True.

7.10 Role Request Binding Activity

The Role Request Binding activity changes the approve or deny attribute in the nrfRequest object.
Two such activities are required in any workflow of Flow Type Role Approval or SoD Approval.
One Role Request Binding handles the approve condition from an Approval activity and the other
handles the deny condition from an Approval activity. The Role Request Binding activities must be
completed before the Finish activity or the workflow is considered invalid and cannot be deployed
by Designer.

+ Section 7.10.1, “Properties,” on page 247
+ Section 7.10.2, “Data Item Mapping,” on page 247
+ Section 7.10.3, “E-Mail Notification,” on page 247
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7.10.1 Properties

The Role Request Binding activity has the following properties:

Table 7-20 Role Request Binding Properties

Property Description
Name Provides a name for the activity.
Action approved: Changes the approve attribute in the nrfRequest object to true.

denied: Changes the deny attribute in the nrfRequest object to true.

7.10.2 Data Item Mapping

Not supported with this activity.

7.10.3 E-Mail Notification

Not supported with this activity.

7.11 Role Request Activity

The Role Request activity allows you to automate the granting or revoking of roles to users, groups,
or containers. For example, you might write a provisioning request definition that provisions all of
the resources and roles a new employee needs on their first day. Using the role request activity, you
can automate the approval of that employee for specified roles.

You can also configure the activity to respond to Separation of Duty (SoD) constraint overrides by
always approving, or allowing specific cases. You can use the activity to configure the effective and
expiration dates for the role, or use it to extend the expiration date of a role.

The Role Request activity runs within the system service security context.

There is no limit on the number of Role Request activities allowed within a workflow.

The Role Request activity fails if the requested role DN or the target DN is invalid, or does not exist.
The result of the role request is written as a system comment to the comment history.

The Role Request activity does not support the ability to set the originator of the request. Use SOAP
calls rather than this activity when you need this information.

+ Section 7.11.1, “Properties,” on page 247
+ Section 7.11.2, “Data Item Mapping,” on page 252
+ Section 7.11.3, “E-Mail Notification,” on page 252

7.11.1 Properties

The Role Request activity has the following properties:
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Table 7-21 Role Request Properties

Property Name

Description

Name

Description

Action

Roles

Target Type

Effective Date

Required. Provides a localizable name for the activity.

Required. Text that describes the reason for the assignment request.
This corresponds to the Initial Request Description field of the
Request Roles Assignment tab.

Specifies the action the activity should perform. Select a value from
the drop-down list. The values are:
+ grant (default): Use this value if the role should be granted.
+ revoke: Use this value if the role should be revoked.

+ extend: Use this value to extend the expiration date of the
specified role. The role must already be granted, and the value
that you specify in Expiration Date must be later than the one
currently specified.

Required. An expression that resolves to a list of requested roles. For
information on building this expression, see “Specifying the Roles and
Targets Properties” on page 250.

This is an example of the script to request a specific role:

"CN=Administer
Drugs,CN=Level10,CN=RoleDefs,CN=RoleConfig,CN=AppCo
nfig," + PROVISIONING_DRIVER

In this script example, the value is retrieved from flowdata:
flowdata.get(’Start/request_form/role”)

Required. Specifies the type of object that the requested role will be
assigned. Choose one of the values from the list. The values are:

* user (default)

+ group

* container

+ container with subtree
The date when the role assignment goes into effect. If no date is
specified, the assignment is effective immediately after it is requested.

You can use the Expression Builder convenience methods to specify
this value.

ECMASCript Objects

Today
Tomarraw

1+
1+
o Mexk week
o Mexk month
o Mexk year

o June 21, 2008
#- 0 process

'::l Flowdata
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Property Name

Description

Targets

Expiration Date

Correlation ID

SoD Override Request

Override Justification

Required. An expression that resolves to the DN of the object for
whom the role is requested. The target can be users, groups, or
containers depending on Target Type value. The targets that you
specify must resolve to the Target Type specified.

For information on building this expression, see “Specifying the Roles
and Targets Properties” on page 250.

The following examples show a script for targets:
"cn=ablake,ou=users,ou=medical-idmsample,o=novell*
To retrieve the value from flowdata:
flowdata.get("Start/request_form/group”)

The date when the role assignment expires. If not specified, the
assignment remains in effect indefinitely. You can use the Expression
Builder’s convenience methods to specify this value.

Today
Tomarraw

Mexk week
Mext month
Mexk year
June 21, 2003
+- o process

'::l flowdata

oo o oo

o

An optional string field. If not supplied, it defaults to the process
instance ID. This string must be less than or equal to 64 characters.

Optional field. Defines how the Role Request activity should handle a
request that causes an SoD constraint violation. Values are:

* true: SoD override is requested for all encountered conflicts.

+ false (default): An SoD override is not requested for all
encountered conflicts. Role Request activity uses the list of
SoDs in the SoD Overrides property to determine which SoD
constraints to override.

Optional field. Available when SoD Override Request is false.
Describes why an exception to the SoD constraint is necessary. If no
value is specified, the Description is used. This example shows how
to retrieve the value from flowdata.

flowdata.get("Start/request_form/reason”)
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Property Name Description

SoD Overrides Available when the SoD Override Request is false. It is a list of one or
more SoD constraints to override. When an SoD constraint is
encountered and the constraint is in this list, the role request activity
will request the role. It the SoD is not in this list, the role request
activity will stop executing and follow the error link.

You can use the Expression Builder’s convenience methods to build
the expression. The list contains the local list of SoDs defined for this
project. For example:

ECMAScript Objects

=+ 8 SoD Override Request
|_| Doctor-Murse

|_| test

o process
'::l flowdata

Selecting the Doctor-Nurse SoD generates an expression like this:
"cn=Doctor-Nurse,cn=SoDDefs,cn=RoleConfig,

cn=AppConfig," + PROVISIONING_DRIVER”

Specifying the Roles and Targets Properties

Designer provides a convenient way to build the Roles and Targets expressions using the Expression
Builder.

1 Click the [ button in the property’s Value column.
Designer launches this dialog box for adding or removing expressions.

@ Provisioning Request Definition Property Modification

Specify addressee expression(s) For the appraval

LI 4

Rales
IDVault, getrecipient, 'user','manager”y

(3] [ oK H Cancel ]

2 Click + to add a new Roles or Targets expression by using the Expression Builder.
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The dialog box displayed by Designer varies depending on whether you are specifying Roles or
Targets. This dialog shows an example of the dialog box displayed to specify Roles because it
includes the Search Roles button.

ECMAScrph Obfects FurchonmsMetheds. ECMASCrph Operoliors [y ——

# @ adkmaer ® i ECMANrEl 10 Logeal % (B ieriey vad
W= Approva i @ rath o (3] Rioke Yok

" & ot * @ 2

T | | T e | |

You can choose one of the ECMAScript Objects to build the Roles or Targets expression, or use
the Identity Vault button to select a specific object. Click Search Roles to locate a role.

2a To choose specify a Role, click Search Roles.

@ Role Search @

Search for Role

Select role

Search Criteria

Identifier (CH): | |
Display Marme: | |
Description: | |
Cateqgory: | b |
Role Level: | Al v|

Matching Roles

Role:

@ Canicel

2b In the dialog box, specify the CN, Display Name, Description, Role Category, and Role
Level on which you want to search.

For CN, Display Name, and Description, you can enter a wildcard (such as S*, *S) or
regular expressions (such as [A-Z][a-z]*).

You can enter a value for all of the fields or none of the fields. If you do not supply a value
in a particular field, the search returns all of the possible values for that field. If you enter
a value in one or more of the fields, the values are ANDed together to create the search
filter. The search occurs on the roles defined locally. Roles matching the search criteria are
displayed in the Matching Roles selection list.

2c Select a role from the Roles selection list, then click OK. The role is added to the
expression area.

3 Click OK after you are satisfied with expression. Repeat Step 2 to continue to add more
expressions.
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7.11.2 Data Item Mapping

Not supported with this activity.

7.11.3 E-Mail Notification

Not supported with this activity.

7.12 Resource Request Binding Activity

The Resource Request Binding activity changes the approve or deny attribute in the
nrfResourceRequest object. Two such activities are required in any workflow of Flow Type
Resource Approval. One Resource Request Binding handles the approve condition from an
Approval activity and the other handles the deny condition from an Approval activity. The Resource
Request Binding activities must be directly before the Finish activity or the workflow is considered
invalid and cannot be deployed by Designer.

¢ Section 7.12.1, “Properties,” on page 252

+ Section 7.12.2, “Data Item Mapping,” on page 252

+ Section 7.12.3, “E-Mail Notification,” on page 252

7.12.1 Properties

The Resource Request Binding activity has the following properties:

Table 7-22 Resource Request Binding Properties

Property Description
Name Provides a name for the activity.
Action approved: Changes the approve attribute in the nrfResourceRequest object to true.

denied: Changes the deny attribute in the nrfResourceRequest object to true.

7.12.2 Data Item Mapping

Not supported with this activity.

7.12.3 E-Mail Notification

Not supported with this activity.

7.13 Resource Request Activity

The Resource Request activity allows you to automate the granting or revoking of resources to
users. For example, you might write a provisioning request definition that provisions all of the
resources a new employee needs on their first day. Using the resource request activity, you can
automate the approval of that employee for specified resources.
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The Resource Request activity runs within the system service security context.
There is no limit on the number of Resource Request activities allowed within a workflow.

The Resource Request activity fails if the requested resource DN or the target DN is invalid, or does
not exist.

The result of the resource request is written as a system comment to the comment history.

The Resource Request activity does not support the ability to set the originator of the request. Use
SOARP calls rather than this activity when you need this information.

+ Section 7.13.1, “Properties,” on page 253
+ Section 7.13.2, “Data Item Mapping,” on page 255
+ Section 7.13.3, “E-Mail Notification,” on page 255

7.13.1 Properties

The Resource Request activity has the following properties:

Table 7-23 Role Request Properties

Property Name Description
Name Required. Provides a localizable name for the activity.
Resources Required. An expression that resolves to a list of requested

resources. For information on building this expression, see
“Specifying the Roles and Targets Properties” on page 250.

This is an example of the script to request a specific resource:

"CN=Administer
Drugs,CN=ResourceDefs,CN=ResourceConfig,CN=AppConfi
g," + PROVISIONING_DRIVER

In this script example, the value is retrieved from flowdata:
flowdata.get(’Start/request_form/resource”)

Description Required. Text that describes the assignment request. This
corresponds to the Initial Request Description field of the Request
Resources Assignment tab.

Action Specifies the action the activity should perform. Select a value from
the drop-down list. The values are:

+ grant (default): Use this value if the resource should be
granted.

+ revoke: Use this value if the resource should be revoked.

+ extend: Use this value to extend the expiration date of the
specified resource. The resource must already be granted, and
the value that you specify in Expiration Date must be later than
the one currently specified.

Correlation ID An optional string field. If not supplied, it defaults to the process
instance ID. This string must be less than or equal to 64 characters.

Workflow Activity Reference

253



Property Name

Description

Targets

Entitlement Params

Required. An expression that resolves to the DN of the object for
whom the resource is requested. The target must be an object of the
User class only. The targets that you specify must resolve to the
Target Type specified.

For information on building this expression, see “Specifying the Roles
and Targets Properties” on page 250.

The following examples show a script for targets:
"cn=ablake,ou=users,ou=medical-idmsample,o=novell*

Optional. A parameter required by the entitlement driver. For
example, if the entitlement operation grants access to the Sales
group, the parameter might specify the group.

Specifying a Resource and Targets Properties

Designer provides a convenient way to build the Resource and Targets expressions by using the

Expression Builder.

1 Click the C%%] button in the property’s Targets or Entitlement Params column.
Designer launches this dialog box for adding or removing expressions.

Provisioning Request Definition Property Modification

Specify target expression(s) for the resource request,

LI 4

Targets
recipient

[ Ok H Cancel ]

2 Click +to add a new Resource or Targets expression by using the Expression Builder.
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B Source ECMA Expression Builder

ECMASCrpt Objects Functions{Methods ECMASCript Operators Yault Expressions
F- o process [ == ECMASCript @-@ Logical # Tdentity Yault
0 alobal Config Values @ Math 53] Role Yault
: <> flowdata ® Relational
G' String

l Ok ] [ Cancel J [Check Svntax] [Identity 'u'ault...]

You can choose one of the ECMAScript Objects to build the Resource or Targets expression, or
use the Identity Vault button to select a specific resource.

3 Click OK after you are satisfied with expression. Repeat Step 2 to continue to add more
expressions.

IMPORTANT: You cannot specify values to the resource request form fields at the time of
resource request activity through Designer.

7.13.2 Data Item Mapping

Not supported with this activity.

7.13.3 E-Mail Notification

Not supported with this activity.

7.14 Start Workflow Activity

The Start Workflow activity allows you to invoke a workflow instance from within a provisioning
request definition. The workflows you invoke branch; they are not subflows.

You can group these related workflows by using the Correlation ID.

+ Section 7.14.1, “Properties,” on page 255
+ Section 7.14.2, “Data Item Mapping,” on page 256
+ Section 7.14.3, “E-Mail Notification,” on page 257

7.14.1 Properties

The Start Workflow activity has the following properties:
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Table 7-24 Start Workflow Properties

Property Description

Activity Id Specify a unique string value that identifies the activity. Activity Ids are
written to the user application’s log file. Specifying a meaningful Activity Id
makes it easier to understand the data written to the logs. You can specify
letters, numbers, and the underscore (_) character.

If you do not specify a value, the Activity Id defaults to ActivityNN where the
NN represents the order in which the activity was added to the workflow.

Name Provides a name for the activity.

Provisioning Request Defn  An expression that resolves to the distinguished name of the provisioning

to start request definition to invoke. You can select the provisioning request from the
Expression Builder. The possible selections are provisioning requests
whose Status is Active and whose Process Type is Normal.

Recipient An expression that resolves to one or more user or group distinguished
names.

To specify multiple values, click Recipient List (in the ECMAScript Objects
panel of the Expression Builder). This generates a pre-built function called
multirecipient(). Replace ‘Enter recipient ‘ with the distinguished name of a
user or group as needed to include all of the recipients for the workflow.

A separate workflow process is created for each recipient that you specify.

Correlation ID An expression that lets you group the workflows invoked from this activity. If
you do not supply a value, the workflow engine supplies a default, which is
the request ID of the current workflow.

7.14.2 Data Item Mapping

To pass the data needed by the workflow you want to start, you must specify data item mappings.
The data items you must specify depend on the workflow that is to be started. The Data Item
Mapping view displays the fields required by the Provisioning Request Defn to start. Because the
Provisioning Request Defn to start is an expression, it might evaluate properly only at runtime. This
would be the case in a workflow where the user could choose a workflow to start from a form field,
and that value gets mapped to flowdata, and that flowdata expression is used in the Provisioning
Request Defn to start property. To account for this, the Data Item Mapping view changes based on
whether the workflow to start can be determined at design time. If so, then the data items to start that
workflow are shown. However, if the workflow is not known at design time, then the workflow
developer must specify them.

The Start Workflow activity has the following data item mappings:

Table 7-25 Start Workflow Data Item Mapping Properties

Setting Description

Source Expression An expression used to initialize the data items needed by the Provisioning
Request Defn to Start. When you click a cell in the Source Expression
column, the ECMA Expression Builder displays to help you define your
expression.
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Setting Description

Target Form Field A read-only field that specifies target fields for the initialization data specified
in the Source Expression. If the workflow cannot be determined at design
time, this field is editable.

Data Type Specify the data type for this data item.

Multivalued A read-only field that specifies if the workflow can accept multiple values for
this parameter. If this value is true, you can specify multiple values by using
the syntax provided in the Expression Builder. If the workflow cannot be
determined at design time, this field is not present.

7.14.3 E-Mail Notification

Not supported with this activity.

7.15 Finish Activity

The Finish activity marks the completion of a workflow. When the Finish activity executes, an e-
mail message is sent to notify participants that the workflow has finished.

+ Section 7.15.1, “Properties,” on page 257

+ Section 7.15.2, “Data Item Mapping,” on page 258

+ Section 7.15.3, “E-mail Notification,” on page 258

7.15.1 Properties

The Finish activity has the following properties:

Table 7-26 Finish Activity Properties

Property

Description

Activity Id

Name

Notify by E-Mail

Specify a unique string value that identifies the activity. Activity
Ids are written to the user application’s log file. Specifying a
meaningful Activity Id makes it easier to understand the data
written to the logs. You can specify letters, numbers, and the
underscore (_) character.

If you do not specify a value, the Activity Id defaults to
ActivityNN where the NN represents the order in which the
activity was added to the workflow.

Provides a name for the activity.

Provides a method of triggering an e-mail notification when the
Finish activity is executed. When this property is set to True, an
e-mail naotification is sent. When this property is set to False, no
e-mail naotification is sent.

See Section 7.15.3, “E-mail Notification,” on page 258 for
information about setting up the e-mail notification.
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7.15.2 Data Item Mapping

Not supported with this activity.

7.15.3 E-mail Notification

To enable e-mail notification for the Finish activity, you need to specify the e-mail template to use,
as well as source expressions for target tokens in the e-mail body.

Table 7-27 E-Mail Notification Settings for the Finish Activity

Setting Description

E-Mail Template Specifies the name of the e-mail template to use. By default,
the Finish activity uses the Provisioning Approval Completed
Notification template.

You can edit an e-mail template in Designer. See “Editing an
e-mail template:” on page 186 for more information.
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Setting

Description

Source

Target

Specifies the source expressions for target tokens in the e-
mail body.

The list of target tokens is determined by the selected e-mail
template. You cannot add new tokens, but you can assign
values to the predefined tokens by building your own source
expressions. At runtime, the source expressions are evaluated
to determine the value of each token.

The available target tokens for the Provisioning Approval
Completed Notification e-mail template are listed below:

¢ TO

* CC

¢+ BCC

¢ REPLYTO

* requestStatus

¢ requestSubmissionTime

* requestiD

+ recipientFullName

¢ initiatorFullName

* requestTitle

If you use a provisioning request definition template to create
your workflow, each token has a default source expression.
The default expressions retrieve values from the workflow
process (the process object) or from the data abstraction layer
(IDVault object). You can modify these expressions to suit your
application requirements.

NOTE: When you create a workflow for use with the Resource
Request portlet, and you use _default_ as the expression for
the TO token, the addressee expression must be an IDVault
expression.

For details on building ECMA expressions, see Chapter 9,
“Working with ECMA Expressions,” on page 317.

NOTE: E-mail notification is supported only when the Notify participants by E-Mail check box is

selected on the Overview tab.
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7.16 Integration Activity

The Integration activity provides a way to use a Web service to process workflow data. For detailed
information about using the Integration activity, see Chapter 8, “Working with Integration
Activities,” on page 269.

+ Section 7.16.1, “Properties,” on page 260
+ Section 7.16.2, “Data Item Mapping,” on page 261
+ Section 7.16.3, “E-Mail Notification,” on page 262

7.16.1 Properties

The Integration activity has the following properties.

Table 7-28 Integration Activity Properties

Property Name Description

Activity Id Specify a unique string value that identifies the activity. Activity
Ids are written to the user application’s log file. Specifying a
meaningful Activity Id makes it easier to understand the data
written to the logs. You can specify letters, numbers, and the
underscore (_) character.

If you do not specify a value, the Activity Id defaults to
ActivityNN where the NN represents the order in which the
activity was added to the workflow.

Name Provides a name for the activity.

WSDL Resource Specifies a WSDL file for the Web service to be used in the
Integration activity. After it is specified, the WSDL is
incorporated into the provisioning request definition file.

When you select a WSDL file, a dialog box is displayed that
you use to select the Web service port type and operation that
you want to use in the Integration activity.

Timeout Specifies a dynamic expression that defines the period of time
allotted for the Integration activity to complete. The timeout
interval applies each time the activity is executed by the
addressee.

For details on building ECMA expressions, see Chapter 9,
“Working with ECMA Expressions,” on page 317. For
descriptions of the system variables available in a workflow,
see Section 6.5.3, “Understanding Workflow Data,” on
page 193.
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Property Name

Description

Retry Count

Final Timeout Action

Specifies the number of times to retry the activity in the event
of a timeout.

When an activity times out, the workflow process can try to
complete the activity again, depending on the retry count
specified for the activity. If the last retry times out, the activity
can be marked as success, fault, error, or timed out,
depending on the final timeout action specified for the activity.

Determines the final state of the request in the event that the
Integration activity times out. The choices are

+ success

* fault

* error

* timedout

7.16.2 Data Item Mapping

To bind the data items associated with the Integration activity, you define pre-activity and post-
activity mappings. The pre-activity mappings map values retrieved from the flowdata object to
attributes in the Input message for the Web service that will be accessed by the Integration activity.
The post-activity mappings map the response from the Web service back into the flowdata object.
For more information about data item mapping for Integration activities, see Section 8.3, “Moving
Data to and from the Integration Activity,” on page 271.

Table 7-29 Integration Activity Data Item Mappings

Setting

Description

Pre-Activity

Post-Activity

Allows you to specify one or more pre-activity mappings.
When this option is selected, you can double-click a cell in the
Source Expression column to specify where the Integration
activity gets data for a particular Web service input field.

NOTE: When the Pre-Activity option is selected, the cells in
the Web Service Input Field column are not editable.

Allows you to specify one or more post-activity mappings.
When this radio button is selected, you can double-click a cell
in the Target Expression column to specify where data from a
Web service output field should be copied after the form has
been processed.

NOTE: When the Post-Activity option is selected, the cells in
the Web Service Output Field column are not editable.
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Setting

Description

Source Expression

Web Service Input Field

Web Service Output Field

Mapping

Specifies a source expression. When you click a cell in the
Source Expression column, the ECMA Expression Builder
displays to help you define your expression. For example,
flowdata.get("Start/RequestRate/Countryl™) for
a Web service input, or Flowdata.Start/RequestRate/
Countryl for a Web service output field.

This column displays all of the input fields for the port type and
operation specified when the WSDL file was selected. The
fields in this column are automatically populated. If you want
to remove an input field, click Mapping, expand the nodes of
the sample document and deselect any input fields that you
want to remove.

This column displays all of the output fields for the port type
and operation specified when the WSDL file was selected.
The fields in this column are automatically populated. If you
want to remove an output field, click Mapping, expand the
nodes of the sample document and deselect any output fields
that you want to remove.

Displays a hierarchical view of the sample document for the
inputs to or outputs from the Web service. You can use this
feature to deselect input or output fields (by default, all Web
service input and output fields are selected).

7.16.3 E-Mail Notification

Not supported with this activity.

7.17 Entitlement Activity

The Entitlement activity grants or revokes an entitlement for a user or other entity type.

A workflow must have at least one Entitlement or Entity activity.

+ Section 7.17.1, “Properties,” on page 262

+ Section 7.17.2, “Data Item Mapping,” on page 263
+ Section 7.17.3, “E-Mail Notification,” on page 264

7.17.1 Properties

The Entitlement activity has the following properties:
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Table 7-30 Entitlement Activity Properties

Property Name

Description

Activity Id

Name

Set Workflow Status

Specify a unique string value that identifies the activity. Activity Ids are written to
the user application’s log file. Specifying a meaningful Activity Id makes it easier
to understand the data written to the logs. You can specify letters, numbers, and
the underscore (_) character.

If you do not specify a value, the Activity Id defaults to ActivityNN where the NN
represents the order in which the activity was added to the workflow.

Provides a name for the activity.

Specifies the approval status of the provisioning request. Set to True for
approved; otherwise, set to False. This method of setting workflow status
overrides other methods (for example, the Set Default Completion Status to
Approved parameter (see Table 4-3, “Overview Properties,” on page 99) or the
Approval Status activity (see Section 7.8, “Workflow Status,” on page 243).

7.17.2 Data Item Mapping

To bind the data items associated with the Entitlement activity, you define mappings for several

DirXML® attributes.

Table 7-31 Entitlement Activity Data Item Mappings

Setting

Description

Source Expression

Specifies a source expression for a DirXML mapping. When you click a cell in
the Source Expression column, the ECMA Expression Builder displays to help
you define your expression.

The DirXML mappings for the Entitlement are described below:

+ dn is the distinguished name for the recipient of the entitlement.

¢ DirXML-Entitlement-DN is the distinguished name of the entitlement to
execute. For example, the entittement might be identified as follows:

"CN=Groups,CN=GroupEntitlementLoopback,CN=TestDrivers,
O=novell"

You can use the ECMA Expression Builder's ECMAScript Variable panel
to see a list of all the entitlements in the driver. To select an entitlement,
double-click the full distinguished name of the entitlement.

+ DirXML-Entitlement-Action indicates whether the entitlement is granted or
revoked. If the operation grants the entitlement, the value must be 1; if it
revokes the entitlement, the value must be 0.

+ DirXML-Entitlement-Parameter specifies a parameter required by the
entitlement driver. For example, if the entitlement operation grants access
to the Sales group, the parameter might specify the group as follows:

“\\MYTREE\\novel IN\\idmsample-doc\\groups\\Sales*

+ DirXML-Entitlement-MultiValueAllowed indicates whether the entitlement
supports multiple values. If it supports multiple values, the value must be
True; otherwise, it must be False.
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For details on building ECMA expressions, see Chapter 9, “Working with ECMA Expressions,” on
page 317.

7.17.3 E-Mail Notification

Not supported with this activity.

7.18 Entity Activity

The Entity activity updates an entity in the Identity Vault. You can use this activity to create, modify,
or delete attributes on an entity. You can also use this activity to create or delete an entity (see
Section 7.18.4, “Working with Entity Activities,” on page 267).

A workflow must have at least one Entitlement or Entity activity.

+ Section 7.18.1, “Properties,” on page 264

+ Section 7.18.2, “Data Item Mapping,” on page 265

+ Section 7.18.3, “E-Mail Notification,” on page 266

+ Section 7.18.4, “Working with Entity Activities,” on page 267

7.18.1 Properties

The Entity activity has the following properties:

Table 7-32 Entity Activity Properties

Property Name Description

Activity Id Specify a unique string value that identifies the activity. Activity
Ids are written to the user application’s log file. Specifying a
meaningful Activity Id makes it easier to understand the data
written to the logs. You can specify letters, numbers, and the
underscore (_) character.

If you do not specify a value, the Activity Id defaults to
ActivityNN where the NN represents the order in which the
activity was added to the workflow.

Name Provides a name for the activity.

Entity Type Specifies the target entity type: User or Group.
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Property Name

Description

Operation

Set Workflow Status

Indicates what kind of operation will be performed on the target
entity:

+ Create/Modify
+ Delete attributes/values

+ Delete entity

To create or modify attributes of an entity or to create a new
entity, select create/modify. To delete attributes of an entity,
select delete.

To delete an entity, select delete object.

Specifies the approval status of the provisioning request. Set to
True for approved; otherwise, set to False. This method of
setting workflow status overrides other methods. For example,
the Set Default Completion Status to Approved parameter (see
Table 4-3, “Overview Properties,” on page 99) or the Approval
Status activity (see Section 7.8, “Workflow Status,” on

page 243).

7.18.2 Data Item Mapping

To bind the data items associated with the Entity activity, you define mappings for the attributes

associated with the target entity type.

Table 7-33 Entity Activity Data Item Mappings

Setting

Description

Entity dn

Identifies the entity that is the target of the operation. The
default value is recipient.

To create a new object, specify a distinguished name that
does not yet exist.

TIP: The output of the DNMaker control can be used as input
for the Entity dn value. The DNMaker control constructs the
DN by allowing the user to enter the naming attribute in a text
field and presenting an interface for picking a container. After
this data has been captured in a request form, the output can
be mapped to a variable in the flowdata object. In the
definition for the Entity activity, this flowdata variable can be
accessed in the Entity dn setting with an expression such as

flowdata.get("groupdn”);

For details on using the DNMaker control, see Section 5.5.11,
“DNMaker,” on page 144.
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Setting

Description

Modify Type

Modify Value Expression

Indicates how the mapping should be performed for an
attribute. The choices are

* Append Value
+ Replace Value

+ Replace All Values

For many attributes, Replace Value is the only option that
makes sense; therefore, this option is selected automatically
and cannot be changed.

You must specify the Modify Type setting before specifying
the Modify Value Expression setting.

Specifies a source expression for an attribute. When you click
a cell in the Modify Value Expression column, the ECMA
Expression Builder displays to help you define your
expression. The list of attributes available varies depending
on which entity type was selected on the Properties tab.

Designer automatically inserts a sample ECMAScript
expression into this field. The code provided varies depending
on the Operation property specified in Properties and the
Modify Type selected in Data Item Mapping. For example, if
you have specified Create/Modify for Operation, and Replace
All Values for Modify Type, Designer inserts an expression
that helps you to create a vector:

function list() { v=new java.util.Vector();
v.add("{Enter Item 1}"); v.add("{Enter Item
2}"); return v; }; listQ;

In some cases you might be able to create expressions that
work as well or better than the sample expression. For
example, instead of creating a vector for multiple attribute
values, you can create a flowdata variable (see Section 6.5.3,
“Understanding Workflow Data,” on page 193) to store
multiple attribute values, and use the getObject function to
retrieve the values of the flowdata variable (see “ECMAScript
Variables” on page 320).

NOTE: The cells in the Target Attribute column are not
editable.

7.18.3 E-Mail Notification

Not supported with this activity.

266 User Application: Design Guide



7.18.4 Working with Entity Activities

You use Entity activities to update entities in the Identity Vault. The procedures for working with
Entity activities differ slightly from the procedures for working with other activity types so this
section includes example procedures for:

+ “Adding or Modifying an Entity” on page 267

+ “Using an Entity Activity to Delete an Entity” on page 267

+ “Using an Entity Activity to Delete an Attribute or Value” on page 267

Adding or Modifying an Entity
1 From the Workflow page, click the Entity activity icon in the palette, then click the canvas to
insert the Entity activity into the workflow.
2 Click the Properties tab.

3 Click in the Value column of the Entity Type field, then select the Entity Type (for example,
User, Group) that you want to create or modify. If the target object that you specify in Step 6
already exists, the target object is modified; if the target object doesn't exist, it is created.

4 Click in the Value column of the Operation field, then select Create/Modify.
5 Click the Data Item Mapping tab.

6 Click the button next to the Entity dn field to display the ECMA Expression Builder, then
specify an expression that identifies the target of the operation (for example, “recipient”).

7 Click OK to return to the Data Item Mapping view.
8 Specify expressions for other attributes as required to create the Entity.

See Section 3.2, “Working with Entities and Attributes,” on page 49 for information about
adding entities. If you are adding an entity, you must enter expressions for all required
attributes.

Using an Entity Activity to Delete an Entity
1 From the Workflow page, click the Entity activity icon in the palette, then click the canvas to
insert the Entity Activity into the workflow.
2 Click the Properties tab.

3 Click in the Value column of the Entity Type field, then select the Entity Type (for example,
User, Group) to which the entity that you want to delete belongs.

4 Click in the Value column of the Operation field, then select Delete entity.
5 Click the Data Item Mapping tab.

6 Click the button next to the Entity dn field to display the ECMA Expression Builder, then
specify an expression that identifies the Entity that you want to delete.

7 Click OK to return to the Data Item Mapping view.

Using an Entity Activity to Delete an Attribute or Value

1 From the Workflow page, click the Entity activity icon in the palette, then click the canvas to
insert the Entity activity into the workflow.

2 Click the Properties tab.
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3 Click in the Value column of the Entity Type field, and select the Entity Type (for example,
User, Group) of the entity to which the attribute or value that you want to delete belongs.

4 Click in the Value column of the Operation field, and select Delete attribute/value.
5 Click the Data Item Mapping tab.

6 Click the button next to the Entity dn field to display the ECMA Expression Builder, then
specify an expression that identifies the entity that contains the attribute or value that you want
to delete.

7 Click OK to return to the Data Item Mapping view.

8 Click in the Delete Type field for the attribute to which you want the operation to apply, then
select the operation from the list:

+ Select Delete Attribute for single-value attributes

+ Select either Delete Attribute or Delete Value for multi-value attributes. Selecting Delete
Value for multi-value attributes also requires that you enter an expression to identify the
value that you want to delete.

9 To delete a value, click in the Delete Value Expression field for the attribute to which you want
the operation to apply, then specify an expression that resolves to the value of the attribute that
you want to delete.
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Working with Integration Activities

This section provides details about working with Integration activities. Topics include:

*

Section 8.1, “About the Integration Activity,” on page 269

*

Section 8.2, “Adding an Integration Activity,” on page 269

*

Section 8.3, “Moving Data to and from the Integration Activity,” on page 271

*

Section 8.4, “Using the Integration Activity Editor Interface,” on page 274

*

Section 8.5, “Actions,” on page 287

8.1 About the Integration Activity

The Integration activity is an activity that allows workflows to exchange data with arbitrary Web
services. Data sent to a Web service can integrate an individual workflow with other systems, inside
and outside the organization. Data received from a Web service can provide decision support
information on approval forms.

You create flowdata variables to move data from the workflow to the Web service for processing.
The Integration activity automatically creates an action model for working with a Web service based
on a WSDL document that you specify.

NOTE: The action model is a subset of the features available in the Novell Integration Manager
product (formerly known as Novell exteNd Composer).

An action model is a visual representation of a set of instructions for processing XML documents
and communicating with XML data sources. An action model performs all data mapping, data
transformation, and data transfer within an Integration activity. You can edit the action model to
manipulate data before and after the data is submitted to the Web service. You then map the data
from the Integration activity back to flowdata variables for use in the workflow.

8.2 Adding an Integration Activity
1 Create a provisioning request definition (see Chapter 4, “Configuring Provisioning Request
Definitions,” on page 85).

2 Create a workflow for the provisioning request definition (see Chapter 6, “Creating the
Workflow for a Provisioning Request Definition,” on page 177).

3 Click the Workflow tab.

4 Drag an Integration activity from the palette and place it in the desired location in the
workflow.
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6 Type a name for the activity in the Name field.

7 Click the Value field for the WSDL Resource property, then click the browse button to display a

dialog box that you use to locate the WSDL file for the Web service that you want to access
with the Integration activity.

8 Use the dialog box to browse your file system to locate the WSDL file for the Web service that

you want to use. Click the name of the WSDL file, then click Open to return to the Properties
tab.

A dialog box that you use to select a port type and operation for the Web service is displayed.
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The Select Port Type list includes a set of port types supported by the Web service. Each port
type supports operations that include the input and output messages of the operation.

9 Select a port type from the list.
10 Select an operation from the Select Operation list.
11 Click OK.

The Integration activity creates an action model based on the WSDL document.You use the
action model at design time to test the input to the Web service, test the response from the Web
service, and map and transform data, if necessary, before returning the data to the workflow.

For many Web services, you don’t need to concern yourself with the action model. You simply
create data item mappings for the Integration activity. After the action model is created, a new
tab, Integration, is added to the provisioning request definition editor. You use this tab to access
the action model.

12 Specify the Timeout Interval, Retries, and Final Timeout Action properties (see Section 7.16,
“Integration Activity,” on page 260).

13 If you want to view or edit the action model, click the Integration tab.

Cierisn | SiarkFlow | Farms | Signature Declarations lIntegratiDn o

8.3 Moving Data to and from the Integration
Activity
1 Create form fields to allow users to provide input to the Web service accessed by the
Integration activity (see Chapter 5, “Creating Forms for a Provisioning Request Definition,” on

page 109). For example, if you are working with a Web service that provides stock quotes, you
need a field for the user to specify a stock symbol.

2 To move user input from the form to the workflow, create a flowdata variable in an activity that
precedes the Integration activity in the workflow.

See Section 6.5.3, “Understanding Workflow Data,” on page 193 for information about
creating flowdata variables.

For example, if you have created a form field called “symbol” to accept a stock symbol for
input to the Web service, you would go to the post-activity data item mapping for the activity
associated with the form that contains the symbol field, then you would map the symbol field to
a flowdata variable (for example, flowdata.symbol).

3 In the Workflow tab, right-click the icon for the Integration activity, then choose Show Data
Item Mapping.

The Data Item Mapping tab is displayed.
4 In the Data Item Mapping view, click Pre-Activity.

In the Web Service Input Field grid, you should see fields that match all of the input fields
associated with the port type and operation specified in Step 9 and Step 10 on page 271.

The integration activity automatically selects all of the input field associated with the port type
and operation. You can remove the input fields or modify properties of the input fields by
following this procedure:

4a Click Mapping.
The Sample Document dialog box is displayed.
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4d Type the maximum number in the Enter Repeats dialog, and click OK
4e Click OK to return to the Data Item Mapping view.

5 For each Web Service Input Field, click in the Source Expression field, then click the ECMA
Expression Builder button.

Properties | Email Motification "f-':,- Data Ikem Mapping X Paolicy Set | Dataflow| =0
& pre Ackivity " Post Ackivity Mapping. .. |

Source Expression | ‘Web Service Input Field | Data Type

% | GetquoteSoapIn/GetQuots)symbol skring

4] | -l

The ECMA Expression Builder is displayed.

6 Expand the flowdata node in the Ecmascript Variables pane of the ECMA Expression Builder,
then double-click the flowdata variable for the user input to the Web service.

E’}gSource ECMA Expression Builder gl =l
ECMASCript Yariables Functions/Methods ECMASCript Operators WD Expr Panel
- 8 process [ *3 ECMASCript -0 Math -8l User
E|'::l flowdata - =2 Global Functions @ Relational Group
E|'::l Start @ Logical User Lookup
:l RequestSymb @ String Task Group

Task Manager Lookup
*-[#l Manager Laokup

|/ — D K

Flowdata, get('Start/RequestSymbol/Symbal)y

Ok I Cancel Check Syntax | Identity Yault...

7 Click OK to return to the Data Item Mapping view.
8 Click Post Activity.

In the Web Service Output Field grid, you should see fields that match all of the output fields
associated with the port type and operation specified in Step 9 and Step 10 on page 271.

9 The Integration activity automatically selects all of the output fields associated with the port
type and operation. If you want to remove some of the output fields, follow these steps:

9a Click Mapping.
The Sample Document dialog box is displayed.

9b Expand the nodes of the sample document and deselect any attributes that you want to
remove.

9c Click OK to return to the Data Item Mapping view.
10 Click Map All to automatically create flowdata variables for each Web Service Output Field.
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Alternatively, for each Web Service Output Field, click in the Source Expression field, then
click the ECMA Expression Builder button.

11 Expand the flowdata node in the Ecmascript Variables pane of the ECMA Expression Builder,
then double-click the flowdata variable that will receive data from the Web service.

12 Click OK to close the ECMA Expression Builder.

Now you can work in the Integration view to test and refine the interaction with the Web
service.

8.4 Using the Integration Activity Editor Interface

The Integration activity editor provides a working environment for the input, output, and actions of
the Integration activity. The Integration activity editor is composed of three views: Action Model,
WSDL Editor, and Messages.

Figure 8-1 Integration Activity Interface
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+ Section 8.4.1, “XML Views,” on page 275
+ Section 8.4.2, “Action Model,” on page 279
+ Section 8.4.3, “WSDL Editor,” on page 285
+ Section 8.4.4, “Messages,” on page 286
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+ Section 8.4.5, “Regenerating Code for the Action Model,” on page 286
+ Section 8.4.6, “Adding Actions to the Action Model,” on page 286

8.4.1 XML Views

The Integration activity provides a number of XML views (for example, Input and Output messages,
WSDL Editor, Messages) derived from the WSDL document. These views use a common interface.

+ “Tree View” on page 275
+ “Source View” on page 278

Tree View

You use the Tree view to work with a hierarchical view of an XML document. You display the Tree
view by clicking the Tree tab.

Figure 8-2 Tree View
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+ “Tree View Editing Features” on page 275
+ “Tree View Menu” on page 276

+ “Tree View Toolbar” on page 276

+ “Attaching a Schema or DTD” on page 277

Tree View Editing Features
The Tree view provides the following editing features:
+ You can edit attribute values, attribute name, namespace names and values, text, and
comments.

+ You can insert new nodes by using the menu that is displayed when you right-click within the
Tree view. The menu allows you to insert nodes as children before or after the selected node. If
the node is an element, you can insert attributes. The submenus for Add Child, Add After, and
Add Before contain the node that can be legally added. If no schema or DTD is associated with
the document, the submenus contain New Attribute or New Element.

+ You can delete a node by right-clicking a node and selecting Remove.
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+ You can drag and drop items between Tree views (for example, between views of the Input and
Output messages) to create Map actions (see Section 8.5.8, “Map,” on page 309 for
information about Map actions).

+ You can undo, redo, cut, copy, and paste.
Tree View Menu

When you right-click an item in the Tree view, a menu is displayed that you use to perform
operations on the XML document. The menu is context-sensitive and only displays the commands
that are appropriate for the item you clicked.

Table 8-1 Tree View Menu

Item Description

Remove Removes the selected item.

Add DTD Information  Displays a dialog box that you use to add DTD information. You can edit the
Root Element Name, Public ID, and System ID.

Edit Namespaces Displays a dialog box that you use to add namespace declarations.
Add Attribute Displays a dialog box that you use to define a new attribute.
Add Child Displays a submenu with the following options:
Add Before Comment
Add After Add Processing Instruction
#PCDATA

CDATA Section
New Element

Replace with Replaces the selected item with an item selected from the menu.

Tree View Toolbar

Tree view toolbars provide the following features:

Table 8-2 Tree View Toolbar

Button Description

um Expands all nodes in the document.
Collapses all nodes in the document.
Attaches a schema or DTD (see “Attaching a Schema or DTD” on page 277).

3]
@ Displays online help.
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Attaching a Schema or DTD

You can attach a schema or DTD to the current XML document when you are using the Tree view.

1 Click @ in the Tree view toolbar. The Attach Schemas or DTD dialog box is displayed.

Attach Schema or DTD

Attach schema or DTD by either choosing an entry from the XML Catalog
or point to an XML schema or DTD in the file system

x|

7 WML Schema © DTD

¥ML Catalog Entry:

(7) lol’4 I

Cancel |

2 To choose from a list of entries in the XML catalog, choose an entry from XML Catalog Entry

list.

3 To specify an XML schema on disk, click XML Schema.

Attach Schema or DTD

Specify XML schema namespace URI and XML Schema file,

x|

Mamespace LIRI: |

File: |

(7) lol’4 I

Cancel |

o

4 Type a Namespace URI, then use the browse button in the File field to select an XML schema

on disk.

5 To specify a DTD on disk, click DTD.
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P x|
Attach Schema or DTD
Specify DTD identifiers and DTD file.

Publid ID: |

Syskern [0y |

Files | _|
(7) (0] I Cancel |

6 Type a Public ID and System ID, then use the browse button in the File field to select the DTD
file on disk.

Source View

You use the Source view to view the XML source of the document. You display the Source view by
clicking the Source tab.

Figure 8-3 Source View

<?xml version="1.0" encoding="UTF-5"7> ;I
<GetOuoteSoapIn:
<GetQuote xmlns="http://wyw,vebserviceX . NET/" xmlns:xsd=
<!--Element 'sywhol' is optional--»
<!==The walue of the attribute 'type' is 'string'--»
<aymbols%§AA</ symbols>
</ GetQuoter
</GetQuoteSoapIn>

v
1 | 3

Tree | Source

+ “Source View Features” on page 278
+ “Source View Menu” on page 278

Source View Features
The source view supports the following features:
+ Syntax highlighting.
+ Context-sensitive code-completion based on DTD or XML Schema.

+ \alidation as you type. If the XML is invalid (for example, the closing bracket is omitted from
a tag), the editor indicates the error.

+ General text editing operations such as undo, redo, cut, copy, paste, and select all.
Source View Menu

When you right-click an item in the Source view, a menu is displayed that you use to perform
operations on the XML document.
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Table 8-3 Source View Menu

Item Description

Undo Reverses the last action.

Redo Reverses an undo operation.

Cut Cuts the selected text to the clipboard.

Copy Copies the selected text to the clipboard.

Paste Pastes the clipboard contents at the insertion point.

Delete Deletes the selected text.

Select All Selects all of the text in the document.

Find Displays a dialog box that you use to find and replace text within the document.

8.4.2 Action Model

The action model includes the Action Model view and views for displaying message parts. The
Action Model view displays actions that operate on the contents of the message parts. The message
parts display the XML for the Web service Input and Output messages.

+ “About the Action Model Views” on page 279

+ “About the Input View” on page 279

+ “About the Output View” on page 280

+ “About the _SystemFault View” on page 280

+ “About the Action Model Pane” on page 281

+ “Animation” on page 283

About the Action Model Views

The action model views are used at design time to test the interaction with the Web service. You edit
actions in the Action Model view. You can enter test data to be input to the Web service in the Input
view, examine the response from the Web service in the Output view, and see any error messages
returned from the Web service in the _SystemFault view. The Integration activity has the following
message panes:

+ Input view

+ QOutput view

+ _SystemFault view

+ Action Model view

About the Input View

The Input view displays the input message derived from the WSDL document for the Web service.
You can resize the view by dragging the right border.You can resize columns within the view by
dragging the column border. You can specify a value to use in testing the action model directly in the
Input part, in which case the value is discarded after executing the action model. You can also
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specify a value using the Messages tab (see Section 8.4.4, “Messages,” on page 286), in which case
the value persists until you delete the value or you regenerate the action model (see Section 8.4.5,
“Regenerating Code for the Action Model,” on page 286).

Figure 8-4 Input View

Input + - | (5] | &
=7 vl
=l [8] getRateRequest
xmins
8] countryl
le] country2

Tree | Source |

About the Output View

The Output view displays the output message derived from the WSDL document for the Web
service. When you execute the action model, you use the Output view to view the values returned
from the Web service.

You can resize the view by dragging the left border.You can resize columns within the view by
dragging the column border. You can specify a value directly in the Output part for modeling
purposes, in which case the value is discarded after executing the action model. You can also specify
a value by using the Messages tab (see Section 8.4.4, “Messages,” on page 286), in which case the
value persists until you delete the value.

Figure 8-5 Output View

Cukput + [ | |5] | @
T2
=l [8] getRateResponse
®mins
e8] Result

Tree | Source |

About the _SystemFault View

The _SystemFault view displays any error messages produced when you execute the action model.
The XML information contained in _SystemFault is also written to a global object called ERROR.
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Figure 8-6 _SystemFault View

_SystemFaulk + = | (5] | ®
P2 xml
=l [8] rmiFaultInfo
wmins:m
[e] m:ComponentMame
[e] m:DateTime
[e] m:MainCode
[e] m:5SubCode
[e] m:Message

Tree | Source |

Beneath the FaultInfo root are the following elements:

+ DateTime contains the Date and Time at which the fault occurred.

+ ComponentName contains the name of the component that threw the fault.
+ MainCode contains the main code number for the error.

+ SubCode contains a sub-code number for the error.

+ Message contains the error message defined when you set up a Throw Fault action (see “Throw
Fault” on page 289). If you do not specify an error message in your Throw Fault action, the
following message is displayed: “A user-defined Fault occurred!”. If the error occurred
within a Try/On Fault action, and you did not specify a Fault, this element is populated with an
Exception message.

About the Action Model Pane

The Integration activity has a single action model. The action model represents the mappings,
transformations, and other actions that is performed on the Web service input and output messages.
The Action Model view is resizable. Most of your activity that takes place in the Action Model view
involves adding and editing actions.

+ “Action Model Context Menu” on page 281
+ “Finding and Replacing Text in the Action Model” on page 282

Action Model Context Menu

If you right-click in the action model, a menu is displayed.
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Figure 8-7 Action Model Menu

Mew Ackion 4
Edit Action. ..

Disable Action

Toggle Breakpoint

i ‘:l —r =

Clear all Breakpoints

Zuk
Capy

Paste

x . uile U%"

Delete. ..

Find/Replace. ..
Find Mexk

From this menu, you can add or edit actions (see Section 8.5, “Actions,” on page 287), toggle
breakpoints in the action model (see “Animation” on page 283) and perform other tasks.

Finding and Replacing Text in the Action Model
You can replace a word or string by using the Replace command on the action model menu.

1 Right-click in the action model, then select Replace.

-iBfx]
Search for:

[ Replace with:

options:

v Ignore case

[ whole word

(7) ok, I Cancel

2 Specify the search text.

3 If you want to replace the search text, click Replace with, then type a string to replace the
search string.

4 If you want to find the search text regardless of the capitalization of the text, click Ignore case.
5 If you want to find the search text in whole words only, click Whole word.
6 Click OK

The Integration activity finds the first occurrence of the search text. If the operation is a find
and replace operation, the Integration activity asks you to confirm the replacement. You can
then replace the next or all occurrences of the search text.
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Animation

The action model provides animation tools that you can use to test and troubleshoot actions
interactively within the Integration activity. You can execute the action model step by step and
watch the result of each action. Not only do you see any errors as they happen, but you can verify, in
real time, that connections and data behaved as you planned.

The animation tools allow you to toggle one or more breakpoints. You can use this feature to
concentrate on a particular section of an action model. When used in conjunction with the run-to-
breakpoint tool, breakpoints allow you to quickly run through action model sections that work
properly, coming to a stop at a particular action. From there, you can step through each action in
sequence. You can also step over loops and other code blocks that would otherwise be tedious to
execute step-by-step.

The Basic Animation Tools

The animation tools are available on the Designer toolbar.

Figure 8-8 Animation Toolbar

U F-BEREFOI

Table 8-4 Animation Tools

Animation Toolbar

Button Name Description

c Execute Executes the action model.

q Execute Current Executes the currently selected action.

Action

N Start Animation  Starts the animation process. Enables Step Into, Step Over, and
Run to Breakpoint/End.

End Animation  Stops the animation process.

Bi Step Into Executes the currently selected action and highlights the next
sequential action.
For a Repeat Loop action, clicking Step Into executes each action
in the loop and iterates through each loop.
For a Decision Action, Step Into processes the next action in the
True or False branch.
For the Try/On Fault action, Step Into processes the next action
inside the execute branch, and possibly the On Fault branch.

Ei Step Over Executes the currently selected action and highlights the next
sequential action. Unlike the Step Into button, clicking this button
does not highlight and execute the details of Repeat, Decision, or
Try/On Fault actions.

">i Run To Runs the animation to the next breakpoint or to the end of the

Breakpoint/End action model if there are no breakpoints.
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Animation Toolbar

Button Name Description
@ Toggle Sets the selected action in the action model as a breakpoint. You
Breakpoint may set more than one breakpoint. Another way to toggle a
breakpoint is to right-click the desired action and select Toggle
Breakpoint from the menu.
Pause Pauses the animation.
i I Animation

Starting Animation

When you first open an Integration activity, Start Animation and Toggle Breakpoint are the only
enabled buttons. When you click Start Animation, the rest of the animation buttons are enabled. If
you want to halt the animation temporarily, you can use the Pause Animation button. If you want to
abort the animation, you can do so at any time by clicking End Animation.

Although Copy, Paste, and action editing operations (including adding new actions) are all available
at animation time, we recommend that you do not edit the action model during animation. If you do,
exceptions or unpredictable behavior can occur. If you need to edit the action model, use End
Animation to stop the animation first. Then apply your edits and begin the animation again.

1 Open an Integration activity.

2 Click Start Animation button in the Designer toolbar. All of the animation buttons become
active except the Start Animation button, which is now dimmed.

3 Follow the instructions in the following sections to perform the desired Animation activity.

Toggling a Breakpoint

You use the Toggle Breakpoint tool to set a breakpoint in the action model where you want the
animation process to stop. This is helpful if you have a lengthy action model with long sections that
work properly. You can set the breakpoints for each action that is causing a problem and then step
through the action to troubleshoot it.

1 Inthe Action pane, select the action for which you want to set a breakpoint. This is where the
animation will stop.

2 Click Toggle Breakpoint on the Designer tool bar, or right-click the action and select Toggle
Breakpoint. A dot appears in the left border of the action model to indicate the breakpoint.

3 If desired, repeat the previous steps to select additional breakpoints.

Stepping Into an Action

Step Into runs the selected action in the action model and then moves to the next action in the
sequence. You can use the Step Into tool to step through each action in the entire action model, or
you can use it in conjunction with the Run to Breakpoint tool. Execution stops at the next breakpoint
or when the action model ends, whichever comes first.
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A possible scenario for using a breakpoint would be if you have ten actions that you know work
properly but have doubts about the eleventh. You could set the eleventh action as a breakpoint,
execute the Run to Breakpoint tool, and then step through the eleventh (and subsequent) actions by
executing the Step Into tool.

1 Start the animation (see “Starting Animation” on page 284).

2 Click Step Into. The first action in the action model is selected.

3 Click Step Into again. The selected action executes and the next action is selected.

4 Continue to work through the action model by clicking Step Into after each action executes and
the subsequent action is selected.

Stepping Over an Action

You use Step Over when you don’t want to step into the details of the Repeat, Decision, or Try/On
Fault actions. You can execute an entire block of code without stepping individually through each
action.

You can use Step Over in conjunction with Run to Breakpoint. For example, you can toggle a
Breakpoint, execute Run to Breakpoint, and then use Step Over to execute the action designated as
the breakpoint. Step Over can save a great deal of time when testing lengthy action models, because
you can avoid tediously stepping through individual actions.

1 Start the animation (see “Starting Animation” on page 284).

2 Step through the action model with Step Into until you reach a loop or other line of code that
precedes an indented code block.

3 Click Step Over. The first action after the block of indented code is selected. All of the indented
code executes normally and you are taken straight to the next block of actions, without stepping
through the indented actions.

4 Continue to work through the action model by clicking Step Over as needed.
5 Continue to click Step Into and StepOver to execute all of the actions in the action model.

Pausing Animation

You use Pause Animation to pause the execution of an action in the action model. This is especially
helpful in cases in which the action model contains lengthy loops.

1 During the execution of an action, click Pause Animation.

2 To resume the animation process, click Step Into, Step Over, or Run to Breakpoint (if a
breakpoint has been set).

Aborting Animation

You use Stop Animation to stop the animation process. After you stop the animation, you cannot
restart from the place where you left off. You must restart from the beginning of the action model.

8.4.3 WSDL Editor

The WSDL Editor displays the WSDL document for the Web service. You can edit the WSDL by
using the Tree view and Source view editing features (see “Tree View” on page 275and “Source
View” on page 278).
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8.4.4 Messages

The Messages view displays the messages derived from the WSDL document for the Web service.
You can edit the messages using the Tree view and Source view editing features (see “Tree View” on
page 275 and “Source View” on page 278). You can use this feature for entering test data that is used
when you execute the action model at design time. Data that you enter in the Messages view persists
across executions of the action model.

8.4.5 Regenerating Code for the Action Model

When working in the WSDL Editor view, you can regenerate all code for the action model and
regenerate messages by clicking the Regenerate button. When working in the Messages view, you
can regenerate all actions in the action model. The Regenerate button is located in the Designer
toolbar:

Figure 8-9 Regenerate Button

Regenerate button

%Designer
File Edit Wew Project Tools Liwe PRD  Window Help

IO e 2 [ @ e el

8.4.6 Adding Actions to the Action Model

Actions are the processing steps that take place within the Integration activity. A collection of
actions is referred to as an action model. An action in the action model is displayed as a line and
contains an icon for the action type along with an abbreviated definition of the action. Some actions
are subordinate to other actions. For example, you can create a Repeat action that controls loop
processing, then add actions inside the loop. The actions inside the loop are subordinate to the
Repeat action and appear indented beneath the Repeat action. Subordinate actions process as long as
the Repeat action is True.

To add an action to the action model, click the line in the action model that is one line above the
position in which you want to insert an action. Add an action by using any of following methods.
The new action is inserted below the line you selected.

+ Drag and drop. You can add Map actions by dragging and dropping elements from the Input
view to the Output view.

+ Copy and Paste. You can copy an action in the Action Model view and paste it somewhere else
in the view.

+ Right-click the line in the action model that is one line above the position in which you want to
add the action, then select the desired action from the menu.

NOTE: You can reorder actions in the action model by dragging actions to a new position within the
action model.

After you have created the action model, and before you , you should test the action model. Perform
testing by using the Animation tools. With the Animation tools, you can set breakpoints, start an
animation, step into and over actions, and pause the animation. See “Animation” on page 283.
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8.5 Actions

This section describes the actions that are available for use within an action model. An action is
similar to a programming statement in that it takes input in the form of parameters and performs
specific tasks. An action model is a set of instructions for processing XML documents and
communicating with XML data sources. An action model performs all data mapping, data
transformation, and data transfer within an Integration activity. All actions within an action model
work together.

At runtime, every action is converted to an executable form of ECMAScript and processed. At
design time, many actions accept ECMAScript expressions as parameters, adding great flexibility
and control to the action model. The Function action provides you with the most flexibility and
control by giving you access to the full functionality of the ECMAScript language.

This section contains the following topics:

+ Section 8.5.1, “Advanced,” on page 287

+ Section 8.5.2, “Data Exchange,” on page 293
+ Section 8.5.3, “Repeat,” on page 298

+ Section 8.5.4, “Comment,” on page 305

+ Section 8.5.5, “Decision,” on page 306

+ Section 8.5.6, “Function,” on page 307

+ Section 8.5.7, “Log,” on page 308

+ Section 8.5.8, “Map,” on page 309

8.5.1 Advanced

This section includes descriptions of the following actions:

+ “Apply Namespaces™” on page 287
+ “Throw Fault” on page 289
+ “Try/On Fault” on page 291

Apply Namespaces
This section includes the following topics:

+ “About the Apply Namespaces Action” on page 287
+ “Creating an Apply Namespaces Action” on page 288

About the Apply Namespaces Action

Ideally, an Integration activity always receives valid XML documents (that is, the documents
validate against their schema, map and transform data appropriately, and send valid XML
documents). However, this might not always the case. In other cases you might want to ignore
namespaces altogether. It is important to have some means of validating XML documents. These
and many other XML processing cases require a method of modifying or overriding the prefix and
namespace handling provided by the Integration activity.
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The Apply Namespaces action provides a mechanism for managing namespaces and namespace
prefixes in effect for input and output messages within an action model. The action allows you to
consolidate namespace and prefix declarations for a Web service in one place, to override those
declared in the input and output messages, or to ignore namespaces altogether.

The Apply Namespaces action can be applied to input and output messages. You can also have
multiple Apply Namespaces actions for an individual message part, effectively changing
namespaces based on conditions specified in the action model. The namespaces declared are in
effect until the end of the action model is reached or another Apply Namespaces action is executed.
In other words, only the most recent Apply Namespaces action is in effect.

When creating a new Integration activity, an Apply Namespaces action is created automatically for
the Output message if the WSDL declares any namespaces. After component creation, you can
manually create additional Apply Namespaces actions.

Creating an Apply Namespaces Action

1 Right-click the line in the action model that is one line above the position in which you want to
place the Apply Namespaces action (the new action is inserted below the line that you
selected).

2 Select New Action > Advanced > Apply Namespaces.

i

This action allows you to manage the use of namespaces in any message part of a component. You can set the namespaces in effect for any 1
Apply the following namespaces for Park:  Output LI

o am

Iamespace | Prefix

« | ol

Opkions: |- Ignore namespaces when part is used in an ¥Path expression

¥ Declare these namespaces in the part

Target document Rook Element Mame: I 3etBMCQUoteSoapOut

Help | [0]4 I Cancel |

3 Select the message (Input, Output, _SystemFault, or Project) to which you want to apply the
namespace from the Apply the following namespaces for Part list.

4 Click the plus (+) icon to add a new row, then click the Namespace column and type a
namespace URI.
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The table displays all the Namespace declarations for the selected message part. After creating
a new Apply Namespaces action, the table might or might not contain a list of declarations for
a selected part. The list of declarations is initially constructed from the declarations defined in
the WSDL.

Within the declaration list for a message part, prefixes must be unique. However, you can have
duplicate namespace URIs if the URIs have unique prefixes. This allows you to declare
multiple prefixes that are associated with the same namespace URI.

5 If desired, click Ignore Namespaces when document is used in an XPath expression.

Use this option when you want Map action source XPaths to find elements by their XML local
name only.

This provides for a less restrictive method of specifying Map actions (see Section 8.5.8, “Map,”
on page 309) and is useful when Map actions contain the wrong prefix or no prefix in their
Source specifications. This allows you to place the Apply Namespaces action inside a Decision
action (see Section 8.5.5, “Decision,” on page 306) that tests whether the Input message
contains prefixes or not, yet still have one set of Map actions to map the input to another part.
In other words, the Integration activity normally expects the input to contain prefixes, so you
design all your Map actions with prefix names. For the occasional input that has no prefixes,
the Decision action activates the Apply Namespaces action defined to ignore namespaces for
input, allowing the Map actions to work in either case.

6 When you want to declare a set of namespaces in the root element of an output message built
by your action model, click Declare these namespaces in the part.

This option is almost always checked for output to ensure that prefixed elements created in the
output, as a result of Map actions, resolves to the proper namespaces.

This allows a recipient of the output to validate the document properly. The Apply Namespaces
action with this option checked could also be used to add new declarations to an existing
document that already contains declarations.

The Target document Root Element Name is used to specify the name of the root element to
contain the Namespace declaration attributes. The Integration Activity automatically fills in
this value based on the information in the WSDL document and the message part specified in
the Apply the following namespaces for Part list.

7 Click OK. The new action is added to the action model.

Throw Fault
This section includes the following topics:
+ “About the Throw Fault Action” on page 289
+ “Adding a Throw Fault Action” on page 290
About the Throw Fault Action
You use the Throw Fault action to do the following:

+ Write information to an XML message on failure of an action
+ Perform any number of actions before throwing the fault
+ Halt execution of a component
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Throw Fault is only executed when a condition that you specify is true. The message part that is
written when a Throw Fault action is executed is called a Fault document, and the XML within this
message is contained in a global object called ERROR.

Throw Fault actions can be used in a number of ways:

+ Using a Throw Fault Action by itself. You can specify a Fault Condition and an error message
within the Throw Fault Action dialog. When the action is executed, the Fault Condition is
evaluated. If the condition evaluates as True, the following occurs:

+ Any Before Throw actions that you specify are executed. This can be very useful as a way
to leave your application in a particular state before halting execution. For example, you
can send a mail message stating that the execution did not complete.

+ The contents of the error message are written to the Fault document in a node that you
specify, as well as to the global object ERROR.

+ The action model execution is halted.

+ Using a Throw Fault Action within a decision expression in the Decision action. You can
specify a fault condition by entering it in the decision expression of a Decision action. Then put
a Throw Fault statement in the True branch of the Decision action. Here you can either specify
additional conditions in the Throw Fault fault condition or leave it blank and simply specify the
fault document to which the fault information should be written. When the action is executed
and all your conditions are True, the Throw Fault action is executed. If the fault condition in the
Decision action or Throw Fault action is False, the next action in the action model is executed.

+ Using a Throw Fault inside a Try /On Fault action (see “Try/On Fault” on page 291. By putting
either of the above methods inside the execute branch of a Try /On Fault action, you prevent the
Integration activity from halting execution and have an opportunity to respond or recover from
the fault. You create your fault condition by using one of the previous two methods inside the
execute branch of a Try/On Fault action after other actions the output of which you want to test
have worked correctly. You can specify any number of unique faults so that the Integration
activity can branch into several different directions, depending on which fault occurs. When the
Throw Fault action for the given fault is triggered, instead of halting execution of the
component, control passes into the appropriate branch of the Try/On Fault action. Here you can
specify other actions to remedy or respond to the error.

Adding a Throw Fault Action

1 Right-click the line in the action model that is one line above the position in which you want to
place the Throw Fault action (the new action is inserted below the line that you selected).

2 Select New Action > Advanced > Throw Fault.
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E‘.‘throw Fault = |
Fault Condition:
% Thraw {System}{Fault}
Error Message (e.g. Fault/FaultInfo/Messagel:
A -
=
 Throw Defined Fault
_SystemPFault j k-
Help | OF I Cancel |

3 In the Fault Condition field, type a valid ECMAScript expression that, when True, causes the
action to throw a fault.

You can also click the ECMA Expression Builder button and build an expression (see
Chapter 9, “Working with ECMA Expressions,” on page 317).

4 Select Throw {System}{Fault} to write your error message to the _SystemFault document.

By default, the message that you type in the Error Message field is placed in the Fault/
Faultinfo/Message node of that document. Specify a different node if desired. You can also
click the ECMA Expression Builder button and build an expression.

5 Select Throw Defined Fault to select a fault document that is one of the message parts
associated with the Integration activity.

6 Click OK.
The new action is added to the action model. Place any actions that you wish to execute before
the application stops in the Before Throw Actions branch.

teSoapOut)GetBHNQuoteR esponse/GetENGQuoteResult" }=="" THROW FALLT _SystemFault _SystemFauIt.XPath("m:FauItInFo,l’m:I\";I

- W LG "Execution stopped at "+Datel) TO System Oukput using Log Level 5 ‘j

Try/On Fault
The section includes the following topics:

+ “About the Try/On Fault Action” on page 292
+ “Adding a Try/On Fault Action” on page 292

Working with Integration Activities 291



About the Try/On Fault Action

The Try/On Fault action executes a set of actions when a fault occurs within the Execute branch of
the Try/On Fault action. Any number of defined faults can be specified within the Execute branch.
You can use the Try/On Fault action to trap anticipated errors and run other actions to remedy or
report on the fault. For instance, you can use Try/On Fault to respond to an XML Interchange action
that fails to find a file.

When you add a Try/On Fault action, several lines are added to the action model:

+ The beginning of the Try action
+ The Execute branch
+ A branch for each Fault that you specified
+ An All other Faults branch
When you are aware of potential faults an action can produce, you put those actions in the Execute

branch. You then put error handling actions under each On Fault branch to handle unique situations.
If a fault does occur, the actions in the On Fault branch execute.

Using the example given previously, if you anticipate a fault with the XML Interchange action, you
put the action under the Execute branch. In one On Fault branch, you might add another XML
Interchange action that attempts to read the file from an alternate location. In another On Fault
branch, you might add another XML Interchange action that looks for a file with a different
extension.

Adding a Try/On Fault Action

1 Right-click the line in the action model that is one line above the position in which you want to
place the Try/On Fault action (the new action is inserted below the line that you selected).

2 Select New Action > Advanced > Try/On Fault.

=

Handle the Following Faults:

e @m s W

Fault Part Mame |

Help | OF I Cancel |

Use the + icon to add a new fault part to the Fault Part Name list. Use the red - icon to remove
fault parts from the list. Use the up-arrow and down-arrow icons to change the order of the
faults.
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If you don’t specify a fault part, corrective actions can be placed in the default All Other Faults
branch of the Try/On Fault action.

3 Click OK.

The following appears in the Action Model Viewer: the Try On Fault action icon, with an
Execute, one or more On Fault branches, and an All Other Faults branch.

4 Add any actions that might cause errors to the Execute branch.
5 Inthe On Fault branch, add actions that resolve the errors specified in the Execute branch.
The following illustration shows a complete Try/On Fault action in the action model.

ER Y
5| o] EXECUTE

- W LG Input TO Syskem Oukput using Log Level 5

*/ W3 Interchange: CurrencyExchangeService viaService CurrencyExchangeService at Endpoint Location: "http:)fservices, xmethods. net:80/soap”
W LG Oukput TO System Oubput using Log Level 5

E|?T+ IF Oubput, XPathi"getRateResponsefResult" J.tolumber() == 0
E‘""I‘?_%I TRUE

- ﬁ MAP $Inputf'1234, 123" TO $Output fgetRateResponse/Result
=[] FaLse

- W LG "R o) rogss) FHHFERERE Y 4 Oukput, sPath("getRateResponse/Result” ) koMumber() TO System Oubput using Log Level 5
EIE All other Faulks

------ W LG ERROR TO System Qukput using Log Level 5
EO THROW FALLT _SystemFault

- E Before Throw Actions

8.5.2 Data Exchange

This section includes descriptions of the following actions:

+ “WS Interchange” on page 293
+ “XML Interchange” on page 295

WS Interchange
This section includes the following topics:
+ “About the WS Interchange Action” on page 293
+ “Adding a WS Interchange Action” on page 293
About the WS Interchange Action

The WS (Web Service) Interchange action is the most important action in the Integration activity
and allows the Integration activity to invoke a Web service according to calling conventions
specified in a WSDL file. The Integration activity automatically creates a WS Interchange action
when it creates the action model.

In most cases there is no need to add another WS Interchange action to the action model. However,
there might be situations in which you need to do so. The following procedure describes how to add
a WS Interchange action.

Adding a WS Interchange Action

1 Right-click the line in the action model that is one line above the position in which you want to
place the WS Interchange action (the new action is inserted below the line that you selected).

2 Select New Action > Data Exchange > WS Interchange.
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il

Messages I Conneckion I #ML Signature I

W5DL Resource:

I CurrencyExchangeService j
Service Mame:

I CurrencyExchangeService j
Port:

I CurrencyExchangePort j
Dperation:

I getRatef I=tns:getRateRequest O=tns:getRateResponse ) j
Endpoint Location:

|"http:,l’,l’services.xmethods.net:&ﬂ,l’soap" 7 -

Help | Apply | | OF I Cancel |

The WSDL Resource, Service Name, Port, and Operation fields are filled in automatically
based on the information in the WSDL specified for the Integration activity.

3 If desired, modify the information in the Endpoint Location field (usually a URL pointing at a
servlet) for the Web service that you wish to use, wrapped in quotation marks. Alternatively,
enter an ECMAScript expression that will evaluate to an Endpoint Location at runtime.

4 Click the Messages tab.

E'}AWS Interchange _3] x|
WSDL | Connection I XML Signature I
Binding Stvle: rpc
Message | Part | Type/Element | Expression |
input=getRateRequest countryl xsd:string
input=getRateRequest counkry2 xsd:string
output=getRateResponse Result xsd:float
Help | Apply | | OF I Cancel

The Message, Part, and Type/Element fields are filled in automatically based on the
information in the WSDL specified for the Integration activity.

5 If desired, click the Expression column for a message, then use the ECMA Expression Builder
to create an ECMAScript expression that describes the source and target for the message.
Usually, this is an expression that specifies an XPath location in an Input part or Output part.
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6 Click the Connection tab.
You use this tab to specify connection parameters for HTTP servers that require authentication.

7 Type a user ID to use for the connection in the User ID field, and a password for the user in the
Password field.

The user ID and password are not actually submitted during the establishment of a connection.
They are simply defined here. The password is encrypted. You will have access to UserID and
Password variables in ECMAScript, allowing you to map the user ID and password as values
into the screen. This way, no one ever sees the passwords.

8 If the connection requires a client certificate, choose a client certificate by clicking the browse
button in the Client Certificate field and selecting the certificate file you want to use for this
connection.

9 If the connection requires a client private key, choose a client private key by clicking the
browse button in the Client Private Key field and selecting the client private key file.

10 Type the password for the client private key in the Private Key Password field.
11 Specify a connection timeout value, in seconds, in the Connection Timeout field.
12 Click Apply to test the WS Interchange action in real time, or click OK to close.

XML Interchange
This section includes the following topics:

+ “About the XML Interchange Action” on page 295
+ “Adding an XML Interchange Action” on page 296

About the XML Interchange Action

The XML Interchange action reads external XML documents into a DOM and writes data from the
DOM as XML files. There are four types of XML Interchange actions:

* GET
*+ PUT
+ POST
+ POST with Response
When using the GET interchange, fill in the Interchange URL Expression field with a URL that

points to the XML document that you want to bring into the Integration activity. In the Response
Part field, you select the DOM (Input, Output, _SystemFault, or Project) that is to receive the XML.

When using the PUT interchange, enter a URL that points to the location to which you want to write
the XML document in the Interchange URL Expression. In the Request Part field, you select the
name of the DOM from which you want to send data as XML.

When using the POST interchange, enter a URL that points to the location to which you want to
write the XML document in the Interchange URL Expression field. In the Request Part field, you
select the name of the DOM from which you want to send data as XML.

When using the POST with Response interchange, you supply the same parameters as for Post, with
one additional parameter. You must also specify a Response Part DOM to receive the Response
XML document from the Post with Response interchange. The difference between the two
interchanges is that Post with Response expects a response XML object back from the origin server.
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Adding an XML Interchange Action
1 Right-click the line in the action model that is one line above the position in which you want to
place the XML Interchange action (the new action is inserted below the line that you selected).
2 Select New Action > Data Exchange > XML Interchange.

_ioix

Interchange Type:
-

Interchange URL Expression:

HTTF Header Params... |

Connection name: Timeouk:

| <nonez | [o—

Request Part:

| I~ |

Response Part:

| output =l
r Filter; Document, .

Help | Apply | OF I Cancel |

3 Select an Interchange Type (Get, Put, Post, or Post with Response).

4 Inthe Interchange URL Expression field, type an expression that defines a fully qualified URL
for an XML document, using any of the following supported protocols:

. file

+ FTP

¢ HTTP
¢ HTTPS

Depending on the Interchange Type selected, this URL is the source or the destination of the
XML file for the XML Interchange action. For example:

file:///g:/xmldata/invoicebatchl.xml
ftp://accounting:password@123.456.789.987:21/invoices/invl.xml

Because this is an ECMAScript expression, the URL string must be enclosed in quotation
marks.

5 If you need to specify HTTP header parameters, click HTTP Header Parameters.
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E'}AHTTP Header Parameters x|
Bl
Parameter | alue |
Content-type "bexk el
Help | [8]4 | Cancel |

Click the plus (+) icon to add new header parameters, then type a Parameter name and a
corresponding Value. Common HTTP header parameters include “Content-Type,” “Content-
Length,” and “Keep-Alive.” You can add any number of Parameter-Value pairs.

7 Click OK to return to the XML Interchange dialog box.
8 In the Request Part field (which is enabled if the Interchange Type is Put, Post, or Post with

10

Response), select the name of the DOM from which you want to send data as XML.

In the Response Part field (which is enabled if the Interchange Type is Get or Post with
Response), select the name of the DOM tree that will receive the XML.

If you want to filter the incoming XML document to improve performance, select the check
box next to the Filter Document button, then select the Filter Document button.

E’}gDeﬁne Performance Filter =]

Filter elements for the document., Specify which elements ko remove from each document below to reduce its size at runtime, Unchecked leaf
elements and § or element branches will be removed from the document and not be available for processing. You may combine usage with the
Split Document. ackion,

Inpuk

- getRateResponse

Help | OF I Cancel |

The document displayed is the document selected in the Response Part in the XML Interchange
dialog box.

You use this dialog box to specify the individual nodes to retain (rather than discard) from the
incoming XML document in real time to improve performance and reduce RAM overhead.
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11 Select the nodes that you want to keep in the document.
Nodes that are not selected are discarded before parsing the DOM.

12 When you have selected nodes that you want to keep, click OK to return to the XML
Interchange dialog box.

13 Click OK.

Alternatively, you can click Apply to see the affect of the XML Interchange action without
closing the dialog box. This allows you to make repetitive edits to an XML Interchange action
and quickly see the results.

8.5.3 Repeat

This section includes descriptions of the following actions:

+ “Break” on page 298

+ “Continue” on page 299

+ “Declare Group” on page 299

+ “Repeat for Element” on page 300
+ “Repeat for Group” on page 302

+ “Repeat While” on page 304

Break

This section includes the following topics:
+ “About the Break Action” on page 298
+ “Adding a Break Action” on page 298

About the Break Action

The Break Action stops the execution of a Repeat for Element, Repeat for Group, or Repeat While
loop. The action model continues execution with the next action outside the loop.

The use of Break is appropriate when, for example, you are using a loop to search a node list for one
particular item. When the target item is found, there is no need to continue iterating. A Break can be
used to terminate the loop immediately.

NOTE: A Break action is usually used in one branch of a Decision action (within a loop). You place
the Break action in either the True or False branch of the Decision action.

Adding a Break Action
1 Within a Repeat action that you want to modify to include a Break action, select a position
inside the loop where you want to place the Break action.
Generally, this is in one leg or the other of a Decision action.
2 Select New Action > Repeat > Break.
The Break action is inserted into the action model.
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Continue
This section includes the following topics:

+ “About the Continue Action” on page 299
+ “Adding a Continue Action” on page 299

About the Continue Action

The Continue action causes execution of the current iteration of a Repeat for Element, Repeat for
Group, or Repeat While loop to stop and execution to begin at the top of the loop, with the next
iteration. The Continue action provides a way to pass over downstream actions inside the loop while
allowing the loop to continue on to the next iteration.

A Continue action is appropriate in a situation where, for example, one item in a list should be
skipped for some reason, yet execution of the loop must continue.

NOTE: A Continue action usually occurs in one branch of a Decision action within a loop. You
place the Continue action in either the True or False branch of the Decision action, as appropriate.

Adding a Continue Action
1 Within a Repeat action that you want to modify to include a Continue action, select a position
inside the Loop actions where you want to place the Continue action.
This is usually inside one fork or the other of a Decision action.
2 From the Action menu, select New Action > Repeat > Continue.
A Continue action appears in the action model.

Declare Group
This section includes the following topics:

+ “About the Declare Group Action” on page 299
+ “Adding a Declare Group Action” on page 300

About the Declare Group Action

You use the Declare Group action to create two special lists, each in reference to a DOM. These
group lists can then be used as the basis for a loop in the Repeat for Group action. To create the lists,
you supply a Group Name and specify an XPath. The Integration activity then creates the lists as
follows:

+ A Group list is created that contains one entry for each unique value found in all the elements
that match the XPath. The Group list is referred to by the Group Name that you supply.

+ A Detail list is created for each unique entry in the Group list that contains as many entries as
there are members in the Group. The Detail list is referred to by the group name that you
supply, post-fixed with the label (Detail).

Using Groups allows you to select a repeating element in your Input DOM and create fewer
elements based on the unique values across all siblings of that repeating element. Instead of having
multiple elements, you have one element for each unique element value in your Output DOM.
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Adding a Declare Group Action

1 Right-click the line in the action model that is one line above the position in which you want to
place the Declare Group action (the new action is inserted below the line that you selected).

2 Select New Action > Repeat > Declare Group.

Declare Group =

Group Name:

Parent Group:

Group Elements:

ok comol_

3 Type a name for the group in the Group Name field.

4 If you want to create multiple group levels, select a group from the Parent Group list, which
lists groups that you have previously defined.

5 Click Add. The Add Element dialog box is displayed.
I x|

Part: |Input |V|

¢ [ getRateRequest
[ xming
D countryd
D country2

ok come

6 Select a part name and an element.

7 Click OK.
8 Repeat Step 5 through Step 7 to add more elements to the group.
9 When you have all the elements that you want in the group, click OK.

Repeat for Element
This section includes the following topics:

+ “About the Repeat for Element Action” on page 301
+ “Adding a Repeat for Element Action” on page 301
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About the Repeat for Element Action

The Repeat action creates looping structures within an action model. Loops give you the ability to
repeat a set of one or more actions. There are three types of loops: Repeat for Element, Repeat for
Group, and Repeat While.

XML allows multiple instances of an element in a document (analogous to multiple records in a
database table). The number of instances can vary from document to document and is defined in the
document schema (DTD or XML Schema). For example, you might receive an XML document
containing line items for an invoice on a daily basis. Each day the XML document has a different
number of line items. Not knowing how many instances of “line item” are in the XML document
poses a problem if you want to transfer these item numbers from the input XML document to an
output XML document programatically. The Repeat for Element action solves this problem.

The Repeat for Element action allows you to mark an element that occurs multiple times. The action
then sets up a processing loop that executes one or more actions for each instance of the marked
element until no more instances exist. In the previous example, the processing loop would contain a
single Map action to transfer the line item number and this action would be repeated until all line
items had been mapped.

The Repeat for Element action also uses the concept of an alias. An alias performs two functions. It
is an alternate name or shorthand for the marked repeating element, which saves you the work of re-
specifying long XPath expressions. In some cases, the repeating element might be several levels
down in the document hierarchy. When you create Map actions in the Repeat loop that transfers
child elements of the marked element, using the alias is quicker than re-typing a long XPath
expression. An alias is also an indicator to Map actions within the Repeat loop to use the next
instance of the repeating element each time the loop processes. A Map action within a Repeat for
Element loop that does not use the alias always refers to the first instance of the element in the
source message.

The Repeat for Element action allows you to process more than one action within the loop. In the
simplest case, the repeat loop might only contain one Map action that transfers the value of the
current element instance from the input Part to the output Part. You can also define multiple actions
in the processing loop. For example, a Map action to transfer the current value, and a Log action that
writes to a file, creating an audit of each transfer.

Adding a Repeat for Element Action

1 Right-click the line in the action model that is one line above the position in which you want to
place the Repeat for Element action (the new action is inserted below the line that you
selected).

2 Select New Action > Repeat > Repeat for Element.
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E’}gRepeat for Element gl =l
—Source

flias:

Representing:

' %path: I vl " Expression:
—Target

Alias:

[ Always create new output elements
Representing:
% wpath: I vl " Expression:
Help | OF I Cancel |

3 Specify the Source information.
3a Type an alias name in the Source Alias field.

A good naming convention for an alias is to use the element name with a prefix indicating
source or target and the type of repeat action, such as “S1Lineitem.”

3b Type an XPath expression, or click the ECMA Expression Builder button and build an
XPath expression for the repeating element.

4 Specify the Target information.
4a Type an alias name in the Target Alias field.

4b Select Always create new output elements if you have repeating actions that should add
new elements rather than updating existing elements.

4c Specify an XPath expression, or click the ECMA Expression Builder button and build an
XPath expression for the repeating element.

5 Click OK. The Repeat for Element loop is added to the action model.

6 Click Loop Actions in the action model to begin adding actions to be performed within the
loop.

Repeat for Group
This section includes the following topics:

+ “About the Repeat for Group Action” on page 303
+ “Adding a Repeat for Group Action” on page 303
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About the Repeat for Group Action

The format of an XML document that you receive is not always the format that meets the
requirements of your business process. A Repeat for Group action allows you to restructure data and
establish a framework to calculate aggregates on your data. Grouping allows you to select a
repeating element in your input part and create fewer elements based on the unique values across all
siblings of that repeating element.

The Repeat for Group action sets up a processing loop based on one of two lists created by the
Declare Group action. The loop executes as many times as there are entries in the list you use (either
the Group list or Detail list). By combining a Repeat for Group with Map commands, you can create
a new XML document that has a different structure and data from the original.

Similar to the Repeat for Element action, a Repeat for Group action also uses the concept of an alias.
The values for the source group used in the Repeat for Group dialog boxes are the list names created
by the Declare Group action. The list names perform two functions. They are an alternate name or
shorthand for the XPath source of any Map actions within the loop. This saves you the work of re-
specifying long XPath expressions. The group list name, when used in place of a DOM name in a
Map action source, is also an indicator to the Map action within the Repeat loop to use the next
instance in the group list each time the loop processes. A Map action within a Repeat for Group loop
that does not use the group name always refers to the first instance of the element in the source part.

The target aliases created in the Repeat for Group action also serve two functions. They are an
alternate name or shorthand for the XPath target of any Map actions within the loop. This saves you
the work of re-specifying long XPath expressions. The target alias, when used in place of a part
name, is also an indicator to Map actions within the Repeat loop to create a new instance of the
Source in the target message part. A Map action within a Repeat for Group loop that does not use a
target alias always overwrites the first instance created in the target message part with subsequent
instances from the source group list.

Creating a Repeat for Group action consists of three tasks:

+ Create a Declare Group action to create the group lists.
+ Create a Repeat for Group action specifying which group list to use.
+ Create Map actions inside the loop.

Adding a Repeat for Group Action

1 Right-click the line in the action model that is one line above the position in which you want to
place the Repeat for Group action (the new action is inserted below the line that you selected).

2 Select Action > New Action > Repeat > Repeat for Group.
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E‘.‘qRepeat for Group _ ||:||1|
—Source
Where:
| [~ |
Where:
—Target
Alias:
Representing:
' %path: I vl " Expression:
Help | OF I Cancel |

3 In the Source section, select a Group name from the Where list on which to base the Repeat for
Group action loop.

4 Optionally, type a Where clause in the Where field to filter the group list, or click the ECMA
Expression Builder icon and create a Where expression.

5 If you know the alias for the Target element, type the name in the Alias field.

6 If you do not know the alias, select either the XPath button and select an element from the list,
or select the Expression button and type an expression (or click the ECMA Expression Builder
button and build an expression).

7 Click OK.

Repeat While
This section includes the following topics:

+ “About the Repeat While Action” on page 304
+ “Adding a Repeat While Action” on page 305

About the Repeat While Action

The Repeat While action repeats one or more actions as long as a condition that you specify remains
True. The target alias that you create in the Repeat While action serves two functions. It is an
alternate name or shorthand for the XPath target of any Map actions within the loop. This saves you
the work of respecifying long XPath expressions. The target alias, when used in place of a DOM
name in a Map action, is also an indicator to Map actions within the Repeat loop to create a new
instance of the source in the target DOM. A Map action within a Repeat for Group loop that does not
use a target alias always overwrites the first instance created in the target DOM with subsequent
instances from the source.

NOTE: Unlike the Repeat for Element and Repeat for Group, Repeat While does not need to be
based on data in a DOM tree. The loop can operate independently of data in the DOM tree.
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Adding a Repeat While Action

1 Right-click the line in the action model that is one line above the position in which you want to
place the Repeat While action (the new action is inserted below the line that you selected).

2 Select New Action > Repeat > Repeat While.

_ioix

—Source

While:

Index Variable:

—Target

Alias:

Representing:

' %path: I vl " Expression:
| % -

Help | OF I Cancel |

3 Inthe While field, type an expression that tests the While loop, or click the ECMA Expression
Builder button and build an expression.

4 Inthe Index Variable field, type a name for a v